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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition fully
complying with safety standards. To maintain this condition and to ensure safe operation, you must
observe all instructions and warnings provided in this manual. If you have any questions regarding these
safety instructions, the Rohde & Schwarz group of companies will be happy to answer them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions
and the product documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories. For product-specific
information, see the data sheet and the product documentation.

Safety labels on products

The following safety labels are used on products to warn against risks and dangers.

Symbol Meaning Symbol Meaning

Notice, general danger location | O ON/OFF supply voltage

Observe product documentation

: Caution when handling heavy equipment @ Standby indication
‘

Danger of electric shock e Direct current (DC)
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Basic Safety Instructions

Symbol Meaning Symbol Meaning
Warning! Hot surface o Alternating current (AC)
Protective conductor terminal —~_ Direct/alternating current (DC/AC)
Ground I:l Device fully protected by double (reinforced)
insulation

Ground terminal

EU labeling for batteries and accumulators

For additional information, see section "Waste
disposal/Environmental protection”, item 1.

Be careful when handling electrostatic sensitive
devices

EU labeling for separate collection of electrical
and electronic devices

For additonal information, see section "Waste
disposal/Environmental protection”, item 2.

Warning! Laser radiation

For additional information, see section
"Operation", item 7.

Signal words and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks

and dangers.

serious injury.

A WARNING

serious injury.

A CAUTION

moderate injury.

Indicates a hazardous situation which, if not avoided, will result in death or

Indicates a hazardous situation which, if not avoided, could result in death or

Indicates a hazardous situation which, if not avoided, could result in minor or

Indicates information considered important, but not hazard-related, e.g.
messages relating to property damage.

In the product documentation, the word ATTENTION is used synonymously.

These signal words are in accordance with the standard definition for civil applications in the European
Economic Area. Definitions that deviate from the standard definition may also exist in other economic
areas or military applications. It is therefore essential to make sure that the signal words described here
are always used only in connection with the related product documentation and the related product. The
use of signal words in connection with unrelated products or documentation can result in misinterpretation
and in personal injury or material damage.
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Basic Safety Instructions

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1.

Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, use only
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea
level. A tolerance of +10 % shall apply to the nominal voltage and +5 % to the nominal frequency,
overvoltage category 2, pollution severity 2.

Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
even death.

Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
even death.

Electrical safety

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1.

Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

In the case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with a protective conductor contact and protective conductor.

Intentionally breaking the protective conductor either in the feed line or in the product itself is not
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords
or connector strips are implemented, they must be checked on a regular basis to ensure that they are
safe to use.

If there is no power switch for disconnecting the product from the AC supply network, or if the power
switch is not suitable for this purpose, use the plug of the connecting cable to disconnect the product
from the AC supply network. In such cases, always ensure that the power plug is easily reachable and
accessible at all times. For example, if the power plug is the disconnecting device, the length of the
connecting cable must not exceed 3 m. Functional or electronic switches are not suitable for providing
disconnection from the AC supply network. If products without power switches are integrated into
racks or systems, the disconnecting device must be provided at the system level.

Never use the product if the power cable is damaged. Check the power cables on a regular basis to
ensure that they are in proper operating condition. By taking appropriate safety measures and
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Basic Safety Instructions

The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher
fuse only after consulting with the Rohde & Schwarz group of companies).

Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.

Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

For measurements in circuits with voltages Vs > 30 V, suitable measures (e.g. appropriate
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be
taken to avoid any hazards.

Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply
in each case.

Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

If a product is to be permanently installed, the connection between the protective conductor terminal
on site and the product's protective conductor must be made first before any other connection is
made. The product may be installed and connected only by a licensed electrician.

For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the
product, as well as the product itself, is adequately protected from injury or damage.

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1). Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.
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Basic Safety Instructions

Before you move or transport the product, read and observe the section titled "Transport".

As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection”,
item 1.

Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

Laser products are given warning labels that are standardized according to their laser class. Lasers
can cause biological harm due to the properties of their radiation and due to their extremely
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the
product documentation. The objective is to prevent personal injury (e.g. due to laser beams).

EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 55022/CISPR 22,

EN 55032/CISPR 32)

— Class A equipment:
Equipment suitable for use in all environments except residential environments and environments
that are directly connected to a low-voltage supply network that supplies residential buildings
Note: Class A equipment is intended for use in an industrial environment. This equipment may
cause radio disturbances in residential environments, due to possible conducted as well as
radiated disturbances. In this case, the operator may be required to take appropriate measures to
eliminate these disturbances.

— Class B equipment:
Equipment suitable for use in residential environments and environments that are directly
connected to a low-voltage supply network that supplies residential buildings

Repair and service

1.

The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.

1171.0000.42 - 07 Page 5



Basic Safety Instructions

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, protective conductor test,
insulation resistance measurement, leakage current measurement, functional test). This helps ensure
the continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.

Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.
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Instrucciones de seguridad elementales

Waste disposal/lEnvironmental protection

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection
point or via a Rohde & Schwarz customer service center.

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but
must be collected separately.
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for
take-back obligations and disposal obligations for manufacturers within the EU. Contact your
Rohde & Schwarz customer service center for environmentally responsible disposal of the product.

3. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

For additional information about environmental protection, visit the Rohde & Schwarz website.

Instrucciones de seguridad elementales

iEs imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
de la UE y ha salido de nuestra planta en estado impecable segun los estandares técnicos de seguridad.
Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario debera
atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas
Rohde & Schwarz esta siempre a su disposicién en caso de que tengan preguntas referentes a estas
informaciones de seguridad.

Ademas queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
esta destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Instrucciones de seguridad elementales

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacion, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacion debida en la documentacion del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacion del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccién de personas, que encontraran en el capitulo correspondiente de la
documentacion del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios. Los datos especificos del producto figuran en la hoja de datos y en la
documentacion del producto.

Senalizacion de seguridad de los productos

Las siguientes sefales de seguridad se utilizan en los productos para advertir sobre riesgos y peligros.

Simbolo Significado Simbolo Significado
Aviso: punto de peligro general | O Tension de alimentacion de PUESTA EN
MARCHA / PARADA

Observar la documentacioén del producto

Atencion en el manejo de dispositivos de peso @ Indicacion de estado de espera (standby)
A elevado
| 18 kg |
Peligro de choque eléctrico e Corriente continua (DC)
Advertencia: superficie caliente ~ Corriente alterna (AC)
Conexién a conductor de proteccion e Corriente continua / Corriente alterna (DC/AC)
Conexion a tierra D El aparato esta protegido en su totalidad por un
aislamiento doble (reforzado)

Conexién a masa Distintivo de la UE para baterias y

acumuladores

Mas informacién en la seccion
"Eliminacién/proteccién del medio ambiente”,
punto 1.
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Instrucciones de seguridad elementales

Simbolo Significado Simbolo Significado

Distintivo de la UE para la eliminacion por
separado de dispositivos eléctricos y
electrénicos

Aviso: Cuidado en el manejo de dispositivos
sensibles a la electrostatica (ESD)

Mas informacién en la seccion
"Eliminacion/proteccion del medio ambiente”,
punto 2.

Advertencia: rayo laser

Mas informacion en la seccion
"Funcionamiento”, punto 7.

Palabras de seiial y su significado

En la documentacion del producto se utilizan las siguientes palabras de sefial con el fin de advertir contra
riesgos y peligros.

A PELIGRO Indica una situacion de peligro que, si no se evita, causa lesiones
graves o incluso la muerte.

Indica una situacién de peligro que, si no se evita, puede causar

A ADVERTENCIA lesiones graves o incluso la muerte.

Indica una situacién de peligro que, si no se evita, puede causar
lesiones leves o moderadas.

A ATENCION

Indica informacién que se considera importante, pero no en relacién
m con situaciones de peligro; p. ej., avisos sobre posibles dafios

materiales.

En la documentacién del producto se emplea de forma sinénima el

término CUIDADO.

Las palabras de senal corresponden a la definicidon habitual para aplicaciones civiles en el area
econdémica europea. Pueden existir definiciones diferentes a esta definicion en otras areas econdémicas o
en aplicaciones militares. Por eso se debera tener en cuenta que las palabras de sefal aqui descritas
sean utilizadas siempre solamente en combinacion con la correspondiente documentacion del producto y
solamente en combinacion con el producto correspondiente. La utilizacidon de las palabras de sefial en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas Yy tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segtn lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de seguridad del trabajo y de prevencién de accidentes.
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Instrucciones de seguridad elementales

Si no se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicion de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccion IP 2X, uso solamente en estancias interiores, utilizacion hasta 2000 m
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicara una tolerancia de
+10 % sobre el voltaje nominal y de +5 % sobre la frecuencia nominal. Categoria de sobrecarga
eléctrica 2, indice de suciedad 2.

No situe el producto encima de superficies, vehiculos, estantes 0 mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacién del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacion de modo distinto al indicado en la documentacién del producto, se pueden
causar lesiones o, en determinadas circunstancias, incluso la muerte.

No ponga el producto sobre aparatos que generen calor (p. €j. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

Antes de la puesta en marcha del producto se debera comprobar siempre que la tensiéon
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion moévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccién
conectado.

Queda prohibida la interrupcion intencionada del conductor de proteccién, tanto en la toma de
corriente como en el mismo producto. La interrupcién puede tener como consecuencia el riesgo de
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacion de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no esta equipado con un interruptor para desconectarlo de la red, o bien si el
interruptor existente no resulta apropiado para la desconexion de la red, el enchufe del cable de
conexion se debera considerar como un dispositivo de desconexion.

El dispositivo de desconexién se debe poder alcanzar facilmente y debe estar siempre bien accesible.
Si, p. €j., el enchufe de conexion a la red es el dispositivo de desconexion, la longitud del cable de
conexion no debe superar 3 m).

Los interruptores selectores o electrénicos no son aptos para el corte de la red eléctrica. Si se
integran productos sin interruptor en bastidores o instalaciones, se debera colocar el interruptor en el
nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccion y
de instalacién adecuadas, de que el cable de conexion a red no pueda ser dafnado o de que nadie
pueda ser danado por él, p. €j. al tropezar o por un choque eléctrico.

1171.0000.42 - 07 Page 10



10.

1.

12.

13.

14.

15.

16.

17.

18.

Instrucciones de seguridad elementales

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizaciéon de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tensién Uy > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. ej. medios de medicién adecuados, seguros, limitacién
de tension, corte protector, aislamiento etc.).

Para la conexiéon con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafios en el producto.

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexion. La instalacion y
la conexion deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafnos.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningun objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacion contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafios en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. €j. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacion de tension (p. €j. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ningun concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitroceluldsicas.
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Instrucciones de seguridad elementales

Funcionamiento

1.

El uso del producto requiere instrucciones especiales y una alta concentracién durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados —los llamados
alérgenos (p. €j. el niquel)—. Si durante el manejo de productos Rohde & Schwarz se producen
reacciones alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las
causas Y evitar cualquier molestia o dafio a la salud.

Antes de la manipulacién mecénica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacion/proteccion del medio ambiente", punto 1.

Ciertos productos, como p. €j. las instalaciones de radiocomunicaciéon RF, pueden a causa de su
funcion natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacién de evaluar y sefializar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias téxicas
(gases, liquidos etc.) que pueden generar dafos a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. e€j. mascaras antigas e indumentaria de proteccion.

Los productos con laser estan provistos de indicaciones de advertencia normalizadas en funcion de la
clase de laser del que se trate. Los rayos laser pueden provocar dafios de tipo biolégico a causa de
las propiedades de su radiacion y debido a su concentracion extrema de potencia electromagnética.
En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcién aparte de las descritas en la
documentacion del producto, a fin de evitar lesiones (p. €j. debidas a irradiacion laser).

Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 11; y en analogia con EN

55022 / CISPR 22, EN 55032 / CISPR 32)

— Aparato de clase A:
Aparato adecuado para su uso en todos los entornos excepto en los residenciales y en aquellos
conectados directamente a una red de distribucion de baja tensiéon que suministra corriente a
edificios residenciales.
Nota: Los aparatos de clase A estan destinados al uso en entornos industriales. Estos aparatos
pueden causar perturbaciones radioeléctricas en entornos residenciales debido a posibles
perturbaciones guiadas o radiadas. En este caso, se le podra solicitar al operador que tome las
medidas adecuadas para eliminar estas perturbaciones.

— Aparato de clase B:
Aparato adecuado para su uso en entornos residenciales, asi como en aquellos conectados
directamente a una red de distribucion de baja tensidon que suministra corriente a edificios
residenciales.
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Instrucciones de seguridad elementales

Reparaciéon y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensién de alimentacion, para
evitar toda posibilidad de choque eléctrico.

El ajuste, el cambio de partes, el mantenimiento y la reparacion deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccion, medicion de resistencia de aislamiento, medicién de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. ej. celdas de
litio) debe sequir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafio seco y limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.

En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacién las normas nacionales de eliminacién y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevaciéon adecuado (p. €j. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.
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Instrucciones de seguridad elementales

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. €j. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafos personales o
dafios en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacién utilizado.

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafos.

Eliminacion/proteccion del medio ambiente

1.

Los dispositivos marcados contienen una bateria o un acumulador que no se debe desechar con los
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminacién se debe
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atencion al
cliente de Rohde & Schwarz.

Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar,
sino que deben ser recogidos por separado.

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminacion de residuos y asume
plenamente los deberes de recogida y eliminacién para los fabricantes dentro de la UE. Para
desechar el producto de manera respetuosa con el medio ambiente, dirijase a su servicio de atencién
al cliente de Rohde & Schwarz.

Si se trabaja de manera mecanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formaciéon adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacién de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. €j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacion de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacion incorrecta de sustancias peligrosas o combustibles puede causar danos a la salud o
dafnos al medio ambiente.

Se puede encontrar mas informacion sobre la proteccion del medio ambiente en la pagina web de
Rohde & Schwarz.
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Quality management
and environmental

management

Sehr geehrter Kunde,

Sie haben sich fur den Kauf
eines Rohde & Schwarz Produk-
tes entschieden. Sie erhalten
damit ein nach modernsten Fer-
tigungsmethoden hergestelltes
Produkt. Es wurde nach den
Regeln unserer Qualitats- und
Umweltmanagementsysteme
entwickelt, gefertigt und gepruft.
Rohde & Schwarz ist unter ande-
rem nach den Managementsys-
temen ISO9001 und ISO 14001
zertifiziert.

Der Umwelt verpflichtet

1 Energie-effiziente,
RoHS-konforme Produkte

1 Kontinuierliche
Weiterentwicklung nachhaltiger
Umweltkonzepte

1 ISO 14001-zertifiziertes
Umweltmanagementsystem

Dear customer,

You have decided to buy a
Rohde & Schwarz product. This
product has been manufactured
using the most advanced meth-
ods. It was developed, manufac-
tured and tested in compliance
with our quality management
and environmental manage-
ment systems. Rohde & Schwarz
has been certified, for exam-
ple, according to the ISO 9001
and ISO 14001 management
systems.

Environmental commitment

1 Energy-efficient products

1 Continuous improvement in
environmental sustainability

1 ISO 14001 -certified
environmental management
system

Certified Quality System

150 9001

Certified Environmental System

IS0 14001

Cher client,

Vous avez choisi d'acheter un
produit Rohde & Schwarz. Vous
disposez donc d'un produit
fabriqué d'aprés les méthodes
les plus avancées. Le dévelop-
pement, la fabrication et les
tests de ce produit ont été effec-
tués selon nos systémes de
management de qualité et de
management environnemental.
La société Rohde &Schwarz a
été homologuée, entre autres,
conformément aux systémes
de management ISO9001 et
ISO 14001.

Engagement écologique

1 Produits a efficience
énergétique

i+ Amélioration continue de la
durabilité environnementale

1 Systeme de management
environnemental certifié selon
ISO 14001
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Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

Europe, Africa, Middle East Phone +49 89 4129 12345
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +6565 1304 88
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /
+86-400-650-5896
customersupport.china@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-06.00
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Documentation Overview

1 Preface

1.1 Documentation Overview

The user documentation for the R&S SMB consists of the following parts:

e Online Help system on the instrument,
e "Quick Start Guide" printed manual,

e Documentation CD-ROM with:
— Online help system (*.chm) as a standalone help,

— Operating Manual,

— Service Manual,

— Data sheet and specifications,

— Links to useful sites on the R&S internet.

Online Help

The Online Help is embedded in the instrument's firmware. It offers quick, context-sen-
sitive access to the complete information needed for operation and programming. The
online help contains help on operating the R&S SMB and all available options.

Quick Start Guide

This manual is delivered with the instrument in printed form and in PDF format on the
Documentation CD-ROM. It provides the information needed to set up and start working
with the instrument. Basic operations and an example of setup are described. The manual
includes also general information, e.g., Safety Instructions.

Operating Manual

The Operating Manual is a supplement to the Quick Start Guide. The manual is available
in PDF format - in printable form - on the Documentation CD-ROM delivered with the
instrument. In the Operating Manual, all instrument functions are described in detail. Fur-
thermore, it provides an introduction to remote control and a complete description of the
remote control commands with programming examples. Information on maintenance,
instrument interfaces and error messages is also given. The manual can also be orderd
in printed form (see ordering information in the data sheet).

Service Manual

This Service Manual is available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument. It describes how to check compliance with rated
specifications, on instrument function, repair, troubleshooting and fault elimination. It
contains all information required for repairing the instrument by the replacement of mod-
ules.

This manual can also be orderd in printed form (see ordering information in the data
sheet).

|
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1.2

Typographical Conventions

Release Notes

The release notes describe new and modified functions, eliminated problems, and last
minute changes to the documentation. The corresponding firmware version is indicated
on the title page of the release notes. The current release notes are provided in the
Internet.

Web Helps

Web helps are provided for the base unit and each additional (software) option. The
content of the web helps correspond to the user manuals for the latest product versions.

The web help is an additional file format that offers quick online access. They are not
intended to be downloaded but rather to access the required information directly form the
R&S website.

Web helps are available at the R&S website, on the R&S SMB product page at the
"Download > Web Help" area.

Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface ele- All names of graphical user interface elements on the screen, such as dia-

ments" log boxes, menus, options, buttons, and softkeys are enclosed by quota-
tion marks.

KEYS Key names are written in capital letters.

File names, commands, File names, commands, coding samples and screen output are distin-

program code guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quotation
marks.

|
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Front Panel Tour

2 Preparing for Use

The following topics will help you to get familiar with the instrument and perform the first
steps:

e Front Panel Tour
® Rear Panel Tour

e Putting into Operation

This section explains the control elements and connectors of the Signal Generator R&S
SMB with the aid of the front and rear views and describes how to put the instrument into
operation. It also describes the connection of peripherals such as printer, keyboard or
mouse. Specifications of interfaces can be found in the data sheet.

The chapter 3, "Getting Started", on page 44 of this manual provides an overview of
the generator functions and introduces the operating concept. Detailed operating instruc-
tions and an overview of menus follow in chapter 4, "Manual Operation”, on page 53.

For all reference information concerning manual and remote control of the instrument
refer to the online help system or its printed/printable version. A more detailed description
of the hardware connectors and interfaces is also part of the help system.

2.1 Front Panel Tour

The front panel of the R&S Signal Generator consists of the VGA display, some utility
keys (left side) and the hardkey area with connectors and control interfaces (right side).
The subsequent sections provide brief explanations on the controls and connectors, the
hardkey area and the front panel.

Fig. 2-1: Front panel view
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2.1.2

ON STANDEY

=

Front Panel Tour

Utility Keys

The keys to the left of the display cause the R&S SMB to return to a definite instrument
state and provide information on the instrument and assistance.

For more information refer to chapter "Instrument Settings".

PRESET
Sets the instrument to a defined state (see chapter 2.3.5.4, "Default Settings",
on page 29).

LOCAL
Switches from remote control to local (manual) control.

SETUP
Opens the "Setup" dialog for configuring presettings.

For more information, see chapter 5.2.3, "General Configuration of Instrument - Setup
Key", on page 81.

FILE
Activates the menu for storing or loading files (see chapter 4.7, "File Management",
on page 71).

INFO
Displays status messages, error messages and warnings.

WINBAR
Toggles between the diagram and active menus.

HELP
Displays context-sensitive help text.

Standby LEDs and Standby Key
The standby LEDs and the ON/STANDBY key are located in the bottom left corner of the
front panel.

The ON/STANDBY key toggles the instrument between standby and ready state (indi-
cated by the standby LEDs).

The standby LEDs indicate the instrument states as follow:
e the green LED (left) is on when the instrument is ready for operation,
e the yellow LED (right) is on in the standby mode.

See also chapter 2.3.5.1, "Standby and Ready state", on page 28.
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2.1.3 Display

The display clearly shows all main settings and signal generator states.

The display is divided into the following sections:

e Frequency and level display with info line
— Frequency and level settings containing offset.

— Status messages

— Brief error messages.
To access an window with detailed information for a message, use the INFO key.

e Block diagram
The block diagram shows the current configuration and the signal flow in the gener-
ator with the aid of function blocks containing an on/off switch. Selecting a function
block opens a list of associated setting menus. Active menus, info windows and
graphs are displayed on top of the block diagram. The block diagram can be displayed
in the foreground anytime with the DIAGRAM key.

For detailed information, see chapter 4.2, "Display", on page 56.

21.4 Setup Keys

The keys to the right of the display set parameters, select views and control the windows.

21.41 Keys for Setting Paramters

These keys provide direct access to the settings in the header of the instrument for fast
setting the RF signal.

For more information refer to chapter "Instrument Functions".

FREQ
Activates frequency entry.

LEVEL
Activates level entry.

ON/OFF TOGGLE

e Switches highlighted elements or a function block on and off.

e Switches between two or more settings, e.g. items of selection lists. At the end of a
list, the cursor is set on the first entry again.

BACKSPACE
Deletes the character to the left of the cursor.
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2.1.5

Front Panel Tour

Display Keys

The keys assigned right to rotary knob arrange different windows on the display, and turn
the RF signal and the modulation on and off.

DIAGRAM
Brings the block diagram to the foreground. Active menus are minimized.

ESC

The function of this key depends on the current cursor position.

e Calls the next higher selection level.

e Closes the open window without accepting new entries; the old value or parameter
is retained.

In dialog boxes that contain a "Cancel" button it activates that button.

Closes all kinds of dialog boxes, if the edit mode is not active.

Quits the edit mode, if the edit mode is active.

Switches between different entry fields of a menu.

Shifts the entry cursor from the header display to the previously active menu, or to
the previously highlighted block in the block diagram if no menu is active.

MOD ON/OFF
Switches the modulations on and off.

"MOD OFF" is displayed in the info line of the header next to the "Level" field.

RF ON/OFF
Switches the RF signal on and off.

"RF OFF" is displayed in the header next to the "Frequency" field.

Keypad for data entry

The keys in the data entry keypad are used to enter alphanumeric data and units.

Data entry keys are only enabled while the cursor is placed on a data input field in a
dialog. Their function depends on the data type of the input field.

|
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Keys Description
0...9/abc Enters the corresponding numbers (in numeric input fields) or characters (character input
fields).

Inserts a decimal point (numeric input fields) or dot (character input fields) at the cursor posi-
tion. Multiple decimal points are not allowed.

Unit keys Selects a unit and thus determine the absolute value, or changes the unit, i.e. trigger a recal-
culation without changing the absolute value. The function depends on the time at which the
UNIT key is used during parameter entry (see chapter 4.4.5, "Working with Units ",

on page 65).

For unit-free values, the X1 key is equivalent to ENTER. It confirms the previous entry and
deactivates the input field.

Adds a blank in a character input field.

B Enters special characters. Toggles through the available characters if the key is pressed sev-
eral times in a row.

A<->a Toggles between uppercase and lowercase characters.

A, B, C, D, E, | Enters hexadecimal values. The letters assigned to the keys are automatically active when
F an entry field with a hexadecimal value is active.

ENTER
Pressing the rotary knob has the same effect.

e Concludes the entry of dimensionless entries. For other entries, this key can be used
instead of the default unit key. The new value is accepted.

Confirms ("OK") and closes open input windows.

In a dialog box, selects the default or focused button.

In a dialog box, activates the edit mode for the focused area, if available.

In a dialog box, activates or deactivates the selected option of the focused area, if
the edit mode is active.

e Calls the next menu level.

2.1.6 Rotary Knob and Navigation Keys

The rotary knob and the arrow keys are alternative control elements for data variation
and navigation in the graphical user interface.

Operating Manual 1407.0806.32 — 13 19



R&S®SMB100A

Preparing for Use

21.7

Front Panel Tour

ROTARY KNOB

The rotary knob has several functions:

e Increases (clockwise direction) or decreases (counter-clockwise direction) numeric
values at a defined step width in editing mode

Moves the cursor, e.g. to a function block in the block diagram

Scrolls within lists, tables or tree views

Acts like the ENTER key, when it is pressed.

e Shifts the selection bar within focused areas (e.qg. lists), if the edit mode is activated.

Note: Turning or pressing the rotary knob is equivalent to pressing the UP and DOWN
keys or the ENTER key in the keypad.

NAVIGATION KEYS

The navigation keys consist of 4 arrow keys which are used for navigation, alternatively
to the rotary knob.
UP/ DOWN The up and down arrow keys do the following:
KEYS e |n a numeric edit dialog box, increase or decrease the instrument
parameter.

e In alist, table, window or dialog box, scroll vertically.
LEFT/ RIGHT  The left and right arrow keys do the following:
KEYS e In an alphanumeric edit dialog box, move the cursor forward and
back.

e |n a list, table, window or dialog box, scroll horizontally.

Front Panel Connectors

The RF and LF output connectors and a connector for external modulation signals are
located on the front panel.

MOD EXT

Input for external modulation signals.

LF

Output for internal LF modulation generator signal.

See also data sheet and chapter 5.5.1, "Overview of LF Generator", on page 187,
chapter 5.5.2, "LF Output", on page 187.

|
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RF 50 Ohm
Output for RF signal.
Depending on the equipped frequency option, the RF output connectors vary.
RF Option Microwave Option
Frequency options Connector Frequency options Connector
type type
R&S SMB- B101 N female R&S SMB-B112/-112L PC 3.5 mm
R&S SMB-B102 R&S SMB-B120/-B120L
R&S SMB-B103 R&S SMB-B140/-140L PC 2.92 mm
R&S SMB-B106

NOTICE! Maximum Input Levels. Do not overload the RF output. The maximum permis-
sible back-feed is specified in the data sheet.

2.2 Rear Panel Tour

This section gives an overview of connectors on the rear panel of the instrument. Each
connector is briefly described and a reference is given to the chapters containing detailed
information. For technical data of the connectors refer to the data sheet.

Fig. 2-2: Rear panel view
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2.2.1 Description of the Connectors

FUSES
The R&S SMB is fully fused by two fuses IEC60127-T3.15H/250 V.

The fuses are accommodated in the fuse holders next to the power connector. Use only
fuses of the mentioned type.

AC SUPPLY AND POWER SWITCH

When the R&S SMB is connected to the AC supply, it automatically sets itself to the
correct range for the applied voltage (range: see type label). There is no need to set the
voltage manually or change fuses.

The power switch can be set to two positions:

e 0
The instrument is disconnected from the mains.

o |
The instrument is power-supplied. It is either ready for operation (STANDBY) or in
operating mode, depending on the position of the ON/STANDBY switch on the instru-
ment front.

See also data sheet and chapter 2.3.4, "Connecting the Instrument to the AC Supply",
on page 27.

USB IN USB IN
USB (universal serial bus) interface of type B (device USB).

This interface can be used for remote control of the instrument.

USB CONNECTORS TYPE A
USB (universal serial bus) interfaces of type A (host USB).

e Connection of peripherals such as mouse, keyboard, etc.
e Connection of memory stick for file transmission
e Firmware update

See also chapter 2.4.1, "Connecting USB Devices", on page 31.

LAN CONNECTOR

Ethernet interface

e For integrating signal generators in a network
e Remote control of signal generator

e Remote access to the signal generator

e Firmware update

See also:
e chapter 2.6, "Setting Up a Network (LAN) Connection", on page 34
e chapter 6.1.3, "LAN Interface", on page 204

IEC 625/IEEE 488
IEC-bus (IEEE 488) interface for remote control of the instrument.

See also chapter A.1, "GPIB Bus Interface", on page 444 and chapter 6.1.6, "GPIB
Interface (IEC/IEEE Bus Interface)", on page 208.
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Note: In order to avoid electromagnetic interference (EMI) caused by open lines, always
terminate any connected IEC-bus cable with an instrument or a controller.

STEREO R/L
Inputs for analog stereo modulation signals. External modulation sources or the internal
LF generator can be used (stereo modulation is available with option R&S SMB-B5).

See also chapter 5.4.6, "Stereo Modulation", on page 180.

S/P DIF
Input for digital stereo signals (stereo modulation is available with option R&S SMB-B5).

See also chapter 5.4.6, "Stereo Modulation", on page 180.

SIGNAL VALID
Output of valid signal. This signal marks the valid signal times (valid level and frequency
indication). The signal is generated automatically.

INSTR TRIG
Input for external trigger for sweeps and list mode.

See also chapter 5.3.7.4, "List Mode", on page 159 and chapter 5.3.7.1, "Overview",
on page 147.

PULSE VIDEO
Output of internal pulse generator signal or external pulse signal fed in via the PULSE
EXT connector (video signal).

See alsochapter 5.4.5, "Pulse Modulation (PM)", on page 178 .

PULSE EXT
Input of external pulse signal or input of external trigger/gate signal for internal pulse
generator.

See alsochapter 5.4.5, "Pulse Modulation (PM)", on page 178 .

REF OUT
Output of internal reference signal.

See also chapter 5.3.4, "Reference Oscillator”, on page 119.

REF IN
Input for external reference signal.

See also chapter 5.3.4, "Reference Oscillator”, on page 119.

ocXo
e Oven-controlled reference oscillator (option R&S SMB-B1)
or

e high performance oven-controlled reference oscillator (option R&S SMB-B1H)
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The OCXO generates a very precise 10 MHz reference signal. It needs some minutes of
warm-up time to reach its nominal frequency.

Refer also to the data sheet for detailed information.

2.3 Putting into Operation

This section describes the basic steps to be taken when setting up the R&S SMB for the
first time.

A WARNING

Risk of injury and instrument damage

The instrument must be used in an appropriate manner to prevent electric shock, fire,
personal injury, or damage.

e Do not open the instrument casing.

e Read and observe the "Basic Safety Instructions" at the beginning of this manual or
on the documentation CD-ROM, in addition to the safety instructions in the following
sections. Notice that the data sheet may specify additional operating conditions.

Risk of instrument damage

Note that the general safety instructions also contain information on operating conditions
that will prevent damage to the instrument. The instrument's data sheet may contain
additional operating conditions.

Operating Manual 1407.0806.32 — 13 24



R&S®SMB100A Preparing for Use

Putting into Operation

Risk of instrument damage during operation

An unsuitable operating site or test setup can cause damage to the instrument and to
connected devices. Ensure the following operating conditions before you switch on the
instrument:

e All fan openings are unobstructed and the airflow perforations are unimpeded. The
minimum distance from the wall is 10 cm.

e The instrument is dry and shows no sign of condensation.

e The instrument is positioned as described in the following sections.

e The ambient temperature does not exceed the range specified in the data sheet.
e Signal levels at the input connectors are all within the specified ranges.

e Signal outputs are correctly connected and are not overloaded.

Risk of electrostatic discharge

Protect the work area against electrostatic discharge to avoid damage to electronic com-
ponents in the modules. For details, refer to the safety instructions at the beginning of
this manual.

2.3.1 EMI Suppression

Electromagnetic interference (EMI) may affect the measurement results.

To suppress generated Electromagnetic Interference (EMI),

e Use suitable shielded cables of high quality. For example use double-shielded RF
and LAN cables.
Note: USB cables are of varying and often poor quality. Therefore, check the quality
of each individual USB cable as described in the service manual.

e Always terminate open cable ends.
e Note the EMC classification in the data sheet

2.3.2 Unpacking and Checking the Instrument

To remove the instrument from its packaging and check the equipment for completeness
proceed as follows:

1. Pull off the polyethylene protection pads from the instrument's rear feet and then
carefully remove the pads from the instrument handles at the front.

2. Pull off the corrugated cardboard cover that protects the rear of the instrument.
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3. Carefully unthread the corrugated cardboard cover at the front that protects the
instrument handles and remove it.

4. Check the equipment for completeness using the delivery note and the accessory
lists for the various items.

5. Check the instrument for any damage. If there is damage, immediately contact the
carrier who delivered the instrument. Make sure not to discard the box and packing
material.

Packing material

Retain the original packing material. If the instrument needs to be transported or shipped
at a later date, you can use the material to protect the control elements and connectors.

2.3.3

Placing or Mounting the Instrument

The R&S SMB is designed for use under laboratory conditions, either on a bench top or
in a rack using a rack adapter kit (order number see data sheet).

Bench Top Operation

If the R&S SMB is operated on a bench top, the surface should be flat. The instrument
can be used in horizontal position, standing on its feet, or with the support feet on the
bottom extended.

CAUTION

Risk of injury if feet are folded out

The feet may fold in if they are not folded out completely or if the instrument is shifted.
This may cause damage or injury.

e Fold the feet completely in or completely out to ensure stability of the instrument.
Never shift the instrument when the feet are folded out.

e When the feet are folded out, do not work under the instrument or place anything
underneath.

e The feet can break if they are overloaded. The overall load on the folded-out feet
must not exceed 500 N.
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A CAUTION

Risk of injury and instrument damage if stacking instruments

A stack of instruments may tilt over and cause injury. Furthermore, the instruments at the
bottom of the stack may be damaged due to the load imposed by the instruments on top.

Observe the following instructions when stacking instruments:

e Never stack more than three instruments with the same dimensions (width and
length). If you need to stack more than three instruments, install them in a rack.

e The overall load imposed on the lowest instrument must not exceed 500 N.

e Allinstruments should have the same dimensions (width and length).
If you need to stack smaller instruments on the top, the overall load imposed on the
lowest instrument must not exceed 250 N.

e [f the instruments have foldable feet, fold them in completely.

Rackmounting

The R&S SMB can be installed in a rack using a rack adapter kit (Order No. see data
sheet). The installation instructions are part of the adapter Kkit.

Risk of instrument damage in a rack

An insufficient airflow can cause the instrument to overheat, which may disturb the oper-
ation and even cause damage.

Make sure that all fan openings are unobstructed, that the airflow perforations are unim-
peded, and that the minimum distance from the wall is 10 cm.

2.3.4 Connecting the Instrument to the AC Supply

The R&S SMB is automatically adapted to the AC voltage supplied. There is no need to
set the voltage manually or change fuses. The AC SUPPLY AND POWER SWITCH is
at the rear of the unit.
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» Connect the instrument to the AC power source using the AC power cable delivered
with the instrument.

Note: The instrument is in compliance with safety class EN61010-1.
Connect the instrument only to a socket with earthing contact.

Starting the Instrument

Switching off the AC power

You can leave the AC power on permanently to preserve your last instrument settings.
Switching off is required only if the instrument must be completely disconnected from all
power supplies.

2.3.51

ON STANDEY

2.3.5.2

Starting up instruments with power switch
1. Connect the instrument to the AC supply.

2. To turn the power on, press the main power switch to position | (On).

After power-up, the instrument is in standby or ready state, depending on the state
of the ON/STANDBY key at the front panel of the instrument when the instrument
was switched off for the last time.

3. In case the instrument is in standby mode, i.e. the yellow LED is on, press the ON/
STANDBY key to switch the instrument to ready state.

Standby and Ready state
The ON/STANDBY key is located in the bottom left corner of the front panel.

Switching between standby and ready state

» Press the ON/STANDBY key briefly to switch the instrument from the standby to
ready state or vice versa.

In ready state, the left, green LED is on. The instrument is ready for operation. All
modules are power-supplied and the R&S SMB initiates its startup procedure.

In standby state, the right, yellow LED is on. The standby power only supplies the
power switch circuits and the oven-controlled crystal oscillator to keep it at its oper-
ating temperature. In this state it is safe to switch off the AC power and disconnect
the instrument from the power supply.

Start Display and Booting

The instrument boots the operating system, starts the instrument firmware and automat-
ically performs a selftest. If the previous session was terminated regularly, the instrument
uses the last setup with the relevant instrument settings.
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Once the startup procedure has been terminated, the block diagram opened in the pre-
vious session is displayed and the instrument is ready for operation.

Use the PRESET key to return the instrument to its definite reset/preset state, if the cur-
rent setup is not anymore relevant.

To customize the start settings, use the "File" dialog.

Rebooting the instrument
Press the STANDBY key for approx. 5 s. to reboot the instrument, if the software stops
unexpectedly.

2.3.5.3 Function Check

The signal generator automatically monitors the main functions when the instrument is
switched on and continuously during operation.

A detected fault is indicated by a "ERROR" message displayed in the info line together
with a brief error description. For in-depth identification of the error, press the INFO key.
In response, a description of the error(s) is displayed.

For more information, refer to chapter 9, "Error Messages", on page 437.

Additionaly to the automatic monitoring, the R&S SMB offers the following capabilities to
ensure correct functioning:

e |nternal Adjustments
Press the SETUP key and select "System > Internal Adjustments" to access the dia-
log for preforming and configuring of the adjustments settings. A maximum level
accuracy can be obtained, for instance.

e Selftest
A selftest is provided for service purposes. The selftest is a protected test procedure,
which can be accessed if protection level 1 is disabled.

2.3.5.4 Default Settings

When the instrument is switched on, it is not the preset state that is active, but rather the
instrument state that was set before the instrument was switched off. It is also recomen-
ded that you use the PRESET key to return the instrument to its defined preset state

every time a new configuration is required or the current setup is not anymore relevant.

The R&S SMB offers a two-stage preset concept:

e Preset the instrument to a predefined state
The PRESET key calls up a defined instrument setup. All parameters and switching
states are preset (also those of inactive operating modes). The default instrument
settings provide a reproducible initial basis for all other settings. However, functions
that concern the integration of the instrument into a measurement setup are not
changed, e.g. GPIB bus address or reference oscillator source settings.
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e Preset the instrument to its factory settings
The instrument can also be forced to load its default factory settings. To access the
corresponding dialog box, press the SETUP key and select the "Factory Preset".
For more information and an overview of the settings affected by the factory preset
function, see chapter 5.2.3.17, "Factory Preset", on page 101.

Overview of the Most Important Preset States

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.

e "RF frequency" =1 GHz
e "RF level" RF output switched off

e "Level" = 30 dBm for instruments including an attenuator
"Level" = -5 dBm for instruments with no attenuator

e "Offsets" =0
e "Modulations State" = Off

e Uninterrupted level settings are switched off
"Level Attenuator Mode" = AUTO

e Internal level control "Level ALC" = AUTO
e User correction "Level Ucor" = OFF

e "LF output State" = Off

e "Sweep State" = Off

Settings that are not affected by the PRESET key

e Reference frequency settings ("Ref Oscillator" menu)

e Power on settings ("Level/EMF" menu)

o Network settings ("Setup” menu)

e GPIB address ("Setup" menu)

e *IDN? Identification and emulation ("Setup" menu)

e Password and settings protected by passwords ("Setup" menu)
e Start/Stop Gui Update ("Setup" menu)

e Display and keyboard settings ("Setup" menu)

@ User-defined instrument states can be stored and called up in the "File" dialog.

2.3.6 Shutting Down the Instrument

To shut down the R&S SMB, proceed as described below.
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Risk of losing data

If you switch off the running instrument using the rear panel switch or by disconnecting
the power cord, the instrument loses its current settings. Furthermore, program data may
be lost.

Press the ON/STANDBY key first to shut down the application properly.

1. Press the ON/STANDBY key to save the current setup, shut down the operating
system and set the instrument to standby state.

The yellow LED must be on.
2. To switch off the power, press the main power switch to position 0 (Off).

None of the front-panel LEDs should be on.

2.3.7 Power Fuses

The R&S SMB is fully fused by two fuses IEC60127-T3.15H/250 V.

The fuses are accommodated in the fuse holders next to the power connector. Use only
fuses of the mentioned type.

A WARNING

Shock hazard

Before replacing a fuse, make sure that the instrument is switched off and disconnected
from all power supplies.

Always use fuses supplied by Rohde & Schwarz as spare parts, or fuses of the same
type and rating.

2.4 Connecting External Accessories

The equivalent USB ports on the front and/or rear panel of the R&S SMB can be used to
connect a variety of accessories.

In addition the instrument provides interfaces for network integration (see chapter 2.6,
"Setting Up a Network (LAN) Connection”, on page 34).

241 Connecting USB Devices

The USB interfaces on the front and (optionally) rear panels of the R&S SMB allow you
to connect USB devices directly to the instrument. This number can be increased as

|
Operating Manual 1407.0806.32 — 13 31



R&S®SMB100A

Preparing for Use

2.5

Linux Operating System

necessary by using USB hubs. Due to the large number of available USB devices, there
is almost no limit to the expansions that are possible with the R&S SMB.

The following list shows various USB devices that can be useful:
e Memory stick for easy transfer of data to/from a computer (e.g. firmware updates)

CD-ROM drives for easy installation of firmware applications
e Keyboard or mouse to simplify the entry of data, comments, file names, etc.
e Power sensors, e.g. of the NRP Zxy family

Installing USB devices is easy under Linux, because all USB devices are plug&play. After
a device is connected to the USB interface, the operating system automatically searches
for a suitable device driver.

If Linux does not find a suitable driver, it will prompt you to specify a directory that contains
the driver software. If the driver software is on a CD, connect a USB CD-ROM drive to
the instrument before proceeding.

When a USB device is subsequently disconnected from the R&S SMB, the operating
system immediately detects the change in hardware configuration and deactivates the
corresponding driver.

All USB devices can be connected to or disconnected from the instrument during oper-
ation.
Connecting a memory stick or CD-ROM drive

If installation of a memory stick or CD-ROM drive is successful, the operating system
informs you that the device is ready to use. The device is made available as a new drive
(/usb). The name of the drive is manufacturer-dependent.

Connecting a keyboard

The keyboard is detected automatically when it is connected. The default keyboard layout
is English — US.

Use the "Setup > Keyboard Settings" dialog to configure the keyboard properties.

Connecting a mouse

The mouse is detected automatically when it is connected.

Linux Operating System

The instrument uses an embedded Linux operating system. To make sure that the instru-
ment software works properly, certain rules must be adhered to concerning the operating
system.
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Risk of causing instrument unusability

The instrument is equipped with the Linux operating system. Additional software can
therefore be installed on the instrument. The use and installation of additional software
may impair instrument function. Thus, run only programs that Rohde & Schwarz has
tested for compatibility with the instrument software.

The drivers and programs used on the instrument under Linux have been adapted to the
instrument. Existing instrument software must always be modified using only update
software released by Rohde & Schwarz.

The configuration of the operating system is optimally adapted to signal generator func-
tions in the factory. Changes in the system setup are only required when peripherals like
keyboard are installed or if the network configuration does not comply with the default
settings (see chapter 2.6.1, "Connecting the Instrument to the Network"”, on page 34).
After the R&S SMB is started, the operating system boots and the instrument firmware
is started automatically.

Accessing Operating System
No access to the operating system is required for normal operation.
All necessary system settings can be made in the "Setup" dialog.

The R&S SMB provides an internal flash memory, it does not contain a disk drive. The
flash memory holds the operating system, the firmware and the stored data. Data transfer
is possible via a memory stick connected to a USB interface. The memory stick and the
flash memory are accessed via the "File Manager".

Accessing the File System

The instrument also supports two standard methods to access the file system form a
remote client:
e FTP (file transfer protocol)

e File sharing according to the SAMBA/SMB (server message block) protocol.

Both methods allow the access to the folder /var/user/share.

Default password
The FTP and SAMBA/SMB file access use the user "instrument" with the default pass-
word "instrument".

In is highly recommenced that you change this password in the Setup > Security >
Change User Password dialog before connecting the instrument to the network!

Refer also to Application Note 1GP72 "Connectivity of Signal Generators", provided on
the CD.
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Screen saver

A screen saver can be activated in the R&S SMB. When active, the display is shut off
when no entries via front panel, external mouse or external keyboard are made for a
period of time. The screen saver prolongs the life time of the display.

Use the "Setup > Display Settings" dialog to switch on or off the screen saver and to
adjust the screen saver settings.

Setting Up a Network (LAN) Connection

The R&S SMB is equipped with a network interface and can be connected to an Ethernet
LAN (local area network). Provided the appropriate rights have been assigned by the
network administrator and the Linux firewall configuration is adapted accordingly, the
interface can be used, for example:

e To transfer data between a controller and the instrument, e.g. in order to run a remote
control program.
See chapter 6, "Remote Control Basics", on page 202.

e To access or control the measurement from a remote computer using the Ultr@VNC
program (or a similar tool, like another VNC client or any Web browser supproting
Java)

e To transfer data from a remote computer and back, e.g. using network folders
This section describes how to configure the LAN interface. It includes the following topics:

® chapter 2.6.1, "Connecting the Instrument to the Network", on page 34
e chapter 2.6.2, "Assigning the IP Address", on page 35

Accessing Operating System
No access to the operating system is required for normal operation.
All necessary system settings can be made in the "Setup" dialog.

2.6.1

Connecting the Instrument to the Network

There are two methods to establish a LAN connection to the instrument:

e A non-dedicated network (Ethernet) connection from the instrument to an existing
network

e A dedicated network connection (Point-to-point connection) between the instrument
and a single computer

In both cases, an IP address has to be assigned to the instrument and the computer,
which is usually accomplished automatically. See also chapter 2.6.2, "Assigning the IP
Address", on page 35.
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To set up a network (LAN) connection

Risk of network failure

Before connecting the instrument to the network or configuring the network, consult your
network administrator. Errors may affect the entire network.

» Connect the instrument to the network or to a single PC.

If the instrument is connected to the LAN, the operating system automatically detects
the network connection and activates the required drivers.

By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically.

The network card can be operated with a 10/100 Mbps Ethernet IEEE 802.3u interface.

2.6.2 Assigning the IP Address

Depending on the network capacities, the TCP/IP address information for the instrument
can be obtained in different ways.

e If the network supports dynamic TCP/IP configuration using the Dynamic Host Con-
figuration Protocol (DHCP), all address information can be assigned automatically.

e If the network does not support DHCP, the instrument tries to obtain the IP address
via Zeroconf (APIA) protocol. If this attempt does not succeed or if the instrument is
set to use alternate TCP/IP configuration, the addresses must be set manually.

By default, the instrument is configured to use dynamic TCP/IP configuration and obtain
all address information automatically. This means that it is safe to establish a physical
connection to the LAN without any previous instrument configuration.

Risk of network errors!

Connection errors can affect the entire network.

If your network does not support DHCP, or if you choose to disable dynamic TCP/IP
configuration, you must assign valid address information before connecting the instru-
ment to the LAN.

Contact your network administrator to obtain a valid IP address.

Assigning the IP address on the instrument

1. Press the SETUP key and select the "Network Settings" dialog.

2. Set the "Address Mode" to Static.

3. Select the "IP Address" and enter the IP address, for example 792.7168.0.1..
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The IP address consists of four number blocks separated by dots. Every block con-
tains 3 numbers in maximum.

4. Select the "Subnet Mask" and enter the subnet mask, for example 255.255.255.0.
The subnet mask consists of four number blocks separated by dots. Every block
contains 3 numbers in maximum.

Use computer names to identify the instrument

In networks using a DHCP server, it is recommended that you address the instrument by
its unambiguous computer name, see chapter 2.6.3, "Using Computer Names",

on page 36.

A computer name (hostname) is an unique dedicated identification of the instrument, that
remains permanent as long as it is not explicitly changed. Hence, you can address an
instrument by the same identification (computer name), irrespectively if a network or a
point-to-point connection is used.

2.6.3

To assign the IP address manually on the remote computer

» Obtain the necessary information from your network administrator. If you use more
than one LAN connector, you need separate address information for each connector.
For information on how to perform the configurations, refer to the documentation of
the operating system the remote computer uses.

Using Computer Names

In a LAN that uses a DNS server (Domain Name System server), each PC or instrument
connected in the LAN can be accessed via an unambiguous computer name instead of
the IP address. The DNS server translates the host name to the IP address. This is
especially useful when a DHCP server is used, as a new |IP address may be assigned
each time the instrument is restarted.

Each instrument is delivered with an assigned computer name, but this name can be
changed.

The default computer name follows the syntax rs<instrument><serial number>.

Querying and changing a computer name
1. Press the "Setup" key and select "Network Settings".

The computer name is displayed under "Hostname".

2. Press the "Setup" key, select "Protection" and enable the "Protection Level 1".
The default password is 123456.

The parameter "Hostname" in the "Network Settings" dialog is now enabled for con-
figuration.

3. Change the "Hostname".
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2.7 Remote Access via an External Controller

The R&S SMB can be remote accessed from a remote computer (external controller) via
a network link. This allows convenient operation of the instrument from the desktop
although the instrument is integrated in a rack somewhere else.

For an overview of the instrument's operating concept and the different ways to control
and operate the instrument, see chapter 3.1, "Brief Introduction to the Instrument's Con-
cept", on page 44.

There are different ways to establish a remote access connection to the signal generator
but all of them require an established LAN connection between the instrument and the
remote computer. The simplest way to remote access the instrument is to use a Web
browser, such as Windows Internet Explorer or Mozilla Firefox for instance. Alternatively
a remote access via a special application can be used.

The free-of-charge program Ultr@VNC for PCs with Linux/Unix or Windows operating
system is available for setting up the remote access connection. Using this application
requires additional installation.

See the following table for an overview of the different ways to establish a remote access
connection to the signal generator.

Table 2-1: Remote access via an external computer

Remote access via Installation of the additional appli-
LAN cation
connec-
tion on the instru- on the remote
ment computer
Web Browser required no no

e.g. Windows Internet Explorer or Mozilla Firefox

see chapter 2.7.1, "Using a Web Browser for Remote
Access", on page 38

Ultr@VNC required required VNC Viewer

for PCs with Linux/Unix or Windows operating system required

see chapter 2.7.2, "Remote Access via Ultr@VNC",
on page 39

When the connection is set up with Ultr@VNC, direct control on the instrument is possible
while remote access is established.

For return to direct operation on the instrument, the connection must be cut. After cutting
the connection, it is still enabled and can be established again any time. The connection
is disabled only after deactivation of the program.

This section gives an information on how to use the Web browser for remote access, how
to install the applications for remote access and how to establish the connection between
the instrument and an external computer with Windows operating system. Remote

access via an external computer with Linux/Unix operating system is performed accord-

ingly.
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Default password
Remote-access and file access require the user "instrument" with default password
"instrument".

Changing the default user and security passwords

Itis highly recommended to change the default user and security passwords in the menu
"Setup > Security" before connecting the instrument to the network (see section chap-
ter 5.2.3.15, "Security", on page 97).

2.7.1 Using a Web Browser for Remote Access

The instrument can be remote-accessed via any Web browser, like Windows Internet
Explorer or Mozilla Firefox for instance.
To remote access the instrument via Web browser:

1. Connect the instrument and the remote computer to a LAN, see chapter 2.6.1, "Con-
necting the Instrument to the Network", on page 34.

2. Instal the Java Runtime Environment JRE on the remote computer.

3. Type the instruments' IP address in the address field of the Web browser on your PC,
e.g. http://10.111.11.1

The "VNC Authentication" screen appears.

4. Enter the password and select "OK".
The default password is "instrument".

After the connection is established, the current signal generator screen with the block
diagram is displayed and the instrument can be remote-accessed from the remote
computer.

|
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2.7.2 Remote Access via Ultr@VNC

Ultr@VNC is an application which can be used to access and control the instrument from
a remote computer through a LAN connection. The program is included in operating sys-
tem Linux/Unix. It is available as a free-of-charge download on the internet for operating
system Window XP (http://www.uvnc.com/download/index.html).

Risk of Unauthorized Access

If the VNC application is enabled on the instrument, any user in the network who knows
the computer name and login data can access it. To prevent this, make sure that the VNC
server service on the instrument is disabled.

Setting up a VNC connection

1. Connect the instrument and the remote computer to a LAN, see chapter 2.6.1, "Con-
necting the Instrument to the Network", on page 34.

2. Install the Ultr@VNC application and enable it on the instrument.
3. In the ICF firewall, enable communication on the network via Ultr@VNC program.

4. Install the VNC Viewer on the remote computer with Windows operating system, see
"Installing the VNC Viewer on a Windows PC" on page 41.

5. Set up the VNC connection between the instrument and:

a) the remote computer with Linux/Unix operating system, see "Setting up the VNC
connection on the Linux/Unix remote computer" on page 41;

b) the remote computer with Windows operating system, see "Setting up the VNC
connection on the Windows remote computer" on page 42.

Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be controlled
from the front panel and via the remote computer alternately.

Installing the Ultr@VNC application

1. Download the program from the internet and copy it to a directory that can be
accessed.

2. On the instrument, shut down firmware using the ALT+F4 key combination.

3. Double click on the setup file to start the installation.
The setup wizard leads through the installation. This description focus only on the
relevant settings.

|
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a) Select installation of all components.

b) In the "Additional Task Panel", enable all entries.

A successful installation is indicated by a message.

At the same time a warning is displayed stating that a password must be set.

4. Select "OK".

The "Default Local System Properties" panel opens.
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Remote Access via an External Controller

Enter a password with a length of at least five digits.
This password is used on the remote computer to access the instrument. Other set-
tings may be changed according to the user-specific security requirements.

After the installation the Ultr@VNC program is automatically started together with the
operating system. On mouse over, the IP address of the instrument is indicated.
This IP address and the user-defined password are the prerequisites to enable
remote access on the remote computer. Terminated connection is indicated by
changed icon color.

Installing the VNC Viewer on a Windows PC

1.

2.

Download the Ultr@VNC program form internet and follow the installation instruc-
tions.
Only the program component VNC Viewer is required.

Note: The VNC Viewer program is included in the download for the installation of the
Ultr@VNC program on the signal generator if "Full installation" was selected in the
"Select Component" panel. In this case, the program ultr@vncviewer.exe can
be copied to the Windows PC.

Install VNC Viewer program component on the remote computer.

Setting up the VNC connection on the Linux/Unix remote computer

The VNC program is available per default for Linux/Unix operating systems.

1.

Start a Web browser on the remote computer and enter the IP address of the instru-
ment.

Enter the following address:
vnc://<IP-address of the instrument>, e.g. vnc://192.168.1.1.

A dialog is opened and the password for the remote VNC connection is requested.

|
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3. Enter the password as defined in the "Default Local System Properties" panel of the
Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual functions
are operated using the mouse and keyboard.

In contrast to remote access via Remote Desktop, the direct control of the instrument
is not disabled and the instrument can be controlled from the front panel and via the
remote computer alternately.

Setting up the VNC connection on the Windows remote computer

1. Start VNC Viewer program component on the PC, select "VNC Server" and enter IP
address of the instrument.

2. To initialize the connection, select "Connect".

A message requesting the password appears.

3. Enter the password as defined in the "Default Local System Properties" panel of the
Ultr@VNC program and select "Log On".

The connection is established, the instrument is remote accessed and the current
signal generator screen with the block diagram is displayed. The individual functions
are operated using the mouse and keyboard.

Enabled Direct Control
The direct control of the instrument is not disabled and the instrument can be controlled
from the front panel and via the remote computer alternately.
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Terminating VNC Connection

The remote access via VNC connection can be terminated either on the R&S SMB or on
the external PC. Terminating the connection does not disable it. It can be established
again any time. See the notice above concerning unauthorized access due to VNC con-
nection!

1. Terminate the connection on the R&S SMB

a) Press the "Windows" key to access the operating system.
b) Right-click on the VNC icon on the task bar and select "Kill all clients".

2. Toterminate the connection on the external Linux/Unix PC, close the internet browser
or close the signal generator window.

3. To terminate the connection on the external Windows PC, close the VNC Viewer
program.

The connection is terminated. The color of the VNC icon in the status bar of the
instrument changes.
A message on the external PC indicates the disconnection.

Disabling Remote Access via Ultr@VNC

The VNC connection can be disabled by removing the program on the instrument or by
deactivating the VNC Server service.

1. Remove the VNC program

a) Press the "Windows" key to access the operating system and open the "Add or
Remove Programs" by selecting "Start > Settings > Control Panel > Add or
Remove Programs".

b) Remove the VNC program.

2. Deactivate the VNC Server service

a) Press the "Windows" key to access the operating system and open the "Ser-
vices" by selecting "Start > Settings > Control Panel > Services".
b) Deactivate the VNC Server service.

The connection is disabled, the VNC icon disappears from the task bar of the instru-
ment.
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3 Getting Started

This section helps you to get familiar with the R&S SMB and provides an introduction to
the general concept of the instrument with a sample of the possible application fields as
well as a description of the main blocks in the signal generation flow.

This section also explains the operating concept in general and includes a brief intro-
duction to operation by a step-by-step description of the configuration. The example is
intended to provide a quick overview of the settings provided. No additional equipment
is required.

3.1 Brief Introduction to the Instrument's Concept

The operating concept of the R&S SMB employs the following three ways of instrument
control:

e Manual operation
e Remote control
e Remote access

Manual Operation

The R&S SMB can be entirely operated from the front panel. Peripherals such as mouse
or keyboard can be connected but are not essential.

The R&S SMB is equipped with an intuitive user interface. The central element of the
display is the block diagram that shows the signal flow and processing from the left on
the display to most right, i.e. the generated signal can be seen at a glance.

Each block represents a functional unit of the instrument. Thus the user always knows
the position at which a parameter has an effect in the signal flow. The main settings of a
block are indicated in the block. The interconnection of employed inputs and outputs is
also shown. The user is thus always informed about the connection of inputs and outputs
in the signal flow and where they can be configured. A window is opened for each menu
where parameters can be set. When the window is opened, an entry is made in the
"Winbar" below the display. All open menus are of equal priority (not modal) and can be
accessed any time.

The block diagram in the figure below shows a fully equipped instrument.

|
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Fig. 3-1: Block diagram of a fully equipped R&S Signal Generator

With the aid of the rotary knob, the user can navigate in the block diagram and the dialogs,
and can operate the instrument with one hand. The cursor is moved line by line through
the block diagram or dialog. Turning the button clockwise advances the cursor. The
selected block can be activated or deactivated with the TOGGLE key. Active blocks are
highlighted by a colored background.

The instrument comprises a comprehensive info and help system. Context-sensitive help
can be called any time with the HELP (F1) key. The help system indicates the currently
selected parameter and offers additional services such as cross references, index and
contents. The content of the help system corresponds to the operating manual of the
instrument.

Warning and conflict messages caused by incorrect operation as well as further infor-
mation are displayed in the "Info" line. A complete list of existing conflicts is displayed
when the INFO (CTRL+I) key is pressed. Additional information on entries can be reques-
ted from the help system. The history function permits display of all messages.

Assistants simplify the completion of tables. After data entry in the assistant, the table is
modified only after the "Accept" button has been pressed. Pressing the "Accept” button
also stores the assistant data.

For an introduction into the manual operating of the instrument, detailed operating
instructions and an overview of menus refer to chapter 4, "Manual Operation",
on page 53.

For an indepth description of the dialog boxes and the instrument functions refer to sec-
tion chapter 5.1, "Overview of Instrument Functions", on page 78.

Remote Control

Remote control is an operation of the instrument by means of remote control commands
or programs that automatize repeating settings. The instrument is connected to a com-
puter running the program.

This way of operation and the instructions how to set up a connection for remote control
are described in the chapter 6, "Remote Control Basics", on page 202. The description
of the remote control commands is provided in chapter 7, "Remote Control Com-
mands", on page 243.

|
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3.2

3.3

Application Field of the Instrument

Remote Access

Remote access is the operating of the instrument from a remote computer. Both the R&S
SMB and the computer are connected in a LAN.

Remote access in contrast to remote control does not use remote-control commands
but a separate software which is installed on the remote computer. After its start, the
software simulates the user interface of the instrument. The instrument can thus be oper-
ated from the remote computer as on the unit itself. The individual functions are operated
using the mouse and keyboard. Specific instrument functions can be executed using
specific key combinations on the keyboard or a front panel key emulation that can be
operated with the mouse.

This way of operation and the instructions how to set up a connection for remote access
are described in chapter 2.7, "Remote Access via an External Controller", on page 37.

Application Field of the Instrument

The main field of application of the R&S SMB is the generation of sine wave signals with
very high spectral purity. These signals are needed e.g. for adjacent channel or phase
noise measurements. In addition, the RF signal can be modulated with the internal mod-
ulations waveforms sine waves and rectangular signals.

Description of Individual Diagram Blocks

The signal path of the instrument is configured by installing a frequency option that com-
prises all required modules.

|
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One of the following options must be installed.

e R&S SMB-B101 (9 kHz to 1.1 GHz)

e R&S SMB-B102 (9 kHz to 2.2 GHz)

e R&S SMB-B103 (9 kHz to 3.2 GHz)

e R&S SMB-B106 (9 kHz to 6 GHz)

e R&S SMB-B112 (100 kHz to 12,75 GHz)

e R&S SMB-B112L (100 kHz to 12,75 GHz, without attenuator)

e R&S SMB-B120 (100 kHz to 20 GHz)

e R&S SMB-B120L (100 kHz to 20 GHz, without attenuator)

e R&S SMB-B140 (100 kHz to 40 GHz)

e R&S SMB-B140L (100 kHz to 40 GHz, without attenuator)

Instruments without step attenuator provide a restricted level range at the RF output.
Refer to the data sheet for detailed information.

You can additionally get the following options for 20 or 40 GHz instruments:

e up to 20 GHz (R&S SMB-B120/-B120L)
— high output power option R&S SMB-B31

— low harmonic filter option R&S SMB-B25

e up to 40 GHz (R&S SMB-B140/-B140L)
— high output power option R&S SMB-B32

— low harmonic filter option R&S SMB-B26

See data sheet for detailed information.

Up-to-date information is available at R&S SMB homepage on the internet http://
www.rohde-schwarz.com/product/smb100a.html.

Mod Gen block
The internal modulation sources are configured in this block. Also, the "LF frequency
sweep" can be activated here.

An internal LF generator is available as the internal source for the analog modulations
AM, FM and PHiM. Available modulation shapes are sine and rectangle.

The internal modulation signals are provided at the LF output at the front of the instrument.
The LF output signal and the modulations sources for the analog modulations AM, FM
and PhiM can be selected independently from each other.

A pulse generator provides single and double pulse modulation with selectable pulse
widths and periods. Additionally, an option is available to generate pulse train signals.

The R&S SMB offers three different sweep types (frequency sweep, level sweep and LF
sweep) to be activated alternatively. Each type has 6 modes which differ with respect to
the sweep cycle mode (continuous, individual and step-by-step) and triggering mode
(automatic, internal and external). In the "Mod Gen" block, the LF sweep is configured.
Frequency and level sweep settings are accessed via the "RF" block.

The status display in the block shows whether LF generator and/or a sweep are active.
The selected internal LF generator and/or noise source are switched on or off with the
TOGGLE ON/OFF key.

|
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3.4

Example of Setup

Modulation block
The internal and external analog modulations are configured and activated in this block.
The MOD ON/OFF key switches the active modulation(s) on/off.

The internal modulation sources are configured in the "Mod Gen" block. External ampli-
tude, frequency or phase modulation signals can be fed in at the input connector MOD

EXT at the front of the instrument. An external pulse signal is fed in via the BNC connector
PULSE EXT at the rear of the instrument. AC or DC coupling for external feed is possible.

Modulation signals of up to two sources (internal and external source) can be combined
for AM/FM and PhiM modulation.

Available internal and external analog modulation modes are:
Amplitude modulation (AM)

Frequency modulation (FM)

Phase modulation (PhiM)

Pulse modulation (Pulse)

Stereo modulation (Stereo)

Note: For modulation modes that can be simultaneously used, refer to the R&S SMB
data sheet.

The status display in the block shows the active modulation(s). Use the TOGGLE ON/
OFF key to switch the active modulation of the block on or off.

RF block
In this block, the RF parameters and frequency/level sweep settings are set.

The active sweep is displayed in the block. The RF ON/OFF key switches the RF signal
on and off. When the signal is switched off, the switch before the RF output symbol is
open.

RF settings include:

e Frequency and reference frequency

Level settings; if required.

NRP-Z Power Viewer using power sensors

Frequency and level sweep

List Mode settings. In this mode, extremely fast frequency and level settings can be
made.

The RF 50 OHM output connector at the front of the instrument provides the RF signal.
An external trigger/gate signal for sweeps is input via the INST TRIG connector at the
rear of the instrument

Note: Frequency and level are set fast with the aid of the FREQ and LEVEL keys.
Use the TOGGLE ON/OFF key to switch the RF output on or off.

Example of Setup

This section provides an example on how to configure the instrument for generating of
an amplitude modulated signal.

|
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Generation of an Amplitude-Modulated Signal
To generate a simple AM-modulated signal, proceed as follow:

1. Activate default (preset) state
Press the PRESET key to set a defined instrument state.

Freq| RFOFF__| MODOFF | Level

| 1.000 000 000 0 o+ =] | -30.00dem -]

| ALC-S&H Info
Mod Gen | Modulationl RF |
config... config... config... w; RF
-+ + —
™ on [ on [ on

2. Select and activate AM modulation

a) Turn the rotary knob and select the "Modulation" block.

Modulation

config... |

[~ on

b) Press the rotary knob to open the dialog where the modulation can be selected.
Note: Different modulation modes are available depending on the options instal-
led.

Modulation
Amplitude Modulation.
Freguency Modulation
Phase Modulation
Pulse Modulation

The "Amplitude Mod..." menu is the first menu and is highlighted per default.
¢) Turn the rotary knob and highlight "Amplitude Mod...".
Press the rotary knob to open the "Amplitude Modulation" dialog.

d) Turn the rotary knob to select parameter "AM Depth", press the rotary knob to
allow editing and enter the preferred AM depth with the aid of the numeric keypad
and the unit keys.

|
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e) Finally, select "State" and press the rotary knob to switch on the AM modulation.

f) Press the DIAGRAM key to display the complete block diagram.
To indicate the active state, the "Modulation" block is displayed in blue. The "RF" is
not yet active, which means that no RF signal is output.

3. Set frequency and level and activate RF signal

a) Press the FREQ key to activate the editing mode for frequency entry. The "Fre-
quency" entry field in the header section of the display is highlighted.

Freq[ RFOFF_|[WMODONT]
1.000 000 000 00/ |

Enter the frequency using the numeric keypad and terminate the entry by press-
ing a unit key.
b) Press the LEVEL key and enter the level settings in the same way.

c) Press the DIAGRAM key to display the complete block diagram.
d) Turn the rotary knob to select the "RF" block.
Press the RF ON/OFF key to activate the "RF" block.

The AM modulation signal is now present at the RF output.

Leve

Freq |
| 363.000 000 00 [+ -[| -11.00 |étm -]
|

LiSweep, ALC-S&H Info

RF
— G

Generation of an RF Frequency Sweep Signal
In the example, an RF frequency sweep is configured. Proceed as follow:

1. Activate default (preset) state
Press the PRESET key to set a defined instrument state.
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Freq RF OFF | MOD OFF | Level

| 1.000 000 000 0o+ -] [ -30.00 ¢em -]

| ALC-S&H Info
Mod Gen Modulation RF
config... | config... | config... | . RF
+ + —(
" on [T on [T on

2. Configure and activate RF frequency sweep.

a) Turn the rotary knob and select the "RF" block.

b) Press the rotary knob to open the dialog where the RF frequency sweep can be
selected.

m"mLE'\l'E| Sweep...

c) Turn the rotary knob and highlight "RF Frequency Sweep...".
Press the rotary knob to open the "RF Frequency Sweep" dialog.

All sweep parameters are default except for the sweep mode. The default settings
are not changed.

d) Turn the rotary knob to select parameter "Mode", press the rotary knob to open
the selection list and select "Single".

e) Press the rotary knob to apply the selection.
For triggering, the "Execute Single Sweep" and "Reset Sweep" buttons are dis-
played.

|
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f) Finally, select "State" and press the rotary knob to switch on the RF frequency
sweep.

g) Press the DIAGRAM key to display the complete block diagram.

The "RF" is not yet active, which means that no RF signal is output.

3. Activate RF signal.

a) Turn the rotary knob to select the "RF" block.
b) Press the RF ON/OFF key to activate the "RF" signal output.

v

To indicate the active state, the RF block is displayed in blue. An RF signal with the
default frequency and level settings is output, i.e. 1 GHz and -30 dBm.
The sweep is not yet active, it must be triggered in the sweep dialog.

4. Trigger RF frequency sweep

a) Press the WINBAR key to switch to the "RF Frequency Sweep" dialog.
Turn the rotary knob to select the "Execute Single Sweep" button.

Press the rotary knob to trigger (start) the frequency sweep.

A linear single sweep signal is now present at the RF output, starting at 100 MHz.
The sweep is processed in 1 MHz steps with dwell time of 10 ms per step up to the
stop frequency of 500 MHz.

The sweep starts at 100 MHz, stops at 500 MHz in 1 MHz steps is output with a dwell
time of 10 ms per step.
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4 Manual Operation

The R&S SMB can be operated intuitively either via the interactive block diagram or via
a menu tree. All menus are in the form of windows that can be operated in the same way.
Rotary knob, keys and softkeys, or alternatively a mouse, allow direct and therefore con-
venient access to entries and settings.

The clear-cut display shows the current signal generator state. Numerous help functions
support the user in signal configuration.

This section describes the concept of manual operation of the signal generator. This
includes a description of the general structure of a dialog box, working with dialog boxes
and the block diagram and the setting of parameters.

For an in-depth description of the dialog boxes and the instrument functions refer to sec-
tion "Instrument Functions".

4.1 Key Features

The manual operating concept of the R&S SMB enables the user to make settings as
intuitively as possible and at the same time gives a permanent overview of characteristics
of the generated signal and of the current instrument state. Numerous online help func-
tions support user settings.

Block diagram
The block diagram is the core of the operating concept.

A graphics display shows the current configuration and the signal flow in the form of a
block diagram. All graphical elements can be accessed for operation. An element is
selected by means of the arrow keys and the associated setting function is called by
pressing Enter. Required menus and graphs are displayed on the block diagram which
is displayed again in the foreground whenever the DIAGRAM (CTRL+D) key is pressed.

Permanent frequency and level display

The main characteristics of the RF signal, frequency and level, are permanently displayed
in the header section of the screen and can be directly set in the display fields after the
FREQ (CTRL+F) or LEVEL (CTRL+L) key is pressed. Status messages for the output
signal are displayed in addition to frequency and level.

freq[_FFOT_J_wovor_]|

Level
1.000 000 000 00|c+= =] [ -30.00¢n -

Operation via Graphical User Interface

¢ Functional blocks
Menus are assigned to the specific function blocks in the block diagram. The function
blocks represent elements of signal generation. Function blocks displayed with a blue
frame can be directly switched on and off by means of the TOGGLE ON/OFF (CTRL
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+T) key. The menus of the highlighted function blocks can be called by pressing the
ENTER key.
— Example:
The "Modulation" block contains all menus required for modulation signal con-
figuration.

In this block all modulations can be selected.

Modulation
Amplitude Modulation.
Freguency Modulation

Phase Modulation
Pulse Modulation

e Signal flow
The signal flow between the function blocks and the employed inputs and outputs are
also shown.

e Menu tree
The menu tree can be opened and closed with the MENU (CTRL+M) key. The menu
tree is organized in the same way as the directories under Windows. The function
blocks correspond to the first directory level, the menus to subdirectories.

=+Mod Gen 1=

Mod Gen

LF Freq Sweep...

- LF Output...

i Pulse Gen..

- Maodulation

- RF

- Setup ;I

Operation corresponds to the Windows concept

To offer the user a familiar environment, operation is very similar to operation of Windows
user interfaces. All menus and tables are made up of known elements, such as selection
lists, check boxes and entry fields.

A blue frame indicates that the selected item is active. In the highlighted element, entries
can be made.
Rotary knob

Operation is possible via front-panel keys, an external keyboard and the mouse. How-
ever, most of the settings can be easily made with the rotary knob:

e Turning the rotary knob shifts the entry focus to the target element.
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e Pressing the rotary knob activates the selected entry field.
Depending on the parameter, the submenu is called, the numeric value varied, the
list entry selected or the check box activated or deactivated.

e If avalue is entered, the entry is stored by another click on the rotary knob and the
editing mode is exited.

Clear settings with the aid of independent subdialogs

A separate window is opened for each dialog and subdialog. The dialogs can be operated
independently of each other, i.e. none of the dialogs requires that settings in other dialogs
be completed before it can be closed. This ensures flexible operation at all times.

Keys with assigned simple functions
Most keys on the front panel of the R&S SMB directly perform a simple function.

Since a great number of settings can thus be made by a keystroke, operation is easy.
For instance, the CLOSE (ESC) key closes the active menu; with the RF ON/OFF (CTRL
+R) key the RF output signal can be switched on or off.

An exception are keys that call a menu such as the MENU (CTRL+M) key which opens
the complete menu tree of the instrument, the SETUP (CTRL+E) key which opens the
menus for general instrument settings or the FILE (CTRL+S) key which opens the menu
for file management.

Help functions for user support
Numerous help functions support the user in signal configuration.

e Value ranges
The valid setting range is displayed for each numeric parameter. This requires a short
wait after activation of the entry field. The range is then displayed automatically after

a few seconds.
Phase Settings

Celta Phase lf|deg =
Reset Delta Phad Min =-720.0 deg
——————————— Max=720.0 deg

insert mode

If the entered value is outside the permissible range, the next permissible value is
automatically set and a message is output.

o Context-sensitive help
Context-sensitive help for each parameter can be called with the HELP or F1 key.

e Comprehensive online help
Each help page is part of a comprehensive online help function which can be called
by means of an index, a content tree or the "Previous/Next" buttons.

Info line with messages for indication of the current instrument state

A great variety of different messages such as status messages, error messages, warn-
ings or information are displayed in the header field of the screen. With the aid of the
INFO (CTRL+I) key, help pages can be called for most of the messages. They provide
background information on the message and indicate operating steps that may be
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required. All messages are explained in the online help which can be called with the
HELP (F1) key.

4.2 Display

The display shows the current signal generator state and offers graphical elements for
direct operation. It is divided into three sections:

e The frequency and level display with info line indicates the main output signal param-
eters and reports the current state with status, error and warning messages.

e The block diagram shows the instrument configuration, the signal characteristic as
well as the inputs and outputs used and permits interactive operation via graphics
elements. Active menus and graphs are displayed on top of the block diagram.

e Winbar with labelled softkeys for menu display.

The block diagram in the figure below shows a fully equipped instrument.

Fig. 4-1: Block diagram of a fully equipped R&S Signal Generator

4.2.1 Settings Displayed in the Header Section

Frequency/level settings and a few status messages (see chapter 4.2.2, "Status Infor-
mation and Messages", on page 57) are displayed in the header field of the screen.
The display may vary depending on the instrument's operating mode:

e In the sweep mode, the current frequency or level of the output signal is displayed.
The status message "SweepMode" is displayed in the info line.

e In the list mode, neither the current frequency nor level is displayed, the indication is
dimmed.

e If user correction is active, the status message "UCorr" is displayed in the info line.
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The values displayed in the "Freq" and "Level" fields include a set offset or multiplier
factor.

For more See alos chapter 5.3.2, "RF Frequency", on page 116 and chapter 5.3.5.1,
"Overview of RF Level", on page 121.

The frequency and level indication can be enlarged so that it covers the complete display
of the R&S SMB by using the DIAGR key. This key toggles between block diagram,
magnified frequency and level indication and the display of the active dialog. This requires
the "Summary Screen Toggle" to be enabled.

See also "Toggle Summary Screen" on page 93.

4.2.2 Status Information and Messages

The status information and messages are displayed in the header section of the screen.
The messages differ with respect to their importance (errors, warnings, info) and the time
of their appearance (brief and permanent messages). They require different treatment
by the user. Further information on all messages can be called in the info window (see
chapter 4.2.3, "Info Window", on page 58).

Refer to chapter 9, "Error Messages", on page 437 for an overview of all status infor-
mation and messages as well as instructions for error elimination.

4.2.2.1 Status Information

The status information gives the user an overview of the main operating states and set-
tings of the instrument. The states are indicated for information only and do not neces-
sitate any action by the user.

Status information is displayed between the frequency and level fields, at the left of the
info line or in the info line itself.

4.2.2.2 Messages

Messages indicate errors in the instrument. They are displayed in the info line in different
colors depending on their importance and display duration. Errors (e.g. no calibration

data) are displayed in red, information (e.g. file not found) and warnings in black. Warn-
ings indicate less significant errors (e.g. the instrument operates outside specified data).

4.2.2.3 Volatile messages

Brief messages report automatic settings in the instrument (e.g. switching off of incom-
patible types of modulation) or on illegal entries that are not accepted by the instrument
(e.g. range violations). They are displayed in the info line on a yellow background. They
are displayed on top of status information or permanent messages.

Volatile messages do not normally demand user actions and disappear automatically
after a brief period of time. They are stored in the history, however.
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4.2.3

Display

These messages can be read from remote using the commands : SYSTem:ERRor [ :
NEXT]? and :SYSTem:ERRor : ALL.

Permanent Messages

Permanent messages are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signalled by a permanent message must be
eliminated before correct instrument operation can be ensured.

The message is displayed until the error is eliminated. It covers the status display in the
info line. After error elimination, the message automatically disappears and is also recor-
ded in the history.

These messages can be read from remote using the command : SYSTem: SERRor 2.

Info Window

A few operating states and the current message are displayed in the info line.

The INFO window with a list of current permanent messages and a detailed description
of each message can be opened with the INFO (CTRL+I) key.

The upper section of the info window contains a list of all current permanent messages
in the order of their occurrence, i.e. the most recent message is displayed first. In the
lower section of the window, additional information on the highlighted message is dis-
played. A history of all messages that have occurred since instrument switch-on can be
called with the "History" key. The most recent message is displayed first.

The messages are color-coded according to their level. Device-specific messages are
red, info and remote control error are black. The level is also indicated in the "Lev" column
(Err, Sys or Info). Column "SCPI" indicates the SCPI error code.

With the aid of the softkey buttons, error messages can be cleared and a history of all
messages called.

Delete
Clears the highlighted message.

This button is available only if the history of the messages is displayed.

Delete All
Clears all messages.

|
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Display

This button is available only if the history of the messages is displayed.

History

Calls the list of all messages that have occurred since instrument switch-on. The most
recent messages are displayed at the top of the list. When the button is pressed again,
the list of current messages is displayed.

Remote command:

:SYSTem:ERRor [ :NEXT] 2 on page 394 or STATus : QUEue [ : NEXT] 2 on page 391
Each time a SYST:ERR? or STAT: QUE ? query is sent, the oldest entry in the error queue
is returned and at the same time cleared in the list.

Block Diagram

The block diagram shows provided options, signal configuration and the currently
selected signal flow of the generator with inputs and outputs used. Signal generation can
be completely operated from the block diagram. The highlighted function block can be
directly switched on and off with the TOGGLE ON/OFF (CTRL+T) key. Pressing the Enter
opens the associated setting menu.

Fig. 4-2: Block diagram of the R&S SMB

Function Blocks in the Block Diagram

Each block represents a function of signal generation. The function is indicated in the
headline of the block. In the check box, the respective function can be quickly activated/
deactivated with the TOGGLE ON/OFF (CTRL+T) key. After activation, the block is dis-
played in blue. Status information is displayed below the check box. It is different for the
different blocks.

Pressing the rotary knob (front panel) or the "Config..." button (mouse) opens the asso-
ciated setting menu.

Example: Modulation block

Modulation
Amplitude Modulation...
Freguency Modulation. ..
Fhase Modulation...
Fulse Modulation...

In this block, the modulation signals are set. The status information of the "Modulation”
block indicates the selected modulation.
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4.2.4.2 Signal Flow and Input/Output Symbols in the Block Diagram

The input/output symbols in the block diagram show the currently used inputs and outputs
of the signal generator. Unused inputs and outputs are not shown. The lines indicate the
signal flow.

Symbols and labels refer to the corresponding inputs and outputs on the front and rear
panel of the signal generator. The direction - input or output - is indicated by an arrow.

Example:

PULSE The symbols indicate the input for the external pulse signal on the
instrument rear panel.

4.2.5 Structure of the Dialogs

The parameters are set in the menus. Menus are accessed either via the function blocks
in the diagram or by means of the MENU (CTRL+M) key. The menus are displayed on
top of the block diagram.

The WINBAR key toggles between the active menus. The REARR key toggles between
the enlarged and normal sized menus.

Working with menus and dialog boxes is described in chapter 4.3, "Accessing Dialogs",
on page 61; the setting of parameters in chapter 4.4, "Setting Parameters”,
on page 62.

The menus are in Windows format. The menus differ in details depending on their function
but they consist of the same main elements. Each menu consists of a menu header and
one or more menu areas with various fields for setting parameters.

The header line contains the name of the menu and the buttons for minimizing and closing
the menu. To operate the buttons, use the mouse or the front key CLOSE (ESC).

Several fields of associated but separately set parameters are organized in menu areas.
A menu area is framed and labelled with the function common to all parameters.

Example: Pulse Generator

Pulse Generator

Fulse Mode ISingIe vl

Fulse Periad I 1.0000 Ims vl
FPulse Width I 500.0 Ius vl

Each of the setting fields is assigned a parameter name. The kind of setting varies
depending on the parameter to be set. Some settings can only be made in a specific
configuration. If setting is not permitted with the specific configuration selected, the
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respective item is disabled and displayed in gray and the entry or selection field cannot
be accessed.

4.3 Accessing Dialogs
The MENU (CTRL+M) key opens the complete menu tree. Selecting a functional block
and pressing the ENTER key opens the menu associated with this block.

An alternatively way to access a dialog is to use the CLOSE (ESC), DIAGRAM (CTRL
+D) and REARR (CTRL+A) keys on the front panel.

For a quick access to the dialogs, use one of the following alternative methods.

Displaying the block diagram or a dialog in the foreground

» Press the DIAGRAM (CTRL+D) key to move the cursor to the block diagram.

All active menus are minimized.

Enlarging the indication of the header section

» Press the DIAGRAM key twice to enlarge the indication of the header section.
Tip: Use the REARR key to toggle between the enlarged and normal sized dialogs.

Accessing the menu tree

» Press the MENU (CTRL+M) key to open the complete menu tree.

Calling the File or Setup dialog
» Use the FILE (CTRL+S) or SETUP (CTRL+E) keys to open the respective dialog.

Closing an active menu

» Press the CLOSE key to close an active menu.

Tip: If the cursor is at the highest menu level, you can also use the ESC key to close
the active menu.
Accessing the header area

» Press the FREQ (CTRL+F) and LEVEL (CTRL+L) keys to activate the "Frequency”
or "Level" entry fields in the header area.

Keyboard Shortcuts

Keyboard shortcuts (e.g. "Ctrl + D" for the displaying the block diagram in the foreground)
provide direct access to all utility dialogs of the instrument (see chapter 4.8, "Legend of
Front-Panel Controls", on page 75).
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4.4 Setting Parameters

The R&S SMB offers several and sometimes alternative possibilities for setting param-
eters. Operation is possible from the front panel, with the aid of a mouse and/or from a
PC keyboard.

The examples whitin this description focus on the operation from the front panel.

For more information, refer to:

e chapter 4.8, "Legend of Front-Panel Controls", on page 75 for an overview of key
functions and a cross-reference between the front panel keys and the keyboard
shortcuts

e section "Instrument Functions" for a detailed description of key functions.

Most of the parameters are set in the different menus. The R&S SMB provides alternative
ways for accessing the dialogs. Turn the rotary knob and navigate to the corresponding
block in the block diagram and press the knob to open the dialog or perform a mouse
click on the "Config..." button.

An exception are the "Setup" and "File" dialogs. In the "Setup" dialog, general settings
are made which are not directly concerned with signal generation, e.g. setting of the
GPIB-bus address. In the "File" dialog, files and lists are managed.

These menus can only be called with the SETUP (CTRL+E) and FILE (CTRL+S) keys.

Frequency and level are directly set in the header area of the display using the FREQ
and LEVEL keys.

Specific settings can also be made directly in the block diagram, e.g. activating a function
block by means of the TOGGLE ON/OFF (CTRL+T) key or switching the RF output on
and off with the aid of the RF ON/OFF (CTRL+R) key. Changes affecting the signal flow
are immediately visible in the graphics display.

This section provides an information about the parameter handling that comprises of the
following main steps:

® chapter 4.4.1, "Working with the Cursor", on page 63

e chapter 4.4.2, "Selecting a Control Element", on page 63

e chapter 4.4.3, "Switching Parameters On/Off", on page 63

e chapter 4.4.4, "Entering a Value", on page 64

e chapter 4.4.5, "Working with Units ", on page 65

e chapter 4.4.6, "Selecting a Value from a List", on page 66

e chapter 4.4.7, "Terminating Entries with Confirmation", on page 67

® chapter 4.4.8, "Restoring the Previous Value", on page 67
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441 Working with the Cursor

After the instrument is switched on, the cursor is always on the first function block of the
diagram (default setting).

Moving the cursor on the display

» To move the cursor, use one of the following alternative methods:

a) Use the rotary knob or the arrow keys.
b) Use the WINBAR key to toggle between the active dialogs.
c) Use the ESC key.

Tip: Be aware that the function of the ESC key depends on the current cursor position.
The function of this key depends on the current cursor position.

e Calls the next higher selection level.

e Closes the open window without accepting new entries; the old value or param-
eter is retained.

In dialog boxes that contain a "Cancel" button it activates that button.

Closes all kinds of dialog boxes, if the edit mode is not active.

Quits the edit mode, if the edit mode is active.

Switches between different entry fields of a menu.

Shifts the entry cursor from the header display to the previously active menu, or
to the previously highlighted block in the block diagram if no menu is active.

Moving the coursor to the heading area

» Pressthe FREQ (CTRL+F)or LEVEL (CTRL+L) key to move the cursor to the header
area.

4.4.2 Selecting a Control Element
Control elements are always selected in the same way no matter whether a function block
in the diagram, a menu in the menu tree, a parameter in the menu or an entry in a list or

table is concerned.

» To activate an element, put the cursor on it.

Source |Imerna| jl

An active element is highlighted by a blue frame.

4.4.3 Switching Parameters On/Off
A parameter can be activated and deactivated using a button or a check box.

1. Select the parameter.
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2. To change the state of a parameter, use the "Enter" function of the different control
media:

e Press the rotary knob
e Press ENTER
e Press the TOGGLE ON OFF (CTRL+T) key.

Colour and label of a button change, the check box is ticked or the tick is removed.

444 Entering a Value

Numeric and alphanumeric values can be edited in the entry fields. In the editing mode,
cursors of different colour are used. A blue cursor indicates the overwrite mode, a green
cursor the insert mode.

Numeric and alphanumeric values can either be newly entered or the existing value can
be changed. Incorrect entries are cleared with the BACKSPACE key.

Entering a new numerical value
1. Select the parameter.
2. Press a numeric key to activate the editing mode.

The previous value is cleared and the new value can be entered.

Editing a value in the insert mode (default setting)

1. Press the rotary knob (= Enter) to activate the editing mode.

If the cursor is placed at the right of the total value, the insert mode is always active.

2. Set the cursor to the left of the number to be changed using the LEFT/RIGHT arrow
keys.

The cursor is displayed in green.

3. Click on a numeric key to insert a new value.

Editing a value in the overwrite mode
1. Activate the editing mode.

2. Setthe cursor on the numeric digit to be changed using the LEFT/RIGHT arrow keys.

The cursor is displayed in blue and the number to be replaced is highlighted.

3. Click on a numeric key to overwrite the highlighted value.

Varying a value

1. Activate the editing mode.
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2. Set the cursor to the left of the number to be changed using the LEFT/RIGHT arrow
keys.

The value at the cursor position is varied.
3. To vary the selected value, use the UP/DOWN arrow key or turn the rotary knob.

The value is increased or decreased.

Entering a new alphanumerical value
1. Select the parameter.
2. Press an alphanumeric key to start the editing mode.

The new value is entered.

Editing an alphanumerical value

An existing value, e.g. a file name, can be changed in the insert mode (see example) or
in the overwrite mode.

1. Select the paramter and activate the editing mode.

2. Set the cursor to the left of the alphanumerical value using the LEFT/RIGHT arrow
keys.

Tip: If hexadecimal values are to be entered, the numeric front-panel keys are auto-
matically changed to hexadecimal values.

3. Click on an alphanumeric key to insert a new alphanumerical value.

Terminating the entry of a numeric value
To terminate the entry of a numeric value:
1. Press the rotary knob (= Enter).

2. Press a UNIT key on the front panel.

3. Select a "Unit" in the selection field next to the parameter value.

Working with Units

The unit of a parameter is displayed next to the value. When the parameter is edited, the
unit is selected either from the list or by means of the front-panel keys. When the entry
is completed, the unit can be changed. In this case the value remains unchanged but is
automatically adapted to the new unit.

@

While operating the instrument by means of a mouse, assign the unit to the selected
parameter before entering its value.
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Assigning a unit
To assign a unit to a value, use one of the following alternatives:

1. Press a UNIT key on the front panel.

2. Select a "Unit" in the selection field next to the parameter value.
Press the ENTER key.

The unit displayed in the entry field next to the value is assigned.

Changing a unit

To subsequently change a unit, i.e. after the entry has been terminated and when the
editing mode is not active, use one of the following alternatives:

1. Press a UNIT key on the front panel.
2. Select"Unit" in the selection field next to the parameter value.

The value remains unchanged but the display is automatically adapted to the new
unit, i.e. the value is recalculated to suit the new unit.

The new unit is indicated in the value field of the menu.

Selecting a Value from a List

Selection lists provide a list of predefined values for the selected parameter.

Source Internal  «

Internal
External

Cutput

To select a item from a list, proceed as follow:
1. Press ENTER key to open the list.

2. Use one of the following alternatives to navigate through the list:

a) Turn the rotary knob or use the UP/DOWN arrow keys.
The selected item is highlighted.

b) Press TOGGLE ON/OFF key several times until the preferred entry is displayed
in the selection field.

3. To confirm the selection, press the ENTER key.

|
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Terminating Entries with Confirmation

The instrument behaves different by the termination of entries deppending on the param-
eter type and the way this parameter is set.
Confirming settings

» To confirm the settings, press the rotary knob or one of the UNIT keys (see also
chapter 4.4.5, "Working with Units ", on page 65) .

Note: Variations by means of the rotary knob are immediately set.

Confirming multiple values

In some cases, like for instance when editing data in a user correction table, it is useful
first to enter few values and to confirm them together. Such settings require additional
confirmation. Not yet confirmed settings are displayed on a yellow background as an
indication that the currently displayed values do not represent the target signal.

» To confirm these settings, select the "Save" or "Accept" button, respectively.

Confirming parameters with On/Off state

Most of the instrument functions with enabled and disabled states are calculated and
effective only after this functions have been enabled. However, there are functions like
the frequency variation of the reference oscillator for instance, that are immediately set
after confirmation.

» To confirm a parameter with On/Off state, enable the parameter.

Restoring the Previous Value
Parameter variations with the rotary knob are immediately set and therefore not reversi-
ble.

Normally, values cannot be restored in the case of mouse control because no explicit
confirmation is required in this case and entries are automatically confirmed when the
entry or selection field is exited.

Restoring values

In the case of front-panel control or operation from the keyboard, previous values can be
restored as long as the new value is not confirmed, i.e. the entry is not completed.

» To restore the values, press the ESC key.

Restoring values that require confirmation

All settings that are not confirmed with the "Accept" button but require this additional
confirmation can be restored.

1. Press the ESC key.

A confirmation query is displayed.

|
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Editors

2. Confirm with "OK" to abort the changes.
Select "Cancel" to return to the dialog. The previous selected settings are displayed.

Restoring values after an extended calculation has been started

Calculation and setting might require different period of time. Many settings are made
without noticeable calculation times; such operations are indicated by a "BUSY" message
displayed in the status field of the header section.

A window with a progress indicates that the instrument performs an extended calculation
that requires longer calculation time. The termination of such a calculation restores the
previous values.

» Press the ABORT button to terminate the calculation.

All previous values are restored.

Editors

The R&S SMB provides user-friendly editors for defining lists. Lists containing frequency
and level value pairs are used for the list mode and the user-defined level correction.

The lists are saved to files and may thus have any length. The file name of the lists and
the directory to which the files are saved are user-selectable. The file prefix is different
for each list type and is permanently assigned by the system.

For information about file handling and overview of the automatically assigned file pre-
fixes, refer to chapter 4.7, "File Management", on page 71.

Working with List Editor

The "User Correction" and "List Mode" dialogs provide a list editor for defining the fre-
quency/level value pairs.

Editing list mode data lists

1. To access a list editor and open an existing data list for editing, use the cursor keys
to select the associated button "Edit User Correction Data..." or "Edit List Mode
Data..." (if available) in the individual menu.

The selected list is displayed and the cursor marks the first row of the "Frequency/
Hz" column.

|
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FrequencyHz Power/dBm |~
100 000.000 -140.00
4100 010.000 -140.00
100 020.000 -140.00
100 030.000 -140.00
100 040.000 -140.00
100 050.000; -140.00
100 080.000 -140.00
100 070.000 -140.00
100 080.000; -140.00)

w ||~ oo

Goo | Eat | sawe |

If no list has been selected, a blank list of only one row is displayed.

Press the LEFT/RIGHT arrow keys to change between the colums.
Use the UP/DOWN arrow keys to mark a row.

Use the numeric keys to enter the value for the value pairs in the "Frequency/Hz" and
"Power/dBm" table columns. A blank row is inserted at the end of the list.
Terminate the entry by pressing a UNIT key.

To select a row, select the "GoTo" button and press the ENTER key.
Use the numeric keys to enter the row index in the entry field and press the
ENTER key to confirm the entry.

The cursor moves to the selected row.

To insert a new row in the table, select the row above which the new row is to be
inserted and select "Insert Row(s)".

A row is inserted above the currently marked row.
If no row has been selected, a row is inserted at the beginning of the list.

Use the "Save" function to save the edited list under its current name.
Enter the file name in the "File Select" dialog and select the directory (see chap-
ter 4.7.1, "File Select Dialog", on page 72).

Only complete value pairs are taken into consideration; rows containing an entry in
only one column are ignored.

Creating a new list mode data list

A new list can be created under a new name either by generating a blank file in the "File
Select" menu (see section chapter 4.7, "File Management", on page 71) or by changing
an existing list which will then be saved under a new name.

1.

2.

To create an empty data list, select "RF > List Mode > List Mode Data... > New
List" or respectively "RF > User Correction > User Cor. Data... > New User Correction
Data" and enter the file name of the new data list.

To open the data list for editing, select the associated button "Edit User Correction
Data..." or "Edit List Mode Data..." in the individual menu.
Edit the list and save it under a new name.

|
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4.6 How to Use the Help System

The R&S SMB is equipped with a context-sensitive help function. A help page is available
for each parameter and can be called any time during instrument operation.

CD-ROM supplied with the instrument. This help program can be called on any controller

@ Compiled online help systems are also available for all functions of the R&S SMB on the
with Internet Explorer version V4.0 and higher.

Calling context-sensitive and general help

> To display the general help dialog box, press the HELP (F1) key.

The help dialog is displayed. A topic containing information about the current menu
or the currently opened dialog box and its function is displayed.

elp - State =3
Contents Index Back =

Instrument Function > Modulations =
Amplitude Modulation (AM) > Amplitude
Modulation Menu > State

State

Activates/deactivates AM modulation.

SCPI command:
[:S0URce<hw>]:AM:S5TATe j

On top, the help dialog box contains a navigation bar with:

e "Contents" - accesses a table of help contents

e "Index" - switches to an index table

e "Back "/"Previous"/"Next" for navigation to further help topics

Navigating in the table of contents

1. To move through the displayed contents entries, use the UP/DOWN keys. Entries
that contain further entries are marked with a plus sign.

2. Todisplay a help topic, press the "ENTER" key.
The corresponding help topic is displayed.

Navigating in the help topics

1. To scroll through a page, use the UP/DOWN arrow keys.

2. To jump to the linked topic, press the link text.

3. Use the "Previous" or "Next" links to jump to the corresponding topic.
4

Use the "Scroll Right" or "Scroll Left" buttons to shift the indicated area of the navi-
gation window to the left or right.

|
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Using the Index
1. Select "Index".

2. Enter the first characters of the topic you are interested in. The entries starting with
these characters are displayed.

3. Press the ENTER key to change the focus.
4. Use the UP/DOWN keys to navigate and select the suitable keyword.
5. Press the ENTER key to display the help topic.

The corresponding help topic is displayed.

Closing the help window

» Press the HELP (F1) key.

File Management

The R&S SMB uses files to save all instrument data, i.e. system and user data.
The user data includes saved instrument settings and lists and the user correction.

The files are stored in the internal memory of the instrument or on a USB memory stick.
The /var directory can be used to save user-defined data; any subdirectory structure
can be created on /var. Some default subdirectories are predefined, but can be changed
at any time.

The /opt directory is a protected system drive and therefore unaccessible system direc-
tory. The files on this directory contain data that must not be changed. Therefore, this
drive should not be accessed, since reconstruction of the system partition will lead to data
loss. To prevent inadvertent deletion or overwriting of system files, this drive is not speci-
fied in the file menus.

Files can be exchanged either via a memory stick or a connected network. A memory
stick is connected to the USB interface and is assigned the var/usb/ drive. In the case
of a connected network, all network drives that can be accessed are available. The files
are accessed in a "Save/Recall" dialog in the individual menus.

The files are differentiated according to their extensions; each type of file is assigned a
specific file content. The extension is usually of no consequence to the user since access
to the files occurs in the individual menus where only the relevant type of file is available.
See chapter 4.7.2.1, "Extensions for User Files", on page 74 for an overview of the
supported file extensions.

The user data can be roughly divided into the following data types:

e Settings
Instrument settings can be saved and loaded. In case of saveing, the current setting
is saved to the specified file.

e Lists

|
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Lists, e.g. user correction lists, can be loaded. They can be generated either exter-
nally or internally. For internal generation, a new list must be created in the "File
Select" dialog which will then be edited in the list editor of the individual menu.

For more information, refer to:

e chapter 4.8, "Legend of Front-Panel Controls", on page 75 for an overview of key
functions and a cross-reference between the front panel keys and the keyboard
shortcuts

e to section "Instrument Functions" for a detailed description of key functions.

Accessing files with user data

1. Toaccess an editable user datafile, select the "Save/Recall" or "File Manger" function
in the individual dialog.

Recall Settings
Save Settings
File Manager...

2. To access a loadable data file, select the "Select/New" or "File Manager" function in
the individual dialog.

Select User Correction Data
MNew User Correction Data
File Manager...

3. To access the "File Manager" function, press the SETUP (CTRL+E) key and select
"Save/Recall > File Manager".

A "File Select" window for loading, saving or creating a file or the "File Manager"
dialog for managing all files is displayed.

Saving and loading of all instrument settings
All instrument settings are saved and loaded in the "File" menu.

To access the "File" menu, press the FILE (CTRL+S) key.

For more information, see chapter 5.2.8, "Storing and Loading Instrument Data - File
Key", on page 107.

4.7.1 File Select Dialog

The "Save/Recall" dialaog displays the available drives and directories. In the upper part,
"Recent Data Sets", the files last used are listed.
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The available drives and directories and the files of the selected directory are displayed.
The currently selected path is displayed above the window. Only the relevant files without
file extensions are displayed. If the area is opened several times, the path last selected
is displayed. When a file is saved or created, its name is user-selectable; the extension
is assigned automatically and cannot be entered. The file is saved to the selected path.

In addition to the files saved by the user, some menus also offer files containing prede-
fined contents. These files are saved to a specific directory on system drive; for this rea-
son, this directory cannot be chosen from the "File Select" menu.

Working with the File Select dialog
1. Access the "File Select" dialog (see "Accessing files with user data" on page 72).
2. Navigate in the "File Select" dialog.

3. Load an existing file.
In the "Recall Settings" dialog, mark a file and press the "Select" button.

4. Save afile.
In the "Save Settings" dialog, enter file name in the "File Name:" field.
Select the directory to which the file is to be saved and then select the "Save" button.

5. Create a new file.
To create a new file, use the "Save Settings" functionality, i.e. specify file name and
directory and save the file.

The created file is empty; it must be filled with the necessary values in the individual
editor.

File Manager

The "File Manager" allows general file management such as copying, shifting, renaming
and deleting files as well as generating new directories.

|
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Use the "File Type" to select a file type form the list. This can be used to process either
all files (all files (*) selection) or a specific selection of files. See chapter 4.7.2.1, "Exten-
sions for User Files", on page 74 for an overview of the supported file extensions. The
available drives and directories and the files of the selected directory are displayed. The
currently selected path is displayed above the windows. If the area is opened several
times, the path last selected is displayed. Unlike the "File Select" window, the "File Man-
ager" displays the full file names including extensions.

Working with the File Manager dialog

1. Accessing the "File Manager" dialog (see "Accessing files with user data"
on page 72).

2. Navigating in the "File Manager" dialog.
Operation is similar to the operation of menus with several areas.

3. Moving, duplicating, deleting or renaming files
To move a file, select the file and press the "Cut" button. Mark the directory to which
the file is to be moved and select the "Paste" button. If the target directory already
contains a file with the same name, a confirmation query is displayed to confirm
overwriting of this file.
Perform the similar steps and cut/copy/rename/delete the file.

Tip: The operation corresponds to the Windows concept.
4. Creating a new directory
Mark drive or directory level where the new directory is to be created, select the

"Create New Directory" button and enter the name of the new directory in the entry
window that opens. Confirm with ENTER.

4.7.2.1 Extensions for User Files

The following table lists all available file extensions for user files. The currently available
files on the instrument depend on the installed options.
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Table 4-1: List of the automatically assigned file extensions in the instrument

Function List type Contents File suffix
Instrument State Settings Instrument settings *.savrcltxt
"User Correction" List User-defined level correction values *.uco

Export Data *.txtor*.csv
"List Mode" List User-defined frequency/level value pairs * . lsw

Export Data *.txtor*.csv
"Pulse Train List" User-defined offtime/ontime/repetition values * . pulstrn
NRP Settings Settings NRP Settings *.nrp

4.8 Legend of Front-Panel Controls

The following table lists all key functions available on the front panel. Key combinations
used on the PC keyboard to trigger key functions on the instrument front panel are also
described. Keyboard labels are described in alphabetical order.

In addition, a front panel key emulation and an on-screen keyboard can be used for
manual operation by mouse only.

Table 4-2: Cross-reference between the front panel keys and keyboard shortcuts

Front-panel key Key of PC keyboard Function

Turning the rotary knob | Tab key (towards the right) | Sets the cursor with the rotary knob.
Shift + Tab (towards the left)

Pressing the rotary Enter Pressing the rotary knob confirms an entry; it has the

knob same function as the ENTER key.

Arrow keys Arrow keys Moves the cursor.

RV rLH# Enters a period/decimal point. Enters a special char-
acter.

-/ A<->a -/ (shift+) a—z Enters the sign.
Switches between upper-case and lower-case let-
ters.

0-9/a..z CTRL+ 0-9/a...zCTRL Enters the number/letter.

BACKSPACE Backspace Clears the last entry (number, sign or decimal point)

DIAGR CTRL+ D Sets the cursor on the block diagram and hides all
menus.

ENTER/*1/dB(m) Enter Terminates an entry.

ALT + F12 Confirms entries in the base unit and values without

a unit.

Selects dBm for the RF level and dB for level offset
and level step width.
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Front-panel key Key of PC keyboard Function

ESC /CLOSE ESC/CTRL+G Selects the next higher menu/selection level. When
the editing mode is exited with ESC, the previous
value is restored.

Closes an active menu.

FILE CTRL+ S Activates the menu for storing instrument settings.

FREQ CTRL+ F Activates the frequency entry.

G/n / dBuV ALT + F9 Selects the unit Giga/Nano, dBuV for the RF level
and dBu for the LF level.

HELP F1 Opens/closes context-sensitive help.

INFO CTRL +1 Opens/closes the info window

k/m / mV ALT + F11 Selects the units kilo/milli and mV for RF levels.

LEVEL CTRL +L Activates the level entry.

LOCAL CTRL+Q Switches the instrument from remote control to man-
ual control.

M/u / uV ALT + F10 Selects the units Mega/Micro and uV for RF levels.

MOD ON/OFF CTRL+O Switches modulation on/off. "MOD OFF" is indicated

in the status line.

ON/OFF TOGGLE CTRL+T Switches a block or parameter on/off.

Toggles between the different possibilities of setting
a selection parameter.

PRESET CTRL +P Restores a defined basic instrument setup.

RF ON/OFF CTRL+R Switches the RF output signal on/off. "RF OFF" is
indicated in the status line.

SETUP CTRL+E Opens the setup menu for general instrument set-
tings.

WINBAR CTRL +W Toggles between the active menus.

4.8.1 Front Panel Key Emulation

The R&S SMB provides a front panel key emulation to enable execution of the front panel
key functions by mouse e.g. for remote access. The emulation is called by a right mouse
click. The front panel key functions are executed by a mouse click on the associated
button.

|
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5 Instrument Function

5.1 Overview of Instrument Functions

This chapter explains the functions of the R&S SMB and the options available in the
setting menus. The associated SCPI command is specified for each parameter (where
applicable).

The description starts with the general instrument settings which do not directly affect
signal generation. The maijority of these settings can be accessed by means of front-
panel softkey menus and not by means of function block menus.

The signal generation functions are then described, beginning with the functions which

affect the RF signal ("RF" block) and the analog modulations ("Mod" block). The config-
uration of the modulation generators (LF generators and pulse generator) and of the LF
sweep is offered in the "Mod Gen" block. The clock synthesis signal is set in the "Clock
Synthesis" block.

The general instrument settings include various functions, such as:

e Setting a defined basic setup using the PRESET key
see chapter 5.2.2, "Default Instrument Settings - Preset Key", on page 80

e Switching from remote control to manual control using the LOCAL key
see chapter 5.2.4, "Switching to Manual Control - Local Key", on page 102

e Configuring the generator and its interfaces in the "Setup" dialog - e.g. setting the
GPIB address, starting an adjustment, querying instrument data
see chapter 5.2.3, "General Configuration of Instrument - Setup Key", on page 81

e Calling up the online help using the HELP key
see chapter 5.2.7, "Help System - Help Key", on page 106

e Querying messages using the INFO key
see chapter 5.2.6, "Messages - Info Key", on page 106

e | oading and storing complete instrument settings in the "File" menu

see chapter 5.2.8, "Storing and Loading Instrument Data - File Key", on page 107
The RF signal and the reference oscillator are configured in the "RF" function block:
e CW mode

see chapter 5.3.1, "Overview of RF Signal", on page 114

e List mode
see chapter 5.3.7.4, "List Mode", on page 159

e Frequency and Level Sweep mode
see chapter 5.3.7.1, "Overview", on page 147

e Reference Oscillator

see chapter 5.3.4, "Reference Oscillator”, on page 119
e RF Level

see chapter 5.3.5.1, "Overview of RF Level", on page 121
e RF Level Sweep
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see chapter 5.3.7.3, "RF Level Sweep", on page 155
e ALC

see chapter 5.3.5.4, "Automatic Level Control - ALC", on page 128
e Power Sensors

see chapter 5.3.6.1, "NRP-Z Power Viewer", on page 141

e User Correction
see chapter 5.3.5.6, "User Correction”, on page 134

The analog and external digital modulations are activated in the "Modulation" function
block:

e Amplitude Modulation

see chapter 5.4.2, "Amplitude Modulation (AM)", on page 169
e Frequency Modulation

see chapter 5.4.3, "Frequency Modulation (FM)", on page 172
e Phase Modulation

see chapter 5.4.4, "Phase Modulation (PhiM)", on page 175
e Pulse Modulation

see chapter 5.4.5, "Pulse Modulation (PM)", on page 178
e Stereo Modulation

see chapter 5.4.6, "Stereo Modulation", on page 180

The internal LF generators, the LF frequency sweep and the pulse generator are con-
figured in the "Mod Gen" function block:

e LF Frequency Sweep
see chapter 5.5.3, "LF Frequency Sweep", on page 189

e LF output
see chapter 5.5.2, "LF Output", on page 187

General Instrument Settings

Overview of General Instrument Settings

This section describes the settings which do not directly affect signal generation. Most of
these settings can only be accessed by means of menus which are opened using keys
or key combinations on the external keyboard or keys on the front panel key emulation.

The general instrument settings therefore affect various functions, such as storing instru-
ment settings using the FILE key or setting the GPIB address in the menu of the
SETUP key. The order in which the descriptions are given corresponds to the layout of
the keys on the front panel of the R&S SMB (from top left to bottom right).

|
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5.2.2 Default Instrument Settings - Preset Key

The PRESET key calls up a defined instrument setup. All parameters and switching
states are preset (also those of inactive operating modes). The default instrument settings
provide a reproducible initial basis for all other settings.

However, functions that concern the integration of the instrument into a measurement
setup are not changed, e.g. GPIB address or reference oscillator source settings.

When the instrument is switched on, it is not the preset state that is active, but rather the
instrument state that was set before the instrument was switched on.

User-defined instrument states can be stored and called up in the "File" menu.

@ Resetting the instrument to the factory state is possible with the Factory Preset function.

Preset
Presets all parameters and switching states.

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the preset tables of the individual menus and
the information accompanying the remote commands.

e "RF frequency" =1 GHz

e "RF level" RF output switched off

e "Level" = 30 dBm for instruments including an attenuator

"Level" = -5 dBm for instruments with no attenuator

"Offsets" = 0

"Modulations State" = Off

Uninterrupted level settings are switched off

"Level Attenuator Mode" = AUTO

Internal level control "Level ALC" = AUTO

User correction "Level Ucor" = OFF

"LF output State" = Off

"Sweep State" = Off

Settings that are not affected by the PRESET key

Reference frequency settings ("Ref Oscillator" menu)

Power on settings ("Level/EMF" menu)

Network settings ("Setup" menu)

GPIB address ("Setup" menu)

*IDN? Identification and emulation ("Setup™ menu)

Password and settings protected by passwords ("Setup" menu)
Start/Stop Gui Update ("Setup" menu)

Display and keyboard settings ("Setup" menu)

Remote command:
*RST on page 246
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5.2.3 General Configuration of Instrument - Setup Key

oSt The SETUP key opens the "Setup" dialog.
- System
Reference Oscillator... 1ne "Setup" dialog is divided into several sections.

Internal Adjustments.. ¢  The "System" section is used to set general instrument parameters.
Hardware Config...

Software/Options... e The "Test" section is used to perform function tests.

e The "Environment" section is used to configure the controller interfaces.

e The "Remote" section is used to configure the remote control interfaces.

e The "Protection" is used to set the protection level for service functions and security
settings.

e The "Settings" section is used to save or recall instrument settings or to preset the
instrument to factory settings.

Most submenus of this key can be accessed only via the SETUP key or the menu tree

( MENU key), with the following exceptions:

e The "Reference Oscillator" dialog can also be called up in the "RF" block and is
therefore described in the section on this block (see chapter 5.3.4, "Reference Oscil-
lator", on page 119).

e The "Save/Recall" dialog can also be called up with the FILE key and is therefore

described in the section on this key (see chapter 5.2.8, "Storing and Loading Instru-
ment Data - File Key", on page 107.

5.2.3.1 Internal Adjustments

The R&S Signal Generator is extremely accurate thanks to the integrated procedures for
adjustments.

All internal adjustments for which no external measuring equipment is needed can be
started in the "Internal Adjustments..." dialog. The adjustments with external measuring
equipment are described in the Service Manual (on CD ROM, supplied with the instru-
ment).

Adjustment is recommended if the temperature range in which the instrument is operated
changes, or prior to all applications which require maximum level and frequency accu-
racy.

During adjustment a bar indicates the status of progress. If an error occurs, adjustment
is terminated and an error message is output in the info line.

Risk of invalid adjustment

In order to achieve correct adjustment of the instrument, make sure that the instrument
is warm before performing adjustments. The warm-up time is 30 minutes.
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Risk of damage to the DUT
High power at the RF output may destroy a connected DUT (Device Under Test).

During level adjustments instruments without step attenuator, i.e. with frequency options
R&S SMB-BxxxL, temporarily apply high power at the RF output. This may damage the
DUT. Therefore, it is required that the RF connector is terminated during adjustment.

Disconnect the DUT and replace it by a 50 Ohm terminating resistor.

To access the "Internal Adjustments” dialog, press the SETUP or MENU key under
"System".

The adjustments offered also depend on the installed options.

Adjust All

Starts all internal adjustments for which no external measuring equipment is needed. The
adjustments with external measuring equipment are described in the Service Manual
(supplied).

Adjustment may take some time. Especially in instruments with frequencies above 6 GHz,
it may last up to 15 minutes.

Remote command:
:CALibration<hw>:ALL[:MEASure] ? on page 250

Adjust Synthesis
Performs all adjustments which affect the frequency.

Remote command:
:CALibration<hw>:FREQuency[:MEASure]? on page 250

Adjust Level
Performs all adjustments which affect the level. The acquired correction values improve
the settling time and the signal quality.

Remote command:
:CALibration<hw>:LEVel [ :MEASure] ? on page 251

Adjustment Data
Selects the data used for external level correction.
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By default the instrument uses correction data obtained in the factory before delivery. In
addition, customer data can be used for external level correction. The customer data is
obtained using a R&S NRP power sensor. External level correction is a protected function
(see Service Manual, chapter 2, "Adjustment”).

Remote command:
:CALibration<hw>:LEVel :EXTern:DATA on page 251

Adjust Stereo Coder
Performs all adjustments which affect the analog channels of the stereo coder. For the
adjustment of the S/P DIF see Service Manual, chapter 2, "Adjustment".

Remote command:
[:SOURce] :CALibration:STEReo:ANALog [ :MEAS] ? on page 252

Hardware Config
In the "Hardware Config" dialog, the installed assemblies together with their variants and
revision states can be displayed for servicing purposes.

To open the "Hardware Config" dialog, select "System" and press the SETUP or
MENU key.

Counter
(Operation Time /h 5]

Power On Count ]

Common Assembly

Assembly Fart Mumber | Revision
SMB100A 1406.6000K02 ——
Basis Board |[1406.6600.00 [00.00
COM-FPGA 00.00.00
RF Assembly
Assembly Fart Mumber | Revision
RF Board 1406.7220.06 |01.01
MOD-FPGA 20.20.00
Baseband Assembly
Assembly Fart Mumber | Revision
Stereo Coder [1407.3240.00 [00.00

i

Section "Counter” in the upper part of the menu shows the "Operation Time" (in hours)
and the number of power-on ("Power On Counter").

The second part of the menu is a table that lists the installed assemblies. It is divided into
the sections:

e "Common Assembly"

e "RF Assembly"

e "Baseband Assembly"

Operation Time / h
Displays the operation time in hours.

Remote command:
:DIAGnostic:INFO:0TIMe? on page 253
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Power On Count
Displays the number of power-on.

Remote command:
:DIAGnostic:INFO:POCount? on page 253

Assembly
The tables list the installed assemblies.

"Assembly" Assembly name
"Part Number" Part Number of assembly
"Revision" Revision state of assembly

Remote command:
:DIAGnostic<hw>:BGINfo? on page 252

5.2.3.3 Software / Options

The "Software/Options" dialog shows the firmware version of the instrument software as
well as all installed hardware and software options.

Software options purchased at a later stage can be activated with a keycode. The acti-
vation code is supplied with the software option. How to install options is described in
Chapter 4 of the Service Manual (supplied with the instrument).

The installation of hardware options purchased at a later stage is also described in Chap-
ter 4 of the Service Manual (supplied with the instrument). Most hardware options need
to be installed at an authorized Rohde&Schwarz service shop.

To access the "Software/Options" dialog, select "System" and press the SETUP or
MENU key.

The menu is devided into the following sections:

e "Firmware"

e "Hardware Options"

e "Software Options"
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Firmware
The Firmware section of the menu shows the firmware version and the version of the
software platform.

Note: Your instrument is delivered with the latest firmware version available. Firmware
updates as well as the Release Notes describing the improvements and modifications
are provided on the Internet at the download site of the Rohde & Schwarz Signal gener-
ator home page. This home page always offers the latest information on your signal gen-
erator, e.g. also on changes of the firmware update procedure.

Remote command:
n.a.

Hardware Options / Software Options
The tables in the sections "Hardware" and "Software" list the installed hardware and
software options.

"Option" Short name of option
"Designation”  Name of Option

Remote command:
*OPT? on page 245
*TDN? on page 245

Loaded Modules
Section "Loaded Modules" is provided for service purposes. It lists all loaded software
modules with their versions and offers a short description of each module.

Remote command:
n.a.

5.2.3.4 Manage License Keys

This dialog is the central dialog for managing licenses, like enabling newly purchased
and/or newly registered options or performing the required instrument related steps dur-
ing the process of unregistration of licenses.

icix

|Device ID 1405.5000K02-000000-ED)|

Enter License Key
Enter License Key

Import License Key From File... |

Export Deaclivation Response To File... |

An option is ready to operate after it is enabled by means of a license key code supplied
with the option. The license key is delivered as a file or on paper. Unregistered licenses
must be registered for a particular instrument prior to the corresponding option can be
enabled for operation.
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License Registration

If your purchased license is delivered unregistered, you must register it before you can
activate the option.

For detailed information about the license registration, refer to the installation instructions
provided with the option (Supplement A) and the documentation of the online tool "Man-
age Licenses" (https://extranet.rohde-schwarz.com/service).

Only if the R&S Signal Generator is equipped with an older firmware version, a firmware
update prior to enabling the software option may be required. The information on the valid
firmware versions for the purchased software option is provided together with the option.

The firmware update is described in the service manual, chapter 4 (on CD ROM, supplied
with the instrument).

5.2.3.5

Device ID
Displays the instrument specific identification number. The device ID is an unique string
with the following structure:

<stock number>-<serial number>-<checksum>

Enter License Key
Type here the license key provided with the option.

For license keys delivered as a file, use Import License Key from File....

Import License Key from File...
Opens a dialog for selecting the file with the license key.

Export Deactivation Response to File...
Exports the generated deactivation response key to a file and opens a file management
dialog to save the file. This key is required during the unregistration process.

Status Information
Displays status information.

Gui Update
The "Start/Stop Gui Update" dialog provides the possibility to switch off update of the
displayed parameters in order to increase speed for certain settings.

The indicated values are not updated and may therefore differ from the intern, used val-
ues.

Start / Stop Gui Update

Gui Update is

Please, be aware:
If "Gui Update is OFF", the values of displayed parameters could differ from their internal, used values.
This mode is mainly provided to support unjittered signal output, fe. in fast sweep or list mode.

Changes in remote state changes the value of "Gui Update is" to ON.

|
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On/Off GUI Update
Switchs on/off update of the displayed parameters.

Switching off the update of the displayed parameters increases the speed for certain
settings.

Note: It is especially recommended to switch off the GUI update for optimum sweep
performance with short dwell times and for fast settling times.

Remote command:

:SYSTem:DISPlay:UPDate on page 402

5.2.3.6 NRP-Z Info/Update

The "NRP-Z Info/Update..." dialog covers information on connected power sensors, like
serial number, revision state and features of the particular sensor. You can directly per-
form an update of the sensor firmware.

» To access this dialog, select "Setup > System > NRP-Z Info/Update...".

The "NRP-Z Info / Update" dialog indicates the connected R&S NRP-Z Power Sen-
sors with specific information and contains the functions to update the firmware of a
connected sensor.

The remote commands required to remotely configure the poewr sensor settings are
described in chapter 7.11, "SENSe, READ and INITiate Subsystems", on page 278.

Current Sensors
Shows the sensors that are connected to the generator with information on serial number,
the revision state and some features.

Tip: Click on a sensor to get quick information about the firmware version and whether
this sensor measures the peak of the signal.

Remote command:

SENSe<ch>[:POWer] : TYPE? on page 286

SENSe<ch>[:POWer] : SVERsion? on page 286

SENSe<ch>[:POWer] : SNUMber? on page 285

Update

Section "Update" provides access to the file system in order to select a file for an R&S
NRP sensor update (Button "Select NRP File"), the selected file is indicated to the left of
the button. On the left side, the sensor to be updated is selected.

Button "Run Update" starts the update.
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Proceed as follows:

e Open the R&S website http://www.rohde-schwarz.com in section "Power Meters &
Voltmeters > R&S NRP-Z Sensors".

Select the respective sensor, e.g. R&S NRP-Z81.

Select "Downloads > Firmware" and the offered firmware suitable for your sensor.
Save the firmware in the /var/user/ directory.

Connect the sensor to the R&S SMB and select "Setup > System > NRP-Z Info
Update" to open the dialog.

e Select the sensor in the left sensor selection field.

e Select the update file with "Select NRP File" and activate "Run Update".

The update starts and a bar indicates the progress.

Note: If the update is interrupted for example by accidental removal of the sensor during
the process, the button "Rescue" appears. Thus, you can restart the update process.
Prerequisite is that no other sensor is connected to the instrument.

The procedure is as follows:

e Do not reconnect the sensor but keep it ready to be connected
Select "Rescue” in the left sensor selection field

Activate "Run Update"

Confirm query in message box

Connect sensor within 4 seconds

The update starts, a bar informs about the progress.

Remote command:
n.a.

5.2.3.7 SMZ Info Update

The "SMZ Info/Update" dialog covers information on a connected frequency multiplier,
like type, serial number revision state, frequency range and firmware version. You can
directly perform an update of the multiplier firmware.

To access the "SMZ Info/Update" dialog, perform one of the following
..... Reference Dciltor e On the front panel, press the SETUP key and select "SMZ > SMZ Info Update".
----- Internal Adjustments
o J e In the block diagram, select "RF Block > Configure > SMZ Info Update"
----- Manage License Keys
- Statsiop 5&;32{1@‘8 SMZ Infa / Update — ‘ L]
_____ i nfailipiats [ Available Multipliers
H Ll IMuh\pherType Serial Number| Revision |Min Freq Max Freq FW-Version BL-Version
IWVSMZNU 101643 01.00 75GHz  110GHz FW_ 18 BL 186
SMZ Input Cable Compensation Standard -
Cable Loss (10GHz) [10eE =
Update
1-SMZ110 | Run Update |
Mone Select SMZ File |
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e Where you can find the description...
Since this section is relevant when an R&S SMZxxx frequency multiplier is connected,
you can find a detailed description in the user manual of the frequency multiplier. It
is included in the online help of the R&S SMB, but can also be found in pdf format on
the CD, or on the R&S website http://www.rohde-schwarz.com/product/SMZ.html.

5.2.3.8

Selftest

A selftest is provided for service purposes. The selftest is a protected test procedure,
which can be accessed if protection level 1 is disabled. The protection dialog is called in
the "Setup” menu (see chapter 5.2.3.14, "Protection”, on page 96).

The following tests are only available via remote control:
® :TEST<hw>:DIRect on page 405

5.2.3.9

Selftest
Performs a selftest on all installed hardware options.

A list of the performed tests cases and the result of each of them (passed or failed) is
displayed.

Remote command:

:TEST<hw>:ALL:STARt on page 404

:TEST<hw>:ALL:RESult? on page 405

Check Front Panel

The "Check Front Panel" dialog is used to check whether the front panel keys are func-
tioning correctly. The menu displays all the front panel keys arranged in the same way
as on the front panel. The respective function is executed by pressing the associated key.
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5.2.3.10 Date and Time

The "Date/Time..." dialog provides access to the system time and date settings. Itis
opened using the SETUP or MENU key under "Environment". The time is used on the
internal controller.

Date / Time

|

Date [DD.MM.YYYY] 1205201

Time [hh:mm:ss] I 16:23:43

To prevent accidental changes, "Date" and "Time" are protected functions. They can be
accessed with protection level 1, see chapter 5.2.3.14, "Protection”, on page 96.

5.2.3.11

Date
Indicates the date in the format day.month.year.

In order to prevent accidental changes, this parameter is protected. It can be accessed
with protection level 1, chapter 5.2.3.14, "Protection"”, on page 96.

Remote command:
:SYSTem:DATE on page 403

Time

Indicates the time in the format hour.minute.second

In order to prevent accidental changes, this parameter is protected. It can be accessed
with protection level 1, see chapter 5.2.3.14, "Protection", on page 96.

Remote command:
:SYSTem: TIME on page 403

Network Settings

The "Network Settings" dialog provides access to the network settings. To access this
dialog, press the SETUP or MENU key under "Environment". The R&S SMB is equipped
with a network interface and can be connected to an Ethernet LAN (local area network).

How to connect the signal generator to the network is described in chapter 2.6.1, "Con-
necting the Instrument to the Network", on page 34.

Risk of network errors!
Connection errors can affect the entire network.

If your network does not support DHCP, or if you choose to disable dynamic TCP/IP
configuration, you must assign valid address information before connecting the instru-
ment to the LAN.

Contact your network administrator to obtain a valid IP address.
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The dialog provides an access to the network settings, like settings about the general
network environment and specific identification of the computer in the network, as well
as an indication whether the instrument is connected to the network or not.

Network Status
Indicates whether the instrument is connected to the network or not.

Remote command:
n.a.

Hostname
Enters the individual computer name of the R&S Signal Generator.

Note: The computer name can only be changed after protection level 1 is deactivated
(see chapter 5.2.3.14, "Protection", on page 96).
A predefined name is indicated and can be used for network connections.

Remote command:
:SYSTem:COMMunicate :NETWork [ : COMMon] : HOSTname on page 397

Workgroup
Enters the individual windows workgroup name of the R&S Signal Generator. This
parameter is necessary in case the instrument is integrated in a windows network.

Note: The workgroup can only be changed after protection level 1 is deactivated (see
chapter 5.2.3.14, "Protection”, on page 96).

Remote command:
:SYSTem:COMMunicate:NETWork[:COMMon] : WORKgroup on page 397

Address Mode
Selects if the IP address is assigned automatically or manually.

"Auto (DHCP)" The IP address is assigned automatically.
The network used must support automatic assignment of IP address
via DHCP or APIPA (Zeroconf) in order to use this function.

"Static" The IP address is assigned manually.

Remote command:
:SYSTem:COMMunicate :NETWork: IPADdress : MODE on page 398
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IP Address
Displays the IP address. To enter the IP address manually, select "Static" Address Mode.

Remote command:
:SYSTem:COMMunicate :NETWork: IPADdress on page 398

Subnet Mask
Displays the Subnet mask. To enter the Subnet mask manually, select "Static" Address
Mode.

This number is used together with the IP address to identify the network segment the
instrument is in.

Remote command:
:SYSTem:COMMunicate :NETWork[: IPADdress] : SUBNet : MASK on page 399

Default Gateway
Displays the IP address of the default gateway. To enter the default gateway manually,
select "Static" Address Mode.

This address identifies the router on the same network as the instrument that is used to
forward traffic to destinations beyond the local network.

Remote command:
:SYSTem:COMMunicate:NETWork [: IPADdress] : GATeway on page 398

Restart Network
Shuts down the network connection of the instrument and subsequently re-establishes
the connection.

This function can be used to resolve network problems.

Note: Only the connection of the instrument to the network restarts, the network itself is
not affected.

Remote command:
n.a.

Display/Keyboard Settings

In the "Display/Keyboard Settings" menu the power-save mode and external keyboard
settings are made. It is opened using the SETUP or MENU key under "Environment".

Screen Saver Active
Activates/deactivates the screen-save mode of the display.
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If activated, the display including backlight is completely switched off after the elapse of
the "Wait Time" when no entries via front panel, external mouse or external keyboard are
made.

This mode is recommended for preserving the display especially if the instrument is
exclusively operated via remote control.

Remote command:
:DISPlay:PSAVe[:STATe] on page 256

Wait Time

Enters the idle time that must elapse before the display lamp is shut off when no entries
are made.

Remote command:

:DISPlay:PSAVe:HOLDof f on page 256

Toggle Summary Screen
Activates/deactivates the magnified frequency and level indication. If activated, the fre-
quency and level indication covers the complete display.

Remote command:
n.a.

Layout (Keyboard)
Selects the keyboard layout for the selected keyboard language.

The assignment of some keys depends on the selected layout and language.

Remote command:
:KBOard:LAYout on page 266
:KBOard:LANGuage on page 265

Remote Channel Settings
The "Remote Channel Settings" dialog provides access to the settings for remote control.
The dialog is opened using the SETUP or MENU key under "Remote”.

Besides the standard GPIB-setting, the selection of one of the possible emulations and
a user defined definition of the * IDN and *OPT string is possible.
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|Language ISCF‘I jl

*IDN?FOPT? Identification
Maode IAutomatiu: ‘I
IDN String

Rohde&Schwarz, SMB1004,1406.6000k02/000000,2.
7.7.0-02.15.111 beta (Debug)

QPT String
SMB-BS, SMB-B106, SMB-K22, SMB-K23

GFIB channel address

RS232 using USE adapter
Baud rate 115200 =

P arity MNone =

1)

Stop bits

Visa Resource Strings
HISLIP |TCPIP::10.113.10.39:: hislip0:INSTR

WV ITCF'IF'::1 0.113.10.392INSTR

GFIB IGPIEI::ZB::INSTR

usB IUSEI::UKUMD::UXUUStI::UUUUUU::INSTR

SERIALIASRL‘] ZMNSTR

Lacal

Language

Selects the instrument whose remote command set is emulated by the R&S SMB.

The R&S SMB can also be remote controlled via the command set of several other gen-
erators, e.g. of an HP generator. You find the available command sets for the generator
in the selection list. This feature allows to replace a generator by an R&S SMB in existing
test setups. Refer to the corresponding Application Note at the download area of the
product site on the Internet. The Application Note is also provided on the user documen-
tation CD-ROM (included in delivery).

The selected instrument also defines the identification string that is retrieved with query
*IDN?. If required, use the parameter "Mode" and "IDN String" to change this string.

As any other parameter, the remote control command set can also be changed remotely
by means of the SCPI command sYST : LANG. However, this remote control command is
enabled only in the instrument's specific SCPI command set, i.e. it is possible to change
the command set remotely from the original one (SYST: LANG SCPI) to the command
set to be emulated but not vice versa.

Note: While working in an emulation mode, the R&S SMB specific command set is dis-
abled, i.e. the SCPI command SYST : LANG will be discarded.

To return to the SCPI command set of the R&S SMB, use the appropriate command of
the selected command set. If for example a HP generator is emulated, the HP command
EX returns to the instrument-specific GPIB command set.

Remote command:
:SYSTem: LANGuage on page 401
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Identification Mode
Selects the way the instrument identification is performed.

"Automatic" The "IDN String" and the "OPT String" are set automatically for the
instrument select with the parameter "Language”.

"User Defined" Enables the selection of user definable "IDN String" and "OPT String"
for the instrument selected with the parameter "Language”.

Remote command:
:SYSTem: IDENtification on page 401

Set to default
Overwrites the user-defined *IDN and *OPT strings with default strings.

The default strings vary depending on the selected emulation mode (Language)

Remote command:
n.a.

IDN String
Indicates the identification string of the instrument when queried with the common com-
mand *IDN?.

In addition to the preset values, a user defined identification string can be entered, e.g.
to provide individual identification for each generator, like 'MY_R&S SMB' for instance.

Remote command:
*IDN?

OPT String
Indicates the option string of the instrument as queried with common command *0OPT?.

If a "User Defined" Identification Mode is selected, a user defined option string can be
created, additionally to the automatically created one.

Remote command:
*OPT?

GPIB channel address
Sets the GPIB address of the instrument.

Remote command:
:SYSTem:COMMunicate:GPIB[:SELF] : ADDRess on page 396

RS232 using USB adapter
Requires a USB serial adapter (recommended extra, see data sheet)

Sets the parameters of the serial interface.

Either a RS232 interface or a Bluetooth connection can be used for remote control via
the serial interface. The settings are effective for both interfaces (see also chap-

ter 5.2.3.15, "Security", on page 97).

Remote command:

:SYSTem:COMMunicate:SERial:BAUD on page 400
:SYSTem:COMMunicate:SERial:PARity on page 400
:SYSTem:COMMunicate:SERial:SBITs on page 400
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Visa Resource Strings
Indicates the visa resource strings, used for remote control of the instrument. A separate
string is provided for remote control via the different interfaces.

Remote command:
:SYSTem:COMMunicate:HISLip:RESource? on page 397
:SYSTem:COMMunicate:NETWork:RESource? on page 399
:SYSTem:COMMunicate:SOCKet :RESource? on page 400
:SYSTem:COMMunicate:GPIB:RESource? on page 396
:SYSTem:COMMunicate:USB:RESource? on page 399
:SYSTem:COMMunicate:SERial :RESource? on page 399

Local (Remote Channel Settings)
Switches the instrument to operate in local control mode.

Switching from remote to local control mode can be also done with one of the following
actions:

e manually with the LOCAL key on the front panel

e with the interface command &GTL via the remote-control interface

e with the key combination CTRL + Q.

Remote command:
&GTL

Protection

This "Protection” dialog provides access to the unlocking of different protection levels.
To open this dialog, use the SETUP or MENU key under "Protection".

After the instrument has been switched on, the protection levels 1 to 5 are automatically
activated. To deactivate the protection, the correct password has to be entered. With the
corresponding check boxes, you can activate the protection again.

Protection

Protection Level 1 W On IPasswordI I

Protection Level 2 W On Passwaord

Protection Level 3 W Cn Passwordl it
Protection Level 4 W Cn Passwaord I ———
Protection Level &5 W Cn  Password I -

The following functions are protected in the rerspective levels:

e Protection Level 1
protects against accidental changes to certain settings, such as clock and date, net-
work settings or instrument names,etc. This level is accessible to the user.

e Protection Level 2
provides access to the unlocking of protected service functions. It is accessible to
authorized personnel of R&S Service Departments only.

e Protection Level 3-5
are reserved for factory internal use.
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Protection Level/Password
Protection Level 1 can be activated to expand the functionality of the internal adjustment
and to access the selftests.

The password is 123456.

For access to service functions of protection level 2, see the service manual of your R&S
SMB.

Remote command:
:SYSTem: PROTect<ch>[:STATe] on page 402

Security

The "Security" dialog provides access to the passwords and mass storage security set-
tings. To open this menu, use the SETUP or MENU key under "Protection”.

The menu is divided into the password sections and the security settings section. In the
password section, the passwords for securing a controlled access to the instrument are
defined and changed.

A change of passwords for the operating system and security password requires the entry
of the old and new password and the conformation of the new password. All settings are
only accepted after the "Change Password" button is pressed.

-5l

Change User Passward
Walid for YNNG, FTP and SMB (Samba) access
Liser Mame |

Change Security Passward
Old Password

MNew Password

Confirm Password

I

Change Passwordl

Security Setting

LAM Services... |

LISB Storage W
Annotation Frequency W
Annotation Amplitude W
Display W
Keyboard W
Security Password l—
Accept |
Bluetooth
Blustooth Pin |_‘

User Name
Indicates the user name used for access to the Linux operating system and valid for VNC,
FTP and SAMBA access.
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The user name and password are required for remote access to the instrument via VNC,
FTP or SAMBA.

Remote command:
n.a.

Old Password (User Password)
Enters the currently used user password. The default password is "instrument".

Note: Itis highly recommended to change the default user password before connecting
the instrument to the network.

New Password (User Password)
Enters the new security password.

The security password may contain decimal characters only.

Remote command:
n.a.

Confirm Password (User Password)
Enters the new password for conformation.

The new password is only valid after the "Change Password" button is pressed.

Remote command:
n.a.

Change Password (User Password)
Changes the password accordingly.

Remote command:
n.a.

Old Password (Security Password)
Enters the currently used security password. The default password is '123456'.

Note: It is highly recommended to change the default security password before connect-
ing the instrument to the network.

The security password is required when changing the status of the USB and LAN inter-
face.

Remote command:
n.a.

New Password (Security Password)
Enters the new security password.

The security password may contain decimal characters only.

Remote command:
n.a.

Confirm Password (Security Password)
Enters the new password for conformation.
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The new password is only valid after the "Change Password" button is pressed.

Remote command:
n.a.

Change Password (Security Password)
Changes the password accordingly.

Remote command:
n.a.

LAN Services
Opens the "LAN Services" dialog for individually enabling or disabling the available LAN
interface services.

|Enab|e LA Interface ¥ on |
SCPI over LAN IEnabIe vl
WG IEnabIe vl
S5H IEnabIe vl
HTTP IEnabIe vl
FTFP IEnabIe vl
SMB {Samba) IEnabIe vl
Avahi (Zeraconf) IEnabIe vl
Security Password I

Accept |

Enable LAN Interface — LAN Services
Enables the LAN interface in general, and thus provides remote access via all unlocked
services.

The settings in this dialog require the entry of the Security Password, and are only
accepted after the Accept - Security button is pressed.

Enable LAN Services individually «— LAN Services
Enables or disables the following interface services individually.

"SCPI over LAN"
activates access over LAN to remotely control the instrument using
SCPI (Standard Commands for Programmable Instruments) com-
mands.

"VNC" activates access via VNC (Virtual Network Computing) interface, a
graphical desktop sharing system that uses RFB protocol to remotely
control the instrument.

"SSH" activates access via SSH (Secure Shell), a network protocol for secure
data communication.

"HTTP" activates access via HTTP (Hyper Text Transfer Protocol), the appli-
cation protocol for hypermedia information systems.

"FTP" activates access via FTP (File Transfer Protocol), used to transfer files
from a host to the instrument and vice versa.

Operating Manual 1407.0806.32 — 13 99



R&S®SMB100A Instrument Function

I EEEEEEEEEEEE—————————.
General Instrument Settings

"SMB (Samba)"
activates access to SMB (Server Message Block), used for providing
shared access to files, printers and serial ports of a network.

"Avahi (Zeroconf)"
activates Avahi, a service for automatic configuration of the instrument
in a network environment.

Remote command:
n.a.

USB Storage
Activates the access to external USB storage media.

This setting has no effect on a mouse or a keyboard, connected via USB.

The setting requires the entry of the security password and is only accepted after the
"Accept” button is pressed.

Remote command:
n.a.

Annotation Frequency
Enables/disables the display of the currently used frequency in the header of the instru-
ment.

The setting requires the entry of the security password and is only accepted after the
"Accept" button is pressed.

Remote command:
:DISPlay:ANNotation:FREQuency on page 254

Annotation Amplitude
Enables/disables the display of the currently selected level in the header of the instru-
ment.

The setting requires the entry of the security password and is only accepted after the
"Accept” button is pressed.

Remote command:
:DISPlay:ANNotation:AMPLitude on page 254

Display
Enables/disables the display.
If this parameter is disabled, the instrument cannot be operated manually via the user

interface, i.e. display, front panel keys and external keyboard are disabled. Remote con-
trol of the insrument is enabled.

The setting requires the entry of the security password and is only accepted after the
"Accept" button is pressed.

Remote command:
:SYSTem:DLOCk on page 395

Keyboard
Enables/disables an external keyboard and mouse connected to the instrument, the front
pannel keys of the instrument, the rotary knob and the on-screen keyboard.
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If this parameter is disabled, the instrument cannot be manually controlled but changes
in the settings are shown on the display. Remote access and remote control are enabled.

The setting requires the entry of the security password and is only accepted after the
"Accept" button is pressed.

To enable the keyboard, type the security password on the external keyboard or use the
SYST:KLOC OFF command over remote control.

Remote command:
:SYSTem:KLOCk on page 395

Security Password
Enters the password that is required to enable or to disable the settings protected by a
security password. Default is '123456'.

Note: It is highly recommended to change the default security password before connect-
ing the instrument to the network.

All settings are only accepted after the "Accept" button is pressed.

Remote command:
n.a.

Accept - Security
Accepts a new entry or selection and changes the settings accordingly.

Remote command:
n.a.

Bluetooth Pin
Requires a USB Bluetooth adapter (recommended extra, see data sheet).

Enters the Bluetooth pin of an external Bluetooth device. The pin is required to enable
remote control via an external Bluetooth device.

Remote command:
n.a.

Save/Recall
The "Save/Recall" submenu can also be called up with the FILE key and is therefore

described in the section of this key (see chapter 5.2.8, "Storing and Loading Instrument
Data - File Key", on page 107).

Factory Preset

The "Factory Preset" dialog provides a function to reset the instrument's settings to their
factory state. This function is activated by pressing the "Execute Factory Preset" button.
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Factory Preset
Reset the instrument's settings to their factory state.

Note: Since Factory Preset resets the Remote Channel and network settings to the
default values, executing Factory Preset via remote control terminates the connection to
the instrument, if these settings had been configured to values different to the default
ones!

The factory preset function resets nearly all instrument settings. In addition to the regular
preset by means of the PRESET key, a "Factory Preset" resets also the following values:
e Reference frequency settings ("Ref Oscillator" menu)

Power on settings ("Level/EMF" menu)

Network settings including hostname ("Setup" menu)

Remote Channel settings including GPIB address ("Setup" menu)

Start/Stop Gui Update ("Setup" menu)

Display and keyboard settings ("Setup” menu).

To maintain security, password settings and all settings protected by these passwords
like disabled USB and LAN connections are not changed.

Not affected by the "Factory Preset" are also user data, lists or instrument settings files,
created for example by means of the Save/Recall function.

Remote command:
:SYSTem: FPReset on page 249

Help

The "Help" dialog offers comprehensive online help for the R&S Signal Generator. A
desired topic can be selected via the table of contents (select "Manual") or the index
(select "Index").

For context-sensitive information about a marked parameter, press the HELP key. For a
description of the "Help" menu, refer to the section covering to the HELP key (see chap-
ter 5.2.7, "Help System - Help Key", on page 106).

Switching to Manual Control - Local Key

In remote control mode a status message appears in the display header. The rest of the
display remains unchanged and shows the current instrument status, i.e. the status which
exists under the remote control settings. The instrument can be operated (e.g. menus
can be opened). However, it is not possible to enter or change values.

The status message additionally indicates whether the LOCAL key is disabled or enabled.

If the "REMOTE" status message is shown, the LOCAL key switches the instrument from
remote control to manual control. The current command must be fully processed before
the mode is switched, otherwise the instrument switches immediately back to remote
control.

If the "REM-LLO" status message is displayed, the instrument can be switched from
remote control to manual control by means of remote control only (e.g. with the Visual
Basic command CALL IBLOC (generator$));the LOCAL key is disabled. The key is
disabled by remote control with the command LLO.
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When switching from remote to manual control, the display update suppression function,
if active ("SETUP > GUI Update" is Off), is automatically deactivated ("SETUP > GUI
Update" is On).

5.2.5 Generating a Hard Copy of the Display

The generation of a hardcopy of the display requires that an external keyboard is con-
nected to the instrument. The hardcopy dialog is called with the key combination CTRL
+Z or CTRL+Y depending on the used keyboard settings.

5.2.5.1 Hardcopy Dialog

Destination
Indicates that the hardcopy is stored in a file (see also "File Options" on page 104).

Remote command:
:HCOPy:DEVice on page 259

Options

Opens the Hardcopy Options dialog for configuring the hardcopy parameters (see "File
Options" on page 104.

Remote command:

n.a.

File
Some configuration parameters are already offered in the Hardcopy dialog. All configu-
ration parameters are available in "File Options" on page 104.

Automatic Naming
Activates, deactivates automatic generation of the file name. Automatic naming is con-
figured in the "Options..." submenu, see "File Options" on page 104.

Remote command:
:HCOPy:FILE[:NAME] : AUTO: STATe on page 264
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File Info

Indicates the file name. The file name can be entered either manually via the file manager
(button "File...") or generated automatically (Automatic naming checkbox). Automatic
naming is configured in the "Options..." submenu.

Remote command:
:HCOPy:FILE [ :NAME] on page 260
:HCOPy:FILE[:NAME] : AUTO:FILE? on page 261

Hardcopy Options

This section describes the "Hardcopy Options™ dialog.

Hard Copy Options ™ EJ
Image
Format| BMP =| Size[640°480 +|

Automatic Naming
Automatic Naming ¥ On

Path... | | fusb/sdat
Delete All Image Files In Path  Clear Path |

Prefix ¥ On lsgl
Year W On Month¥ On Day W On

Current Auto Number 0oo

Resulting File Mame Ism...bmp

File Options
Dialog for setting the file parameters.

"Size" Defines the size of the bitmap in terms of pixels. The first value of the
size setting defines the width, the second value the height of the image.

Remote command:
:HCOPy:IMAGe: STZE on page 265

"Format" Selects the image format. Several bitmap formats are available.

Remote command:
:HCOPy:DEVice:LANGuage on page 259

"Automatic Determines the rules to create the file names and sets the directory the
Naming" files are saved into.
As default the automatically generated file name is composed of:
<Path>/<Prefix><YYYY><MM><DD><Number>.<Format>
Each component can be deactivated/activated separately to individu-
ally design the file name. The resulting file name is indicated.
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"Path..." Opens the "Select Hard Copy Destination Path" dialog to select a path
for storing the hardcopy.

Note: For selecting the destination path a file name must be entered
as well. Otherwise the error message "The name of a list may not be
empty" is displayed and the selection will be canceled.

Directory, path and file name are displayed in the infoline right to the
"Path" button.

Remote command:
:HCOPy:FILE[:NAME] : AUTO:DIRectory on page 261
:HCOPy:FILE[ :NAME] : AUTO? on page 260

"Clear Path" Deletes all image files with extensions bmp, img, png, xpm and csv in
the directory set for automatic naming.
Before deleting the image files a warning message is displayed requir-
ing the confirmation.

Remote command:
:HCOPy:FILE[:NAME] : AUTO:DIRectory:CLEar on page 261

"Prefix" Activates the usage of the prefix in the automatic file name. The prefix
is entered in the field to the right of checkbox.

Remote command:
:HCOPy:FILE[:NAME] : AUTO[:FILE] : PREFix:STATe on page 263

"Enter prefix" Enters the prefix for the automatically generated file name. The use of
the prefix is activated in the checkbox to the left.

Remote command:
:HCOPy:FILE[:NAME] : AUTO[:FILE] : PREFix on page 263

"Date - Year/  Defines the components of the automatically generated file name. The
Month / Day" selectable parameters are year, month and day. If activated the current
year, month or day used in the file name.

Remote command:

:HCOPy:FILE[:NAME] : AUTO[:FILE] : YEAR: STATe on page 264
:HCOPy:FILE[:NAME] : AUTO[:FILE] : MONTh:STATe on page 262
:HCOPY:FILE[:NAME] : AUTO[:FILE] : DAY : STATe on page 262

"Current Auto  Indicates the number which is used in the automatically generated file
Number" name.

Note: On initially switching on the device the number will be reset to
the lowest possible value. Starting with number 0 the output directory
will be scanned for already existing files. As long as files with the same
name are existing the number will be increased by 1. The number will
be automatically set to a number so that the resulting file name will be
unique within the selected path. The current number will not be saved
in the save recall file but will be temporarily stored within the database.
On subsequent saves the number will be increased.

Remote command:
:HCOPy:FILE[:NAME] : AUTO[:FILE] : NUMBer? on page 263

|
Operating Manual 1407.0806.32 — 13 105



R&S®SMB100A

Instrument Function

5.2.6

5.2.7

General Instrument Settings

"Resulting File Indicates the automatically generated file name.
Name"

Remote command:
:HCOPy:FILE[:NAME] : AUTO:FILE? on page 261

Save
Triggers the generation of a hardcopy.

Remote command:
:HCOPy [ :EXECute] on page 259

Messages - Info Key

The INFO key opens a window containing a detailed description of every message dis-
played in the info bar, see chapter 4.2.3, "Info Window", on page 58 and chapter 9, "Error
Messages", on page 437.

Help System - Help Key

The HELP key opens a browser window containing a context-sensitive description of the
highlighted parameter.

elp - State L]
Contents Index Back =
Instrument Function > Modulations =

Amplitude Modulation (AM) > Amplitude

Modulation Menu > State

State

Activates/deactivates AM modulation.

SCPI command:

[:S0URce<hw>]:AM:S8TATe LI

The context-sensitive page which is opened with the HELP key is part of a comprehensive
help system. It is possible to move from this context-sensitive page to any page of the
help system. The following navigation aids are available:

e Internal links in the text
They open pages which are directly linked to the described function. In this way it is
possible, for example, to call up the description of the GPIB command for any par-
ticular function.

e Previous/Next links
The Previous/Next links allow scroll through the help pages. The sequence of the
described functions corresponds to their position in the menus.

e Back button
The Back button calls up the page last viewed.

e Contents in the navigation panel
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The contents list is used to open the individual help pages. It has a hierarchical struc-
ture. The highlighted line indicates where the currently displayed page is within the
contents list.

e |ndex in the navigation panel
The index is used to call up all pages which contain the selected entry. The index has
an alphabetical structure and also contains all GPIB commands.

e Find
The find function allows you to look for freely selectable terms in all help pages. A list
of the pages containing the entered term is displayed as the search result. The search
can be limited to words in the page title to increase the number of hits.

5.2.8 Storing and Loading Instrument Data - File Key

The R&S SMB allows complete instrument settings to be stored in files either on the
internal flash memory or on external USB memory devices.

Defined and complex instrument settings can then be reproduced at any time by loading
this data. If required, these settings can be loaded to various signal generators.

The corresponding menu is available under "Save/Recall" in the "Setup" menu. The
instrument settings are saved in files which can be stored in data directories.

Additionally there are intermediate memories in which the current instrument setting can
be stored and then called up again by just pressing a key. This provides fast switching
between different instrument settings.

Only settings which differ from the preset values and configuration data for the operating
elements (e.g. window positions) are stored. As a result the files remain relatively small.
Furthermore, instrument settings can easily be transferred between different equipped
signal generators since the files contain only relevant information. When loaded, the ref-
erenced settings are implemented and all non-referenced parameters are set to the
associated preset values.

If list data is part of the instrument settings, e.g. a list of user correction data, a reference
to this list is stored, not the list itself. The list is reactivated when the associated settings
are loaded, but the list may have been modified or deleted in the meantime or may not

be available on a different instrument. If the list has been modified, the new entries will

be used. An error message appears if an attempt is made to access a non-existing list

or to activate settings which are not supported by the instrument.

e Network settings and remote settings are not saved and restored.

e |ists are stored and loaded in the appropriate menus. For example, the user correc-
tion data list is created and stored in the "User Correction" menu.

When loading an instrument setting, it is possible to select whether the current frequency
and level setting is to be retained or whether the stored settings are to be activated. It is
possible to delete stored instrument settings. A file can be copied by loading it with
"Recall" and then storing it under a new name.
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5.2.8.2

General Instrument Settings

Settings can be transferred easily between instruments with different equipment options
and/or firmware versions because only the settings which differ from the preset values
are affected. When settings are loaded, only those which are possible on the instrument
are implemented. Error messages indicate the settings which cannot be implemented.

The stored file is transferred from one instrument to another using the memory stick.

General file management functions such as copying and moving data are available in the
"File Manager" dialog.

File Menu

The settings available in the File menu "Save/Recall" depend on the operation selected
under "Select Operation".

Select Operation Save T

For more information, see chapter 4.7.1, "File Select Dialog", on page 72.

Select Operation
Selects the file function.

"Save..." Calls the menu for storing the current instrument setting (see chap-
ter 5.2.8.2, "Storing Instrument Settings", on page 108).

"Recall..." Calls the menu for calling up a stored instrument setting (see chap-
ter 5.2.8.3, "Loading Instrument Settings", on page 109).

Storing Instrument Settings

If "Save" is selected under "Select Operation”, the File menu provides options for storing
the current instrument setting in a file.

Recent files
Displays the files last used.

Remote command:
n.a.
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Directory
Selects the directory in which the file is to be stored.

The window opposite lists all settings files in this directory.
A new directory can be created in the "File Manager" dialog.

Remote command:
:MMEMory:CDIRectory on page 270

File List
Displays the files which are in the selected directory.

If a file is highlighted, it is overwritten when the file is stored.

Remote command:
:MMEMory:CATalog? on page 269

File Name
Enter the file name of the file without file extension. This file is then created.

Remote command:
n.a.

Save
Stores the current instrument settings under the specified path.

Remote command:
*SAV on page 246
:MMEMory: STORe: STATe on page 274

Save Immediate x
Stores the current instrument setting in one of the three intermediate memories.

These instrument settings are retained until a different instrument setting is stored in the
intermediate memory. When the instrument is switched off, the contents of the inter-
mediate memories are retained.

Remote command:
*SAV on page 246

File Manager
Calls the "File Management" menu.

Directories can be created and files managed in this menu (see chapter 5.2.8.4, "File
Manager", on page 111).

Remote command:
n.a.

Loading Instrument Settings

If "Recall" is selected under "Select Operation”, the "File" menu provides options for
loading complete instrument settings. Here it is possible to select whether the current or
stored frequency and level settings are to be used.

|
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Recent data sets
Displays the files last used. The entire path is shown.

If the desired file is in the list, it can be selected.

Remote command:
n.a.

Directory
Enter the directory in which the file with the instrument setting to be loaded is located.

The "Selected file" window lists all the files in this directory.

Remote command:
:MMEMory:CDIRectory on page 270

File List
Selects the file with the desired instrument configuration.

Remote command:
:MMEMory:CATalog? on page 269

Exclude Frequency
The current frequency is retained when a stored instrument setting is loaded.

Remote command:
[ : SOURce<hw>] : FREQuency [ :CW|FIXed] : RCL on page 304

Exclude Level
The current level is retained when a stored instrument setting is loaded.

Remote command:
[ : SOURce<hw>] : POWer [:LEVel] [: IMMediate] :RCL on page 342

Recall
Load the selected configuration.

If an instrument setting in which a sweep was activated is stored, the sweep is started
when the recall command is called.

If an instrument setting which accesses lists is stored, this list is also loaded.
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If the list has been deleted in the meantime, an error message appears when the instru-
ment setting is loaded. If the list has been overwritten in the meantime, the new entries
will be used.

Remote command:

:MMEMory: LOAD: STATe on page 273

*RCL on page 246

Recall Immediate x
Loads the selected configuration from one of the three intermediate memories.

If an instrument setting in which a sweep was activated is stored, the sweep is started
when the recall command is called.

If an instrument setting which accesses lists is stored, this list is also loaded.

If the list has been deleted in the meantime, an error message appears when the instru-
ment setting is loaded. If the list has been overwritten in the meantime, the new entries
will be used.

A message appears if no instrument configuration is stored in this memory.

Remote command:
*RCL on page 246

File Manager

The "File Management" dialog provides all the functions required for file management.
Directories can be created, and files copied, deleted and moved between the directories
on the devices (internal flash memory and memory stick).

For more information, see chapter 4.7.2, "File Manager", on page 73.

File Type
Selects the file types to be indicated. If a file type with a specific file extension is selected
only files with this extension are indicated in the selected directory.

Remote command:
n.a.
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Directory and File Name

Selects the directory in which the file to be deleted or copied is located. The window lists
all files in this directory. The file to be deleted or copied can be highlighted. The path is
indicated above the directory window.

Remote command:
:MMEMory:CDIRectory on page 270

Cut
Cuts the selected file. It can be pasted into a different directory using the "Paste" button.

Remote command:
:MMEMory:DELete on page 272

Copy

Copies the selected file. It can be pasted into a different or the same directory using the
"Paste" button. When pasting the file into the same directory file name

Copy of <file name> is given automatically. When pasting the file into a different
directory, the original file name is kept.

Remote command:
:MMEMory : COPY on page 270

Paste
Pastes the file that has been copied or cut before.

Remote command:
n.a.

Rename
Renames the selected file or directory. The new name can be entered in the "New File-
name" dialog.

Remote command:
:MMEMory : MOVE on page 273

Delete
Deletes the selected file. Before the file is deleted, a message appears prompting the
user to confirm deletion of the file.

Remote command:
:MMEMory:DELete on page 272

Create New Directory
Creates a new directory. The name of the new directory can be entered in the "New
Directory" dialog.

Note: When the subdirectory is entered, it is possible to enter an absolute path name
(e.g. /var/user/USER/MEAS) or the path relative to the current directory (e.g. ../
MEAS).

The directory is created as a subdirectory in the selected level.

Remote command:
:MMEMory:MDIRectory on page 273
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5.2.8.5 Using the FTP or SAMBA/SMB File Sharing and Accessing the File System

Provided that the R&S SMB is connected to a LAN and the required configurations are
completed, you can use the FTP (file transfer protocol) to access the file system and to
transfer files from and to the instrument.

For information on how to set up a LAN connection, refer to R&S SMB Quick Start Guide
manual, chapter "Setting Up a Network (LAN) Connection".

This section provides an introduction to this topic. For comprehensive information, refer
to the Application Note 1GP72 "Connectivity of Rohde&Schwarz Signal Generators ".
To access the file system of the R&S SMB via ftp
We assume that the instrument and the remote PC are connected to a LAN.
1. Select "Setup > Environment > Network Settings".
The "Network Settings" dialog opens.
2. Write down the "IP Address" of the instrument, e.g. 10.113.10.105
3. On the remote PC, start the Windows Explorer.

4. Inthe address field, enter ftp://<"IP Address" of the Instrument>,e.g.
ftp://10.113.10.105
A log on dialog opens and requests a password.

Tip: Default password. The FTP and SAMBA/SMB file access use the user instru-
ment with default password instrument.

It is highly recommended that you change the user password in the "Security" dialog
before connecting the instrument to the network!

See chapter 5.2.3.15, "Security", on page 97.

5. Enter the password to access the /var/user/share directory.

You can access thefiles in the /var/user/ directory, perform standard function like
creating directory, etc.

6. Openthe /var/user/share directory and create a new directory, e.qg.
test ftp.

7. On the instrument, press the FILE key and open the /var/user/share directory.

Operating Manual 1407.0806.32 — 13 113



R&S®SMB100A

Instrument Function

5.3

5.3.1

5.3.1.1

RF Block

The dialog displays the /var/user/share testftp file.

RF Block

Overview of RF Signal

Settings for the RF output signal and analog modulation are made under "RF Signal".
These settings can be accessed in the block diagram by way of the "RF" function block,
or by means of the menu with the same name which is opened using the MENU key.

The function block is available for the basic unit (R&S SMB + frequency option R&S SMB-
B10x) without additional equipment options.

RF Output

To activate and deactivate the RF output signal, use one of the following alternatives:
e by means of the RF ON/OFF key (the current entry focus is irrelevant)
® by changing the state of the "RF" functional block (see "State RF" on page 115)

® by enabling/disabling the RF in the "Configure" menu of the "RF" block (see "RF
Output State" on page 115).

The current state of the RF output (activated and deactivated) is indicated in the block
diagram by means of the different block color and the status of the "On" checkbox.

An active sweep is also indicated in the block.

|
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RF
config... | RF RF
I_ On @_) e

To query the impedance of the RF outputs, use the command : OUTPut<hw>:
IMPedance? on page 277.

State RF
Activated/deactivates the RF output by changing the state of the "RF" functional block.

Alternatively, the RF ON/OFF key can be used.

Remote command:
:OUTPut<hw>[:STATe] on page 278

RF Output State
Activated/deactivates the RF output by enabling/disabling the RF in the "Configure" dia-
log of the "RF" block.

Frequency...

Remote command:
:OUTPut<hw>[:STATe] on page 278

5.3.1.2 REF Signal Modes and Characteristics

e CW

The RF signal is generated with the set frequency and level. This is the default mode.
e Sweep

The RF signal is generated as a sweep with the set parameters.

It is not possible to activate frequency, level and LF sweep simultaneously.

e List Mode
The RF signal is generated on the basis of a list of predefined frequency and level
values. The duration of the individual steps can be predefined.

Instruments connected downstream can be taken into consideration when setting the
frequency and level by entering a frequency and/or level offset.

Automatic level control ("ALC") ensures maximum level accuracy.

User-specific lists which contain level correction values for any frequency range ("User
Correction") can be created to, for example, compensate the cable attenuation in a test
assembly setup.

The R&S Signal Generator generates the RF signal in unmodulated or analog form. The
signal generator is equipped therefore with the following sources for analog modulations:

e aninternal LF generator
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5.3.21

RF Block

e an internal pulse generator
e the external modulation inputs MOD EXT and PULSE EXT.

An external trigger signal for the the sweeps and the LIST mode can be provided at the
INST TRIG input.

The input REF IN is used to input an external instrument reference, and the output REF
OUT serves as the output of the reference frequency (internal or external).

RF Frequency

The value of the RF frequency is displayed in the header of the instrument's display
("Freq"). This field provides the direct input of the RF frequency. Alternatively, you can
enter the RF frequency in the "Frequency/Phase" dialog.

bregmPON [ WoooW ]

100.000 000 000 [z

Be aware that the displayed RF frequency in the header, and the RF output frequency,
entered in the "Frequency/Phase" dialog can be different, as explained in the following
section.

RF Frequency vs. RF Output Frequency

The signal generator offers the possibility, to take additional frequency modifications of
a downstream instrument into consideration, such as an offset set by a mixer, or a multiple
of the frequency by a frequency multiplier. The R&S SMB indicates the resulting fre-
quency, including offset and multiplication factor in the header of the screen. l.e. the
indicated frequency corresponds to the frequency at the output of the downstream instru-
ment. However, the frequency at the RF output of your signal generator always corre-
sponds to the frequency set in the "Frequency/Phase" dialog.

In this dialog, you can also enter the values of the downstream instrument.
A set frequency offset is indicated by the "FREQ OFFSET" status message.

The correlation between the RF frequency, the RF output frequency and the frequency
offset is as follows:

"Freq" (in header) = "RF output frequency" (Frequency in dialog) * "Multiplier" factor
(Multiplier in dialog) + "Freq offset" (Offset in dialog)

|
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If you have the R&S SMB equipped with one of the options R&S SMB-B112, -B120, or -
B140, you can, in addition, operate an R&S SMZxx frequency multiplier. xx represents
the multiplier type that you can use according to the target frequency range.

5.3.2.2

5.3.2.3

w RF ON
Frequency/Phase.

Setting the RF Frequency

To change the RF frequency, press the FREQ key and enter the desired frequency.
Changes to the RF frequency have an immediate effect (without confirmation with the
ENTER key) on the output signal.

RF Freq
Enters the RF frequency, considering the frequency offset.

Note: The SCPI command sets the level of the "Freq" display, i.e. an entered frequency
offset and multiplier factor are taken into consideration in the frequency value.

Remote command:
[ :SOURce<hw>] : FREQuency [ :CW|FIXed] on page 304

RF Frequency Dialog

In the combined "Frequency/Phase" dialog, you can enter the frequency, the frequency
offset and multiplication factor of a downstream instrument, set the step width for the
frequency entry using the rotary knob, and set the phase for the RF output signal.

To open the "RF Frequency / Phase" dialog, select "RF" > "Configure" > "Frequency" or
use the MENU key under "RF".

The "RF Frequency / Phase" dialog is divided into the several sections.

Frequency and offset of the RF output signal are set in the "Frequency Settings" section
in the upper part of the dialog. In addition, the multiplier factor of an externally connected
multiplier is specified.

Frequency lmm

Offset 0ooojHz -
Multiplier 1.000

The step width which is used when setting the frequency using the rotary knob (with
"Variation Active On") is set in the "User Variation" section.

The phase of the output signal can be changed in the "Phase Settings" section. The
"Phase Settings" menu is described in chapter 5.3.3, "Phase", on page 119.

Frequency Settings

The frequency, offset and multiplier factor are set in the top section of the menu.
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Frequency - RF Signal

Sets the RF frequency of the RF output connector. The frequency entered and displayed
here corresponds to the frequency at the RF output, i.e. any offset entry is not taken into
consideration.

Note: The SCPI command SOUR: FREQ sets the frequency of the "FREQ" display, i.e.
the frequency containing offset.

Remote command:
n.a.

Offset - RF Signal
Sets the frequency offset relative to the RF frequency. The frequency offset of a down-
stream instrument (e.g. a mixer) is entered.

The entry does not change the value of the RF frequency at the RF output. It only changes
the RF frequency displayed in the display header. The value of the RF frequency in the
header corresponds to the frequency at the output of the downstream instrument.

Remote command:
[ :SOURce<hw>] : FREQuency: OFFSet on page 307

Multiplier - RF Signal
Sets the multiplication factor for the RF frequency.

In the frequency field of the status bar, the instrument adjusts its frequency display
according to the set multiplication factor. This frequency value shows the frequency at
the output of the downstream multiplier. The entry does not change the RF frequency at
the RF output of the R&S SMB.

Remote command:
[ : SOURce<hw>] : FREQuency:MULTiplier on page 306

User Variation

If the frequency is set using the rotary knob, the step width is defined in the "User Var-
iation" section.

Variation Active - RF Signal
Activates the user-defined step width used when varying the frequency value with the
rotary knob.

"ON" The frequency value set with the rotary knob is varied using the user-
defined step width which is entered under "Variation Step".

"OFF" The frequency value set with the rotary knob is varied in steps of one
unit at the cursor position (standard operating mode).

Remote command:
[ :SOURce<hw>] : FREQuency: STEP : MODE on page 309
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Variation Step - RF Signal

Sets the user-defined step width. This step width is used when entering the RF frequency
using the rotary knob. Frequency variation with this step width must also be activated
with "Variation Active".

Remote command:
[ : SOURce<hw>] : FREQuency:STEP [ : INCRement ] on page 309

5.3.3 Phase

The phase of the RF output signal can be changed in the "Phase Settings" section of the
"RF Frequency/Phase" dialog.

5.3.3.1 Phase Settings

To open the "RF Frequency/Phase" menu, select "RF" > "Configure" >"Frequency /
Phase" or use the MENU key under "RF".

Phase Settings——————
IDeIta Phase | 0.0 | deg jl

Reset Delta Phase Display |

Delta Phase - RF Signal

Sets the phase of the RF signal. The current phase of the signal is used as the reference.
This function allows, for example, the phase of the output signal to be synchronized with
the phase of a signal from a second signal generator.

Remote command:
[ : SOURce<hw>] : PHASe on page 334

Reset Delta Phase Display - RF Signal
Resets delta phase value. The set phase is adopted as the new current phase, i.e. the
delta phase value is reset to 0.

Remote command:
[ :SOURce<hw>] : PHASe:REFerence on page 335

5.3.4 Reference Oscillator

In the internal reference mode the internal reference signal is available at the REF
OUT connector. The frequency of the internal reference signal is permanently set to 10
MHz.

The settings of the reference oscillator are not influenced by an instrument preset
("PRESET" key).
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RF Frequency
\/ RFON
Frequency f Phase

Reference Oscillator

RF Block

Reference Oscillator Dialog

To open the "Reference Oscillator" dialog, select "RF > Configure > Reference Oscilla-
tor" or use the MENU key under "RF".

The menu is used to select the source and to adjust the reference frequency. In case an
external source is selected, the reference frequency is displayed.

Source |Enerna|j|

Deactivate RF Qutput
~
(if external reference is missing) =4 &

External Reference Frequency 10 MHz.

Adjustment
Adjustment Active 12

Adjustment DAC Value 0

Source - Reference Oscillator
Selects the source of the reference frequency.

"Internal" The internal reference signal of 10 MHz is used, comprising either the
calibrated or a user-defined adjustment value.

"External” An external reference signal is used. The frequency of the external ref-
erence signal must be selected under "External Reference Fre-
quency".

Remote command:
[:SOURce] :ROSCillator:SOURce on page 367

Deactivate RF Output - Reference Oscillator
Determines if the RF output is switched off in case of a missing external reference signal
for selection external source.

If enabled, this setting ensures that no improper RF signal due to the missing external
reference signal is output and used for measurements.

In addition to the error message "Ext Ref missing"”, the information "RF output deactiva-
ted" is indicated.

This setting is not influenced by a reset.

Remote command:
[:SOURce] :ROSCillator:EXTernal :RFOFf[:STATe] on page 366

External Reference Frequency
Selects the frequency of the external reference signal. You can select an external refer-
ence signal having a frequency of 5 MHz or 10 MHz.

Note: The installed hardware determines the available settings. Use the Hardware Con-
fig dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[ :SOURce] :ROSCillator:EXTernal : FREQuency on page 365

Synchronization Bandwidth - RF Signal
(Source External only)
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Selects the synchronization bandwidth for an external reference signal. The wideband
setting is provided for using very good reference sources of high spectral purity.

"Narrow" Synchronization bandwidth is 1 Hz.
"Wide" Synchronization bandwidth is 750 Hz.

Remote command:
[:SOURce] :ROSCillator:EXTernal : SBANdwidth on page 366

Adjustment Active - Reference Oscillator
Selects adjustment mode.

"OFF" The calibrated adjustment value of the internal reference frequency is
used. This value is determined at one of the R&S service shops during
calibration.

"ON" A user-defined adjustment value is used. The value is entered under

"Adjustment DAC Value".
This allows the frequency to be impaired freely, for example to simulate
a frequency error.
The instrument is no longer in the calibrated state. However, the cali-
bration value is not changed and the instrument resumes the calibrated
state after switching the "Adjustment State" to Off.

Remote command:

[:SOURce] :ROSCillator[:INTernal] :ADJust[:STATe] on page 367

Adjustment DAC Value
Enters a user-defined adjustment value for the internal reference frequency. This value
is not used unless "Adjustment Active On" is selected.

Note: A factory preset resets this setting to the calibration value of the instrument.

Remote command:
[:SOURce] :ROSCillator[:INTernal] :ADJust:VALue on page 366

5.3.5 RF Level

5.3.5.1 Overview of RF Level

Message "Level overrange/underrange”

If this message appears in the status line, the set level ("Level") is out of range (see data
sheet).

In this case, the signal level at the output can deviate from the set value.

Level The value of the RF level is displayed in the level field in the header of the instrument's
[-30.00/#n ~| display and the easiest way to set the RF level is to set it directly in this field.
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Be aware, that there is a difference between the RF level displayed in the header and
the RF output level set in the "Level/EMF" dialog of the "RF" block.

RF level vs. RF output level

The level entered and displayed in the "Level" field takes the offset of any downstream
attenuators/amplifiers into consideration by way of calculation. This means that with a
level offset the level displayed in the header does not correspond to the level at the RF
output, but rather to the level at the output of the downstream instrument.

This allows the desired level at the output of downstream instruments to be entered. The
R&S Signal Generator changes the RF output level according to the set offset.

However, the level entered and displayed in the "Level" menu of the "RF" function block
always corresponds to the RF output level. Any level offset is not taken into consideration.

The level offset is entered in the "Level" menu. Here it is also possible to set the level
without taking the offset into consideration, and to make other settings, such as level
offset, attenuator mode, power-on state.

The correlation is as follows:

"Level" (in header) = "RF output level" (Level in menu) + "Level offset" (Offset in menu)

The RF output is protected against overloading by an external signal applied to the RF
output (see "Reverse Power Protection" on page 127).

Setting the RF level

To change the RF level, press the LEVEL key and enter the desired level. Changes to
the RF level have an immediate effect (without confirmation with the Enter key) on the
output signal.

RF Level

Enters the RF level, considering the level offset (see "RF level vs. RF output level"

on page 122).

dBm, dBuV, mV and uV can be used as the level units. The 4 unit keys are labeled with
these units.

Note: The SCPI command sets the level of the "Level" display, i.e. an entered level offset
is taken into consideration in the level value.

Remote command:
[ :SOURce<hw>] :POWer [:LEVel] [ : IMMediate] [ :AMPLitude] on page 341
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5.3.5.2 REF Level Dialog

To open the "RF Level / EMF" dialog, select "RF" > "Configure" > "Level / Attenuator" or
use the MENU key under "RF".

The combined "RF Level / EMF" dialog is divided into the several sections.
The top sections of this dialog provide access to the level settings.

The offset-free level, level offset and level limit are set in the top section of the menu. The
attenuator mode is set in the "Attenuator Settings" section.

The step width which is used when setting the level using the rotary knob (with "Variation
Active On") is set in the "User Variation" section.

-loix]

Level Settings
Mode [rormal |

Amplitude [ -30.00dBm x|

Lirnit [ 3o00fsem =]
Offset [oo0fos ~]

Low Harmonic Filter

Mode Irlnanual 'I
State IOn 'I

Attenuator Settings

Mode IAUTD 'I

Fixed Range (PEF} In:
-47.00 .. | -27.00  dBm

RF OFF Maode IFuIIAﬂenuation vl

UserVariation
Yariation Active

r
Yariation Step I 'I.UDIdEI 'l

Powet-0nJ EMF Seftings

Power-On State IPreviaus Setting vl

Display Level as Yoltage of EMF r

Ext Level Adjustment

Adjustment Data IFactDr\,r 'I

The power-on behavior of the instrument and the level display in the display header are
set in the "Power-On / EMF Settings" section (see chapter 5.3.5.3, "Power-On/EMF Set-
tings", on page 127).

Level Settings

The offset-free level, attenuation mode, level offset and level limit are set in the top section
of the menu.

If you have the instrument equipped with a harmonic filter, (options R&S SMB-B25/-B26),
you can also configure the filter.

|
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RF Mode
Selects the level mode for signal output.

This function allows you, to optimize the RF output signal for applications, where
improved harmonic suppression or a low Signal-to-Noise ratio is required.

Note: The modes "Low Distortion" and "Low Noise", for improving harmonic suppression
or the S/N ratio require that an attenuator is fitted.

"Normal" The generator provides an RF output signal with high signal to noise
ratio as well as low distortion, according to the data sheet.

"LOW Noise" This setting forces the generator to optimize the signal to noise ratio.
"LOW Distor-  The generator reduces distortion (harmonics) of the RF signal.
tion"

Remote command:
[ : SOURce<hw>] : POWer : LMODe on page 343

Amplitude
Sets the RF level of the RF output connector.

The level entered and displayed here corresponds to the level at the RF output, i.e. any
offset entry is not taken into consideration.

Note: The SCPl command [ : SOURce<hw>] : POWer [ :LEVel] [: IMMediate] [:
AMPLitude] sets the level of the "Level" display, i.e. the level containing offset.

Remote command:
[ :SOURce<hw>] : POWer : POWer on page 345

Limit - RF Level
Sets an upper limit for the RF output power.

You can use it to protect your DUT from damage due to high input power. If you enter an
RF level above this value, the instrument limits the output power to this specified value,
and generates a warning message.

However, the level indication in the status bar is not affected.

Note: The limit value is always effective, regardless of whether you work with "NRP-Z
Power Control" or not.
The value is not affected by an instrument preset (PRESET key), *RST and the "Save/

Recall" function. It is influenced only by the Factory Preset and the factory value is equal
to maximum level.

Remote command:
[ :SOURce<hw>] :POWer:LIMit [:AMPLitude] on page 343

Offset (Level)
Sets the level offset relative to the RF level.

The level offset of a downstream instrument (e.g. an attenuator or amplifier) is entered.
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The entry does not change the value of the RF level at the RF output. It only changes the
RF level displayed in the display header. The value of the RF level in the header corre-
sponds to the level at the output of the downstream instrument.

Remote command:
[ :SOURce<hw>] : POWer [:LEVel] [ : IMMediate] : OFFSet on page 342

Low Harmonic Filter Settings

In 20 GHz or 40 GHz instruments (option R&S SMB-B120(L) /-B140(L)), it is possible to
install a low harmonic filter (option R&S SMB-B25 /-B26), in order to improve the harmonic
performance.

For a fitted low harmonic filter, you can define its operating mode in section "Low Har-
monic Filter" of the "RF Level / EMF" dialog. Otherwise, the section is hidden.

LovelAdustr » To access the filter settings, select "RF > Config > RF Level > Low Harmonic Filter".

Low Harmanic Fitter..

Lowe Harmanic Filter

tode IManuaI 'I

State On =

Mode
Selects between automatic or manual switching of the filter.

"Auto" The filter switches automatically on and off, according to the given
operating conditions. It is active within a certain frequency and level
range and automatically turns off, if the frequency falls below the lower
limit, or the level exceeds the upper limit.

The corresponding limit values are given in the data sheet.

Note: The State field shows the current state of the filter.
"Manual" In this mode, you can switch the filter individually.

Remote command:
:0UTPut<hw>:FILTer :AUTO on page 276

State
Switches the filter in manual mode.

Note: If you work in the "Auto" Mode, this parameter shows the current state of the filter.
If you then change the state, the operation mode automatically turns to manual operation.

Remote command:
:OUTPut<hw>:FILTer[:LPASs] :STATe on page 276

Attenuator Settings

The R&S SMB can be configured to provide level settings without interruption. This
applies to instruments with, as well as without step attenuator. The attenuator mode is
set in the "Attenuator Settings" section of the "RF level / EMF" dialog.

Attenuator Mode
Sets the attenuator mode at the RF output.

"Auto" Standard mode.
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"Fixed" When this operating mode is switched on, the attenuator, relays and
amplifier stages are fixed in their current positions to provide level set-
tings without interruption. The resulting variation range is defined and
displayed under "Attenuator Fixed Range".

Note: The function is effective when automatic level control is activated
("ALC State = On").

If the normal variation range is overranged or underranged, level errors
increase considerably and the warning "Level under/overrange"
appears in the info line. The spectral purity of the output signal decrea-
ses with high attenuation.

Remote command:
:OUTPut<hw>:AMODe on page 276

Fixed Range (PEP) In
Displays the level range in which the level is set without interruption for the "Attenuator
Mode fixed" setting.

Remote command:
:OUTPut<hw>:AFIXed:RANGe:UPPer? on page 275
:OUTPut<hw>:AFIXed:RANGe:LOWer? on page 275

RF OFF Mode
Selects the attenuator mode, when the RF signal is switched off.

The setting of the RF OFF mode is not affected by an instrument preset (PRESET key),
*RST and the "Save/Recall" function. This parameter is influenced only by the Factory
Preset.

"Unchanged" Freezes the setting of the attenuator when RF is switched off. The
attenuator is only activated when RF is switched on.
This setting recommended if a constant VSWR (Voltage Standing Wave
Ratio) is required.
Furthermore, on instruments equipped with a mechanical attenuator, it
provides fast and wear-free operation.

"Full Attenuation"
Sets attenuation to maximum when the RF signal is switched off. This
setting is recommended for applications that require a high level of
noise suppression.

Remote command:
[ :SOURce<hw>] : POWer:ATTenuation:RFOFf :MODE on page 340

User Variation

If the level is set using the rotary knob, the step width is defined in the "User Variation"
section.

Variation Active
Activates the user-defined step width used when varying the level value with the rotary
knob.

"ON" The level value set with the rotary knob is varied using the user-defined
step width which is entered under "Variation Step".

|
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"OFF" The level value set with the rotary knob is varied in steps of one unit at
the cursor position (standard operating mode).

Remote command:
[ :SOURce<hw>] : POWer: STEP:MODE on page 348

Variation Step
Sets the user-defined step width for entering the RF level using the rotary knob. Level
variation with this step width must also be activated with "Variation Active".

Remote command:
[ : SOURce<hw>] : POWer: STEP [ : INCRement ] on page 348
Reverse Power Protection

The reverse power protection prevents against overload by an external signal applied to
the RF output of the R&S Signal Generator.

The R&S SMB equipped with frequency options up to 6 GHz includes a reverse power
protection as standard. For instruments equipped with frequency option R&S SMB-B112
or R&S SMB-B112L a reverse power protection option R&S SMB-B30 is available. Refer
to the data sheet for additional information and the respective option.

Refer to the data sheet for additional information and the respective options.

The reverse power protection is tripped when the power of the external signal becomes
too high. A relay opens and interrupts the internal connection to the RF output. This
condition is indicated in the display header by the "OVERLOAD" status message.

Overload
If an "Overload" status message is indicated in the display header, reset the overload
protection by pressing the RF ON/OFF key.

The RF input is activated when the overload protection is reset.

Remote command:
:OUTPut<hw>:PROTection:TRIPped? on page 277
:OUTPut<hw>:PROTection:CLEar on page 277
:OUTPut<hw>[:STATe] on page 278

5.3.5.3 Power-On/EMF Settings

RF Level
Level fAttenuatar.

The power-on behavior of the R&S SMB and the level display in the display header are
set in the "Power-On / EMF Settings" section of the "RF Level/EMF" dialog.

To open the "RF Level/lEMF" dialog, select "RF > Configure > EMF" or use the MENU
key under "RF".

Power-On / EMF Seftings

Fower-On State IPrevious Setting v|

Display Level as Voltage of EMF I
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Power-On State - RF Signal
Selects the state which the RF output is to assume after the instrument is switched on.

"RF Off" The output is deactivated when the instrument is switched on.

"Previous Set- When the instrument is switched on, the output assumes the same state
ting" as it had when the instrument was switched off.

Remote command:
:0UTPut<hw>[:STATe] : PON on page 278

Display Level as Voltage of EMF - RF Level
Activates display of the signal level as voltage of the EMF (no-load voltage). If this setting
is deactivated, the level is displayed as a voltage over a 50 Ohm load.

Remote command:
n.a.

5.3.5.4 Automatic Level Control - ALC

Your signal generator is equipped with an automatic level control unit to obtain best RF
level accuracy.

Automatic Level Control (ALC) is an adaptive control system to stabilize the RF output
level. It continuously monitors the current level and adjusts it to keep a steady state over
temperature and time.

ALC is active in almost all applications by default. However, the Pulse Modulation mode
excludes ALC, as the control loop would detect incorrect values and result in level devi-
ations.

Also note that ALC may detect incorrect values in multi-transmitter test setups. If mul-
tiple generators are coupled, reverse power may affect the ALC readings. Based on
incorrect values, ALC would have an impact on the signal to intermodulation ratio.

ALC States

The following description basically explains the ALC states and their principle of opera-
tion. In particular ALC OFF (Sample & Hold) gives an overview on the function in terms
of the equipment of the generator.

The R&S SMB offers the ALC states:

e AUTO

automatically adjusts the output level to the operating conditions.
e On

enables ALC permanently, regardless of the currently selected mode.
o Off

deactivates ALC.

The instrument switches to Sample & Hold (S&H) state, which still allows to maintain
a constant output level.
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The following section explains the functionality of "Sample & Hold", to provide an overview
and to indicate what is to be considered. "On" and "Auto" require no additional explana-
tion. Furthermore, find the ALC state settings described in detail in State - ALC.

ALC OFF (Sample & Hold)

In "S&H" mode, the signal generator switches for a short period of time into CW mode
and activates ALC. ALC adjusts the level to the set value and the generator holds the
value (freeze). Then, the generator switches ALC off again and back to the operating

mode.

RF output behavior during Sample & Hold depends on the configuration of your instru-
ment. Instruments equipped with...:

e an electronic step attenuator
The level is decreased by 30 dB.

e amechanical step attenuator
By default, the mechanical step attenuator is not switched during S&H cycles to opti-
mize the settling time. The instrument provides the output power for 3 ... 5 ms.
However, you can affect the attenuation at the output by the setting "RF during Power
Search" to "Minimum", see RF During Power Search - ALC. Then the generator
decreases the level by 30 dB with the mechanical attenuator. Note that this may take
a certain period of time.
High frequency instruments, such as the R&S SMB with one of the high frequency
options R&S SMB-B120 or R&S SMB-B140, are equipped with a mechanical step
attenuator.

e no step attenuator
The signal generator outputs the set level for 3 to 5 ms after level or frequency setting
during a Sample & hold measurement.
Instruments equipped with one of the options R&S SMB-B112L, R&S SMB-B120L or
R&S SMB-B140L come without step attenuator.

The level control status is permanently displayed as a status message in the info line.

| ALC-Auto Infa

Automatic Level Control Settings

wema. 10 Open the "Automatic Level Control" dialog, select "RF" > "Configure” > "Automatic
........... Autornatic Level Gontrol.. Level Control" or use the MENU key under "RF".

The combined dialog "ALC / UCOR" is divided into the several sections and provides
access to the "Automatic Level Control" settings and to function "User Correction", see
chapter 5.3.5.6, "User Correction", on page 134).

State - ALC

Activates/deactivates internal level control.

|
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"Auto" The instrument selects the most appropriate ALC mode automatically.
ALC is on in most operating conditions. Default state.

"On" Activates ALC, regardless of the operating conditions.

"Off (Sample & Deactivates internal level control.

Hold)" Sample & hold closes the level control loop at every frequency and level
change for a short period of time. The level control voltage is sampled
and then clamped.

Remote command:
[ : SOURce<hw>] : POWer:ALC[:STATe] on page 340

RF During Power Search - ALC
Activates the mode for the mechanical step attenuator and for output during ALC power
search.

"Normal" The RF output is active during power search.
"Minimum" The RF output is inactive during power search.

Remote command:
:OUTPut<hw>:ALC:SEARch:MODE on page 276

Search Once - ALC
Forces the generator to execute level adjustment once, although the "Sample & Hold"
mode is active.

Remote command:
[ :SOURce<hw>] : POWer : ALC: SONCe on page 340

NRP-Z Level Control

With the NRP-Z Level Control function, you can achieve a very stable and accurate RF
power supplied to your DUT. With the aid of a downstream control circuit, a CLPC (Closed
Loop Power Control), you can detect frequency response characteristics of the used
components, such as losses due to cables, modules or components like power amplifiers,
and compensate these effects accordingly.

|
Operating Manual 1407.0806.32 — 13 130



R&S®SMB100A Instrument Function

RF Block

Example: How to set up a closed loop power control

Fig. 5-1: Example of a test setup with NRP-Z Level Control

As shown in the example, the sensor measures a proportional power in defined time
intervals, derivated from a coupler. It considers optionally given S-parameters and returns
the results to the generator. The signal generator compares the measured level with the
set value and adjusts its output level accordingly.

This allows you to control the external signal level continuously and reliably reach a con-
stant input level at the DUT in real time.

Impact of the NRP-Z Level Control and the Operating Modes

Since the frequency and level of the RF output signal are continuously adjusted during
"NRP-Z Level Control", this operating mode interferes those with varying frequency and
level values.

The reason is, that the generator regularly transmits the output frequency to the connec-
ted R&S NRP-Zxx power sensor, which in turn requests the signal generator to adjust
the output level according to its measurement. In contrast to this real time control loop,
for example the list operating mode already generates the RF output signal on previously
optimized frequency and level value pairs. In this case, the "NRP-Z Level Control" as a
second control loop would impact the already determined RF signal values and also
considerably slow down the measurement. Similar impacts occur in sweep mode, and
also the "NRP-Z Power Viewer" and "NRP-Z Level Control" affect each other's function-
ality.

Hence, the operating modes exclude each other as follows:

® "NRP-Z Level Control" automatically disables NRP-Z Power Viewer, and vice versa.

e Activating the RF frequency sweep, RF level sweep or the list mode instantly deac-
tivates a running "NRP-Z Level Control".

e Arunning list or RF sweep mode blocks "NRP-Z Level Control". It can not be activa-
ted.

Also keep in mind that modulated signals may differ from CW signals regarding mean
power and peak power. This affects the operation of "NRP-Z Level Control".

Operating Manual 1407.0806.32 — 13 131



R&S®SMB100A Instrument Function

RF Block

NRP-Z Level Control Settings

RF Level To open the "NRP-Z Level Control" dialog, select "RF > Configure > NRP-Z Level Con-

Lewel fAttenuatar.

automatic Level control..— £rOl" or use the MENU key under "RF".

MRP-Z Level Caontral...
& NRP-Z Level Contr 10l =|

User Correction...
|1 NRP-Z81 5N 800004 =l

= |
Measured Level -54.53 dBm

Zero |
Target Level mm
RfLevelLimit [ 30.00[dBm <]
Catch Range +- lﬁlﬂ
Delay Time I—Dm

Use Peak Power [~ On

Use SParameter [~ On

Sensor
Selects the R&S NRP-Z power sensor for power control.

Note: In remote control, the sensors are set up using the SENSe commands. The remote
measurement is triggered by the READ query which also provides the measurement
results.

The software version of the connected power sensor can be retrieved by means of the
remote control command : SENS: POW: TYPE?.

Use the "Setup >" chapter 5.2.3.6, "NRP-Z Info/Update", on page 87 dialog to update the
sensor software.

Remote command:
[ :SOURce<hw>] : POWer:SPC:SELect on page 347

State
Activates power control using the selected sensor.

The control loop periodically adjusts the generator output. After switching off, the running
loop is completed.

Remote command:
[ :SOURce<hw>] : POWer: SPC: STATe on page 347

Measured Level
Indicates the current reading of the sensor.

Zero - Power Sensors
Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal power.
For this purpose, the RF power source must be switched off or disconnected from the
sensor (see tips below). R&S power sensors automatically detect the presence of any
significant input power. This aborts zeroing and generates an error message. Zeroing
can take a few seconds, depending on the sensor model; refer to the documentation of
your external power sensor for more information.

Tips for zeroing
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Zeroing should be performed:

e During warm-up after switching on or connecting the instrument

After a substantial change of the ambient temperature

After fastening the power sensor module to an RF connector at high temperature

After several hours of operation

When very low-power signals are to be measured, e.g. less than 10 dB above the

lower measurement limit.

e Switch off the RF power source for zeroing; do not disconnect it from the power sen-
sor. In this way you will maintain the thermal equilibrium, and zeroing will also com-
pensate for the noise superimposed on the measured signal (e.g. from a broadband
amplifier).

Remote command:
:SENSe<ch>[:POWer] : ZERO on page 287

Target Level

Specifies the nominal level expected at the input of the sensor. The signal generator
adjusts the output power accordingly, in order to meet the target value at the sensor input,
and thus the power required at the DUT.

Remote command:
[ :SOURce<hw>] : POWer:SPC:TARGet on page 347

Limit - RF Level

Sets an upper limit for the RF output power.

You can use it to protect your DUT from damage due to high input power. If you enter an
RF level above this value, the instrument limits the output power to this specified value,
and generates a warning message.

However, the level indication in the status bar is not affected.

Note: The limit value is always effective, regardless of whether you work with "NRP-Z
Power Control" or not.

The value is not affected by an instrument preset (PRESET key), *RST and the "Save/
Recall" function. It is influenced only by the Factory Preset and the factory value is equal
to maximum level.

Remote command:

[ :SOURce<hw>] : POWer:LIMit[:AMPLitude] on page 343

Catch Range +/-
Sets the capture range of the control system.

Within the range:
Target Level +/- Catch Range

the power control locks and tries to achieve the target level. Readings outside the range
are not considered.

Remote command:
[ :SOURce<hw>] : POWer: SPC: CRANge on page 346
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Delay Time
Defines a waiting period between the level adjustment of the generator and the next
measurement of the power sensor.

With this parameter, you compensate any dead times in the controlled system.

Remote command:
[ :SOURce<hw>] : POWer: SPC:DELay on page 346

Use Peak Power
Activates control by means of the peak power values, provided the power sensor supports
this function. Otherwise, the dialog does not show this parameter.

Remote command:
[ : SOURce<hw>] : POWer : SPC: PEAK on page 346

Use SParameter - Power Sensors
Activates the use of the S-Parameter correction data of the connected power sensor. For
sensors with attenuator this checkbox is automatically checked.

Refer to the manual of the connected R&S NRP-Zxx power sensor for a description on
how to use the SParameter table.

Remote command:
:SENSe<ch>[:POWer] : CORRection:SPDevice: STATe on page 280

User Correction

The "User Correction" function is used to create and activate lists in which level correction
values predefined by the user are freely assigned to RF frequencies. Correction is per-
formed by the user-defined table values being added to the output level for the respective
RF frequency.

With frequencies which are not contained in the list, the level correction is determined by
interpolation of the closest correction values.

The lists are created in the "List Editor". Each listis stored in its own file with the predefined
file extension *. uco. The name of the User Correction file can be freely selected. The
files are loaded from the "Lists..." file manager. Externally created tables with pairs of
frequency and level values can be converted into User Correction files using the import
function. The external files must have the file extension *. txt or *.csv. These file
formats are provided e.g. by the Microsoft Excel program. The separators for table col-
umns and for decimal floating-point numerals can be set. In addition, internally created
User Correction data can be exported into ASCII files using the export function.

The amplitude can also be linearized automatically by means of an R&S NRP power
sensor connected to one of the generator output signals. With the aid of the "Fill with
Sensor" function, a table with correction values for external test assemblies can be auto-
matically determined, e.g. for compensating the frequency response of cables. The User
Correction list with the correction values acquired by the sensor is generated in the "Edit
User Correction List" menu. The correction values can be acquired any time irrespective
of the modulation settings of the generator.
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If user correction is activated, the "UCOR" display (User Correction) is shown in the
header together with the "Level" display. The RF output level is the sum of both values.

"Level" + "UCOR" = Output level

If activated, user correction is effective in all operating modes.

User Correction Menu

oz To open the "User Correction" menu, select "RF > Configure > User Correction" or use

Automatic Level Cantrol . the MENU key under "RF".

MNRP-Z Level Contral
User Correction

The combined menu "ALC/UCOR" is divided into the several sections.

User Correction Settings

The "User Correction" settings are set in the most lower section of the combined dialog;
this section is used to activate/deactivate user correction, and to create, select and acti-
vate the lists.

The upper section provides access to the automatic level control settings, see chap-
ter 5.3.5.4, "Automatic Level Control - ALC", on page 128.

User Correction Settings
State

User Correction I 0.00 dB
User Cor. Data... | ucaor
Edit User Cor. Data... |

ImportExpart == |

State - User Correction
Activates/deactivates user correction.

The "UCOR" status message appears in the frequency and level display.

Remote command:
[ :SOURce<hw>] :CORRection[:STATe] on page 299

User Correction Value - User Correction
Indicates the current value for level correction.

Remote command:
[ :SOURce<hw>] : CORRection:VALue? on page 299

User Cor. Data - User Correction
Calls the "File Select" menu for selecting and creating a list or the "File Manager".

Select User Correction Data
Mew User Correction Data
File Manager...

Remote command:
[ :SOURce] : CORRection:CSET:DELete on page 294
[ : SOURce<hw>] :CORRection:CSET[:SELect] on page 298
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Edit User Cor. Data - User Correction
Calls the editor for editing the selected user correction list.

A list consists of any number of frequency/level value pairs. The currently selected list is

displayed.

Each listis saved as a separate file with extension * . uco. The file name and the directory
to which the file is saved are user-selectable.

Note: Save list only after filling both columns (frequency and level), otherwise the entries

are lost.

"Frequency /
Hz"

"Power/dB"

"Goto"

"Edit"

"Insert Row"

Enters the frequency to which the level correction value applies.

Note: The "Fill..." function allows to automatically enter any number of
frequencies with freely selectable range and increment.

Using the "Fill With Sensor" function of the "Edit" sub menu requires
only the entry of the frequency values. The level values are automati-
cally acquired by the connected power sensor.

Enters the level correction value to which the specified frequency
applies. The values can be entered manually or automatically with the
"Fill With Sensor" function (available in the "Edit" sub menu).

Selects row for editing.

Goto First
Goto Last
Goto Row...

If Goto row is selected, a window opens for entering the requested row.

0K | Cancel |

Calls a selection of possible actions described below.

Insert Row
Insert Range...
Fill...

Fill With Sensor...
Delete Row
Delete Range...

Insert a new row before the marked row.

|
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"Insert Range" Insert new rows before the marked row. The number of rows to be
inserted can be defined in an entry window.

[Rows to msert | |
OK | Cancel |
"Fill...." Opens a sub menu for defining a set of list values to be automatically

entered in the ucor list (see "Filling the Correction List automatically”
on page 139).

"Fill With Sen-  Calls the menu to activate the filling of the user correction list with level

sor" values acquired by the selected power sensor (see "Filling the Correc-
tion List with Power Sensor Measurement Data" on page 140).

"Delete Row" Deletes the marked row.
"Delete Allows to delete any number of rows starting with the marked row. The
Range..." number of rows to be deleted can be defined in an entry window.

IRuws to Delete I | I

0K | Cancel |

"Save" The list is saved under its current name.

Remote command:

[ :SOURce<hw>] : CORRection:CSET[:SELect] on page 298

[ : SOURce<hw>] : CORRection:CSET:DATA: FREQuency on page 292
[ :SOURce<hw>] : CORRection:CSET:DATA: POWer on page 293

Import/Export

User correction list can be imported from externally created files or exported into text or
CSV-files. The import/export settings are available after clicking the "Import/Export" but-
ton.

Import/Export >>>
Expands the menu with the area for import and export of user correction files.

Externally edited Excel tables with any number of frequency/level value pairs can be
imported as text or CSV-files and used for user correction.

Conversely, you can also export internally created user correction lists as text or CSV-
files.

|
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=== Hide Imporb'Exportl

Import / Export UCOR Files
IImp-:lrt vli

=== Hide ImporLfExportl

——Import/Export UCOR Files
lMode IExp-:lrt vli

ASCI File Settings ASCI File Seftings———————
ST | Extension T -
Decimal Point Im Decimal Paint m
SR SR Im Column Separator Im

Select ASCIl Source | Select ASCII Destinatimj

Mone Mone
Select Destination | Select Source |

Mone Mone

Mode - User Correction
Selects if user correction lists should be imported or exported. The settings offered
depend on the selected mode.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange :MODE on page 297

Extension - User Correction
Selects the file extension of the ASCII file to be imported or exported. Selection "TXT"
(text file) or "CSV" (Excel file) is available.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange:AFILe:EXTension on page 295

Decimal Point - User Correction
Selects the decimal separator used in the ASCII data between '.' (decimal point) and ',
(comma) with floating-point numerals.

Remote command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe:SEParator:DECimal
on page 296

Column Separator- User Correction
Selects the separator between the frequency and level column of the ASCII table the user
correction list is exported to or imported from.

Remote command:
[ :SOURce<hw>] : CORRection:DEXChange:AFILe:SEParator:COLumn
on page 296

Select ASCII Source / Destination - User Correction
Calls the "File Manager" for selecting the ASCII file to be imported into a user correction
list (source) or the ASCII file the user correction list is exported (destination) in.

Remote command:
[ : SOURce<hw>] : CORRection:DEXChange:AFILe: SELect on page 295
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Destination / Source - User Correction
Calls the "File Manager" for selecting the user correction list to be exported (source) into
an ASCII file or the destination for the ASCII file to be imported (destination) in.

Remote command:
[ :SOURce<hw>] : CORRection:DEXChange:SELect on page 298

Import / Export - User Correction
Starts the export or import of the selected file.

When import is selected, the ASCII file is imported as user correction list.
When export is selected, the user correction list is exported into the selected ASCII file.

Remote command:
[ :SOURce<hw>] : CORRection:DEXChange:EXECute on page 297

Filling the Correction List automatically

The "Fill Table" menu enables you to automatically set the level correction values.

Fill Uset Correction Data

From |—1
Range |—3
Select column to fill IW
Start Value | 0.00 [Hz =]
End Value | 0.000 000000000 [Hz =]
Increment Value | 0.000 000 000 000 |Hz =]

I Fil 1

The start line and the number of rows to be filled are defined under "From" and "Range.

The column to be filled is selected under "Select column to fill". Depending on the selec-
tion here, the default for start, end, and increment value are set. As the settings are
interdependent, a change of one parameter may result in the automatic change of one
or more of the other parameters. The filling of the column with the selected value settings
is started with button "Fill".

The correction list entries are only computed when the "Fill" button is pressed.

From
Sets the start value of the index range.

Remote command:
n.a.

Range
Sets the range for filling the table.

Remote command:
n.a.

|
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Select column to fill
Selects either the frequency or the level column to be filled with the value defined below.

Remote command:
n.a.

Start value
Sets the start value for the frequency or the level entries.

Remote command:
n.a.

End value
Displays the end value for the frequency or the level entries.

Remote command:
n.a.

Increment value
Sets the increment for the frequency or the level entries.

Remote command:
n.a.

Fill
Fills the selected column in the set range with values, starting with the start value and
using the set increment.

Remote command:
n.a.

Filling the Correction List with Power Sensor Measurement Data

The level correction values for the user correction list can be acquired by means of R&S
NRP power sensors. The R&S NRP sensors are connected to either the SENSOR con-
nector or to one of the USB interfaces. Configuration of the connection is performed in
the "Power Sensor" menu (see chapter 5.3.6.1, "NRP-Z Power Viewer", on page 141).
The filling of the user correction list with measurement data is performed in the ucor list
editor (see "Edit User Cor. Data - User Correction" on page 136).

In the editor, the frequencies for which the correction values are to be acquired are
entered in the frequency column (either manually or by means of the "Fill..." menu).

Do not save the list at this point, because the frequency entries are lost as long as there
are no entries for the level column also. In the following these entries are automatically
acquired by the connected power sensor.

All level correction values for the given frequency values are measured using the Power
Sensor and automatically filled in the selected list after the "Execute" button is pressed.
The list is automatically stored and recalled again after filling.
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Fill User Correction Data with Sensor Settings

The "Fill with Sensor" button of the "Edit User Correction Data" menu opens the associ-
ated menu.

Sensor |1 - NRP-Z11 3/M 200001 K4
List To Fill IUZJUSETCONECIIOI'IDHTE

— Used SLIB Setings For Measuremeant—
WMadulation [orewy
Amplitude lmlm
Use SParameter [ or
Attenuator Mode |

Fixed Range (PEP} In

|5 980.0 ... 6000.0 dBm

The menu indicates the relevant generator settings.

Fill User Correction Data with Sensor
All settings are read-only, except the "Sensor". In case more than one sensor is connec-
ted to the instrument, the sensor can be selected in the "Sensor" field of menu.

The "Execute" button is only enabled if a sensor is detected and the user correction list
contains at least one frequency value.

Remote command:
[ :SOURce<hw>] :CORRection:CSET:DATA[ : SENSor<ch>] [ : POWer] : SONCe
on page 294

5.3.6 RF Measurement

5.3.6.1 NRP-Z Power Viewer

The R&S signal generator supports R&S NRP-Z power sensors to measure the power
of the output signal in the RF path or any freely selectable source. The generator performs
up to four power measurements, with the sensors either directly connected, or via the
R&S NRP-Z5 USB Sensor Hub.

sensors and provides simultaneous internal and external triggering of all connected sen-
sors.

@ The R&S NRP-Z5 USB Sensor Hub (high-speed USB 2.0) can host up to 4 R&S NRP-Z

You can directly connect the R&S NRP-Z Sensors to the standard NRP sensor connec-
tors of the hub. The hub is connected to the R&S instrument via USB with the adapter
cable R&S NRP-Z4.

See also the R&S website http://www.rohde-schwarz.com in section "Power Meters &
Voltmeters > R&S NRP-Z Sensors" for information on the sensor hub and the available
accessories.

To connect a sensor directly at a USB interface, the USB adapters R&S NRP-Z3 or R&S
NRP-Z4 are available.
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The instrument automatically detects a connected R&S NRP-Z power sensor and indi-
cates it in the "NRP-Z Power Viewer" dialog. In addition, you find device specific infor-
mation on the connected sensor in the chapter 5.2.3.6, "NRP-Z Info/Update",

on page 87. For information on the scope of your power sensor refer to the manual of
your R&S NRP-Zxx power sensor.

A sensor continuously measures the average signal power of the selected source. The
signal generator shows the result in either the "NRP-Z Power Viewer" dialog, or directly
in the block diagram. You can activate the permanent display in the block diagram in the
"NRP-Z Power Viewer" dialog. This dialog provides access to all parameters concerning
sensor settings, like average or peak display, reference source, filter and level offset, see
NRP-Z Power Viewer Settings.

The signal generator also supports the use of R&S NRP-Z power sensors for the acqui-
sition of level correction data. The acquired level correction data is used to create and
activate lists in which level correction values predefined by the user are freely assigned
to RF frequencies. Correction is performed by the user-defined table values being added
to the output level for the respective RF frequency (see chapter 5.3.5.6, "User Correc-
tion", on page 134).

"NRP-Z Power Viewer" automatically disables NRP-Z Level Control, and vice versa.

=

RF Measurement —
RP-Z Power Viewer.

NRP-Z Power Viewer Settings

To open the "NRP-Z Power Viewer" menu, select "RF" > "Configure" > "NRP-Z Power
Viewer" or use the MENU key under "RF".

The dialog shows the settings and measurement values of the sensor selected in the field
next to the connector symbol. For indicating the parameters of another sensor, switch to
the respective sensor in the selection list.

When you connect your power sensor(s) via the R&S NRP-Z5 USB sensor hub, each
channel of the hub is firmly assigned to the associated sensor channel in the generator.

Al
[=  [1-nRP-z81 5M 200004 -
State on |
Level (Peak) | -21.13 |uam =
Level (Ava.) | _6[]2[] IdElm j
Display Permanent ¥ Priority |Avg. =

|
Source [re -]
Level Offset  [ofi =[] 00008 -
Filter [puto =] 65 536
Use SParameter I~ on

Sensor - Power Viewer

Selects the R&S NRP-Z power sensor for indication.
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In remote control, the sensors are set up using the SENSe commands. The remote mea-
surement is triggered by the READ query which also provides the measurement results.

The sensor is selected by suffix 1, 2, 3 or 4 in key word SENSe or READ of the command
header.

Suffix 1 denotes the sensor connected at the first USB interface, and suffix 2, 3 and 4 are
assigned to further sensors connected via USB. The suffix is identical to the index which
is assigned automatically to each sensor upon connection.

Note: The software version of the connected power sensor can be retrieved by means
of the remote control command : SENS: POW: TYPE?.

Use the "Setup >" chapter 5.2.3.6, "NRP-Z Info/Update", on page 87 dialog to update the
sensor software.

Remote command:
SENSe<ch>[:POWer] : STATus [ : DEVice]? on page 286

Type - Power Sensors
Indicates the type and the serial number of the connected R&S NRP-Z power sensor.
The sensor type is automatically detected.

Remote command:
SENSe<ch>[:POWer] : TYPE? on page 286
SENSe<ch>[:POWer] : SNUMber? on page 285

State - Power Sensors
Activates/deactivates level measurement by the power sensor.

The local state is set with the INIT command. Switching the local state off enhances the
measurement performance.

In remote control, the sensors are set up using the SENSe commands. The remote mea-
surement is triggered by the READ query which also provides the measurement results.
The state is not influenced by these commands, measurements results can be retrieved
with local State on or off.

The sensor is selected by suffix 1, 2, 3 or 4 in key word SENSe or READ of the command
header.

Suffix 1 denotes the sensor connected at the first USB interface, and suffix 2, 3 and 4 are
assigned to further sensors connected via USB. The suffix is identical to the index which
is assigned automatically to each sensor upon connection.

To query the availability of a sensor at a given connector, use the command
SENSe<ch>[:POWer] : STATus [ :DEVice] ? on page 286.

Remote command:
:INITiate<ch>[:POWer] :CONTinuous on page 279

Level (Peak) - Power Sensors
With certain power sensors only, e.g. R&S NRP-Z81.

Indicates the measured peak level value with the selected unit.

Remote command:
:READ<ch>[:POWer] ? on page 279
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Level (Avg.) - Power Sensors
Indicates the measured level value with the selected unit.

Remote command:
:READ<ch>[:POWer] ? on page 279

Unit - Power Sensors
Selects the unit used for result display.

The power sensor provides the measured value in Watt.

In which unit the measured value is indicated is selected here and might be Watt, dBm
or dBuV.

Remote command:
:SENSe<ch>:UNIT[:POWer] on page 287

Permanent Display State - Power Sensors

Activates the permanent indication of the power measurement result in the upper right
corner of the block diagram. The instrument shows the type of sensor, the corresponding
connector, the measurement source and - if set - the offset.

|1|§|NRP-ZE10ﬂs -60.86dBm RFl

It is possible to switch the permanent display active for several sensors. In this case, the
instrument indicates the values of the sensor with the lowest port number in the display.

Remote command:
:SENSe<ch>[:POWer] :DISPlay:PERManent: STATe on page 280

Display Priority - Power Sensors

Determines which power measurment result is indicated in the permanent display. If the
NRP-Zxxx power sensor can measure peak power, the peak power is displayed by
default, if not, the instrument automatically indicates the average power.

Remote command:
:SENSe<ch>[:POWer] :DISPlay:PERManent:PRIority on page 281

Zero - Power Sensors
Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal power.
For this purpose, the RF power source must be switched off or disconnected from the
sensor (see tips below). R&S power sensors automatically detect the presence of any
significant input power. This aborts zeroing and generates an error message. Zeroing
can take a few seconds, depending on the sensor model; refer to the documentation of
your external power sensor for more information.

Tips for zeroing

Zeroing should be performed:

e During warm-up after switching on or connecting the instrument

e After a substantial change of the ambient temperature

e After fastening the power sensor module to an RF connector at high temperature
e After several hours of operation
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e When very low-power signals are to be measured, e.g. less than 10 dB above the
lower measurement limit.

e Switch off the RF power source for zeroing; do not disconnect it from the power sen-
sor. In this way you will maintain the thermal equilibrium, and zeroing will also com-
pensate for the noise superimposed on the measured signal (e.g. from a broadband
amplifier).

Remote command:

:SENSe<ch>[:POWer] : ZERO on page 287

Source - Power Sensors
Selects the source for measurement.

"RF" Measurement source is the RF signal of the generator. The RF fre-
quency is used as the measurement frequency of the sensor and the
corresponding correction factor is used.

In this mode the RF frequency of the generator is send to the sensor
automatically if changed.

"User" Measurements source is any freely selectable source. The frequency
is entered manually under frequency (e.g. for measurement of amplifier
gain with 2 sensors).

Remote command:
:SENSe<ch>[:POWer] : SOURce on page 286

Frequency - Power Sensors
Source User only

Enters the frequency for measurement source "User".

Remote command:
:SENSe<ch>[:POWer] : FREQuency on page 284

Level Offset - Power Sensors

Activates and defines a level offset which is added to the measured value. This allows
e.g. an attenuator in the signal path to be considered. The offset is always entered in dB,
irrespective of the selected unit for result display.

Remote command:
:SENSe<ch>[:POWer] : OFFSet : STATe on page 285
:SENSe<ch>[:POWer] : OFFSet on page 285

Auto Once
Searches for the optimum filter length for the current measurement conditions and indi-
cates value in the "Filter Length" field above.

Remote command:
:SENSe<ch>[:POWer] : FILTer : SONCe on page 283

Filter Length - Power Sensors
Selects the filter length used for measurement. The filter length is the multiplier for the
measurement time and thus directly influences it.

|
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The averaging filter is used to reduce fluctuations in the measured result to the extent
desired. Such fluctuations can be caused by inherent noise of the measuring instrument,
modulation of the measurement signal or beats from the superposition of adjacent car-
riers. A more stable display has to be traded off against longer measurements. The mea-
surement result is obtained from a two-stage averaging process.

Note: Longer measurements does not mean that it takes longer to display a new result,
but rather that it takes longer for the result to settle when the power changes.

Measurements are continuously repeated in a predefined time window. The measure-
ment result is obtained by averaging the measured values for the last 2N time windows.
The number N is the filter length, the factor of 2 arises because the output signals from
the microwave detector to suppress low-frequency noise are chopped at the same rate
as the time windows, which means that an independent measured value can only be
obtained from two consecutive values. As the filter length is the multiplier for the time
window it directly influences the measurement time.

The filter length can be selected automatically or can be manually set to a fixed value.
As a preliminary, you should always check if the auto mode is giving satisfactory results
because you will always have to adjust an optimal, manual filter-length setting if the power
is not constant.

Selection "Fixed Noise" is offered for reaching defined measurement accuracy.

"Auto" The filter length is automatically selected and adapted to the currently
measured value. With very high signals the filter length and therefore
the measurement time can be short. With very low signal levels the filter
length and therefore the measurement time is increased in order to
reduce noise. The used filter length is indicated in the field to the right.

"User" The filter length is set manually.
The filter length is entered in the entry window to the right. As the filter
length works as a multiplier for the time window, this results in a con-
stant measurement time. Values 1 and 2*n are settable.

Note: The time window varies depending on the used sensor. For most
sensors it is fixed to 20 ms. For the R&S NRP-Z81 sensor it is 10 us.
Therefore, the user filter length for the R&S NRP-Z81 has be about
1000 times larger than the filter length for other sensors in order to
achieve the same filtering result.
The "Auto Once" button can be used to search for the optimum filter
length for the current measurement conditions. The found filter length
is indicated in the field to the right.

"Fixed Noise"  The averaging factor is selected so that the sensor's intrinsic noise (2
standard deviations) does not exceed the specified noise content.
The desired noise content is entered in the entry field to the right.
To avoid very long settling times when the power is low, the averaging
factor can be limited with the "Timeout" parameter.

Remote command:

:SENSe<ch>[:POWer] : FILTer : TYPE on page 283

:SENSe<ch>[:POWer] : FILTer : LENGth:AUTO? on page 281

:SENSe<ch>[:POWer] :FILTer: LENGth[:USER] on page 281

:SENSe<ch>[:POWer] : FILTer : NSRatio on page 282

:SENSe<ch>[:POWer] : FILTer:NSRatio:MTIMe on page 282

|
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Use SParameter - Power Sensors < Filter Length - Power Sensors
Activates the use of the S-Parameter correction data of the connected power sensor. For
sensors with attenuator this checkbox is automatically checked.

Refer to the manual of the connected R&S NRP-Zxx power sensor for a description on
how to use the SParameter table.

Remote command:
:SENSe<ch>[:POWer] : CORRection:SPDevice: STATe on page 280

Enable Logging
Activates recording of R&S NRP-Z power sensor readings.

If enabled, every value measured by a connected power sensor and indicated in the user
interface, is written to a log file. Per measurement the function logs the measured value
(2 readings when you work with peak sensors), the sensor type and the measurement
time (time stamp).

The function automatically creates the file name SensLog<n>. txt and stores the file
in xtxt format under /var/user/SensorLogging on the hard disk. You can enable
logging for each connected sensor separately. If enabled, one file per sensor is written.

Note: This specific function is intended for measurements with long time intervals, or if
there is a risk that the connection to the sensor can be interupted and you need the data
for reconstruction.

The simplified recording function continuously writes the values in the file of the corre-
sponding sensor number, like Sens1Log. txt. When you start a new measurement, the
existing data will not be overwritten, but added to the file.

If you use this function, it is recommended that you regularly remove the files from the
hard disk, since they require storage capacity.

Remote command:
:SENSe<ch>[:POWer] : LOGGing: STATe on page 284

RF Sweep and List Mode

Overview

The R&S Signal Generator offers three different sweep types (frequency sweep, level
sweep and LF sweep) to be activated alternatively. Each type has 6 modes which differ
with respect to the sweep cycle mode (continuous, individual and step-by-step) and trig-
gering mode (automatic, internal and external).

e Sweeps and list mode can not be activated simultaneously, they deactivate each
other.

e Activating a sweep mode instantly disables NRP-Z Level Control.
A running sweep mode blocks "NRP-Z Level Control". It can not be activated

|
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Setting a sweep

A sweep is set in five basic steps which are shown below taking a frequency sweep as
an example.

@ The LF sweep is activated and configured in the "Mod Gen" block.

1. Set the sweep range ("Start Freq" and "Stop Freq" or "Center Freq" and "Span").
Select linear or logarithmic sweep spacing ("Spacing").

Set the step width ("Step Lin/Log") and dwell time ("Dwell Time").

Activate the sweep ("Mode" to Auto, Single, Step or Extern Single, Extern Step).

o &~ wDn

Trigger the sweep, except for Auto mode ("Execute Single Sweep", Current Fre-
quency or External Trigger Signal).

It is recommended to switch off the GUI update for optimum sweep performance espe-
cially with short dwell times (see chapter 5.2.3.5, "Gui Update", on page 86).

5.3.7.2 RF Frequency Sweep

The dialog is used to activate and configure a sweep for the RF frequency.

To open the "Frequency Sweep" menu, select "RF > Configure > RF Frequency
Sweep" or use the menu tree of the MENU key under "RF".

In the top section of the menu, the RF sweep is activated and the sweep mode is selected.

The buttons are used to reset the RF sweep (all sweep modes) or to execute the RF
sweep ("Single" mode).

The sweep range, sweep spacing and dwell time are set in the bottom section.

For the frequency sweep, an output signal at the LF connector can be activated. It pro-
vides a linear voltage ramp from start to stop of the sweep. The output voltage can be
used e.g. to control an oscilloscope.

The sweep range of the RF sweep can be entered in two ways, either by entering the
"Start" and "Stop" value or by entering the "Center" and "Span".

The two sets of parameters influence each other in the following way:

e "Start Freq" = "Center Freq" - "Span"/2

e "Stop Freq" = "Center Freq" + "Span"/2

e "Center Freq" = ("Start Freq" + STOP FREQ)/2

e "Span"="Stop Freq" - "Start Freq"
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= .
Made Extern Start/Stop =
Reset Sweep

Start Freq 100.000 000 000 |MHz =
Stop Freg 500.000 000 000 [MHz =
Center Freq 300.000 000 000 [MHz =

Span lmm
Current Freq Wm
Spacing m
Shape lm
Step Lin Imm
Dwell Time [oafms <]

Use LF connector to output sweep voltage ™ On

Qutput Voltage Start Freg omv =
Qutput Voltage Stop Freq 3000 =

Ext Trigger Input Slope Positive -

RF Frequency Sweep Settings

State - Frequency Sweep
Activates/deactivates RF sweep mode.

Note:
Activating a sweep mode automatically deactivates other sweeps and the list mode.

Remote command:
[ : SOURce<hw>] : FREQuency : MODE on page 306

Mode - Frequency Sweep
Selects the sweep instrument operating mode and the sweep mode.

If you change the sweep mode during the execution, the signal generator stops the sweep
and starts with the next trigger event at the initial value.

The "Reset Sweep" button sets the sweep to the start value.

"Auto" Sets an automatic repeated sweep cycle.

Example:
SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR AUTO
SOUR: FREQ:MODE SWE

"Single" Sets a single sweep cycle. The sweep is triggered by the "Execute Sin-
gle Sweep" button, or by means remote trigger commands, e.g. *TRG.

Example:
SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR SING
SOUR:FREQ:MODE SWE
SOUR: SWE : FREQ: EXEC
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"Step” Sets a step-by-step sweep cycle.
When mode "Step" is activated, the frequency is set to the sweep "Start
Freq".

To step through the sweep frequencies manually, open the "Current
Freq" field for input and use the UP / DOWN navigation keys or the
rotary knob.

You can determine the step width below in the entry field "Step Lin" or
"Step Log", see Step Lin/Log - Frequency Sweep.

If a sweep range border frequency ("Start Freq" or "Stop Freq") is
reached, step commands in direction out of the sweep range are
ignored.

Note: To step through the sweep frequencies in remote control mode,
use the FREQ :MAN command with the UP or DOWN parameter.

Example:

SOUR:FREQ:CENT 300MHz

SOUR:FREQ:SPAN 400MHz
SOUR: SWE: FREQ: SPAC LIN

SOUR:SWE: FREQ:STEP:LIN 100MHz
SOUR:FREQ:MODE MAN

set sweep mode "Step".

SOUR:FREQ:MODE SW

activate sweep mode, the frequency is set to "Start Freq".
SOUR:FREQ:MAN UP

set the frequency to the next higher sweep frequency.
SOUR:FREQ:MAN DOWN

set the frequency to the next lower sweep frequency.

"Extern Single" Sets a single sweep cycle. The sweep is triggered by an external trigger
signal.
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input (see chapter 2.2, "Rear Panel
Tour", on page 21).

Example:

SOUR: SWE: FREQ:MODE AUTO
TRIG:FSW:SOUR EXT
SOUR:FREQ:MODE SWE (External trigger)
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"Extern Step"  Sets a step-by-step sweep cycle. Each sweep step is triggered by an
external trigger signal (trigger source as described under "Extern Sin-
gle"). The step width is set below at entry field "Step Lin" or "Step
Log".

Example:

SOUR: SWE: FREQ:MODE STEP
SOUR: SWE: FREQ: SPAC LIN

SOUR: SWE:FREQ: STEP:LIN 1MHz
TRIG:FSW:SOUR EXT
SOUR:FREQ:MODE SWE (External trigger)

"Extern Start/  Sets an automatically repeated sweep cycle that is started, stopped and
Stop" restartet by subsequent external trigger events.
The first external trigger signal starts the sweep (Start).
The next external trigger signal stops the sweep at the current fre-
quency (Stop).
The third external trigger signal starts the sweep at the start frequency
(Start).
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input (see chapter 2.2, "Rear Panel
Tour", on page 21).

Example:

SOUR: SWE : FREQ:MODE AUTO
TRIG:FSW:SOUR EAUT

SOUR: FREQ:MODE SWE (External trigger)

Remote command:

[ :SOURce<hw>] : SWEep [ : FREQuency] : MODE on page 379
:TRIGger<hw>:FSWeep: SOURce on page 406

[ : SOURce<hw>] : FREQuency : MODE on page 306

Execute Single Sweep - Frequency Sweep

Triggers the sweep manually. A manual sweep can only be triggered if "Mode Single" is
selected.

Remote command:

[ :SOURce<hw>] : SWEep [ : FREQuency] : EXECute on page 378
:TRIGger<hw>:FSWeep [ :IMMediate] on page 407

:TRIGger<hw>[:SWEep] [ : IMMediate] on page 411

Reset Sweep - Frequency Sweep
Resets the sweep. The start frequency is set and the next sweep starts from there.

Remote command:
[ : SOURce<hw>] : SWEep:RESet [ :ALL] on page 387
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Start Freq - Frequency Sweep
Sets the start frequency.

Remote command:
[ :SOURce<hw>] : FREQuency: STARt on page 307

Stop Freq - Frequency Sweep
Sets the stop frequency.

Remote command:
[ :SOURce<hw>] : FREQuency: STOP on page 308

Center Freq - Frequency Sweep
Sets the center frequency.

Remote command:
[ : SOURce<hw>] : FREQuency : CENTer on page 303

Span - Frequency Sweep
Sets the span.

Remote command:
[ : SOURce<hw>] : FREQuency : SPAN on page 307

Current Freq - Frequency Sweep
Displays the current frequency.
If "Step" is set, the frequency for the next frequency step of the sweep is entered here.

Remote command:
[ : SOURce<hw>] : FREQuency :MANual on page 305

Spacing - Frequency Sweep
Selects linear or logarithmic sweep spacing.

"Linear" With the linear sweep, the step width is a fixed frequency value which
is added to the current frequency. The step width is entered below.

"Logarithmic"  With the logarithmic sweep, the step width is a constant fraction of the
current frequency. This fraction is added to the current frequency. The
logarithmic step width is entered below in %.

Remote command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : SPACing on page 382

Shape - RF Frequency Sweep
Selects the cycle mode for a sweep sequence (shape).

Operating Manual 1407.0806.32 — 13 152



R&S®SMB100A Instrument Function

RF Block

"Sawtooth" One sweep runs from start to stop frequency. Each subsequent sweep
starts at the start frequency, i.e. the shape of the sweep sequence
resembles a sawtooth.

"Triangle" One sweep runs from start to stop frequency and back, i.e. the shape
of the sweep resembles a triangle. Each subsequent sweep starts at
the start frequency.

Remote command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : SHAPe on page 382

Step Lin/Log - Frequency Sweep
Sets the step width for the individual sweep steps. This entry is effective for all sweep
modes.

"Step Lin" or "Step Log" is displayed depending on whether "Spacing Lin" or "Log" is

selected.

"Step Lin" With the linear sweep, the step width is a fixed frequency value which
is added to the current frequency. The linear step width is entered
in Hz.

Remote command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : STEP [ : LINear] on page 383

"Step Log" With the logarithmic sweep, the step width is a constant fraction of the
current frequency. The logarithmic step width is entered in %.
Successive frequencies are calculated as follows:

o start_f <stop_f

f2=11*(1+ step_log/ 100)

If f2 > stop_f: 2 is set to stop_f.
o start_f > stop_f

f2=11/(1+ step_log/ 100)

If f2 < stop_f: 2 is set to stop_f.
When the shape "Triangle" is set, the frequency values on the slope
from stop_f back to start_f are the same as on the slope from start_f
to stop_f.

Remote command:
[ :SOURce<hw>] :SWEep [ : FREQuency] : STEP: LOGarithmic on page 384

Operating Manual 1407.0806.32 — 13 153



R&S®SMB100A Instrument Function

RF Block

Dwell Time - Frequency Sweep
Sets the dwell time. The dwell time determines the duration of the individual sweep steps.
3
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The "Dwell Time" set by the user is used as the step time of the sweep. The effective net
dwell time is shorter, reduced by the setting time. This setting time may be greater than
the time specified in the data sheet.

Note:

It is recommended to switch off the GUI update for optimum sweep performance espe-
cially with short dwell times (see chapter 5.2.3.5, "Gui Update", on page 86).

Remote command:

[ :SOURce<hw>] : SWEep [ : FREQuency] : DWEL1 on page 378

Use LF connector to output sweep voltage - RF Frequency Sweep

Activates the output of a linear voltage ramp from sweep start to sweep stop at the LF
connector. This signal can be used for the X-deflection of an oscilloscope. The voltage
range is determined below.

Remote command:
[ : SOURce<hw>] : SWEep [ : FREQuency] : LFConnector on page 379

Output Voltage Start Freq - RF Frequency Sweep
Sets the voltage at the sweep start frequency.

Remote command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : OVOLtage : STARt on page 380

Output Voltage Stop - RF Frequency Sweep
Sets the voltage at the sweep stop frequency..

Remote command:
[ :SOURce<hw>] : SWEep [ : FREQuency] : OVOLtage: STOP on page 381

Trigger Input Slope
Sets the polarity of the active slope of an applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" The rising edge of the trigger signal is active.
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"Negative" The falling edge of the trigger signal is active.

Remote command:
[:SOURce] : INPut: TRIGger : SLOPe on page 310

RF Level Sweep

To open the "Level Sweep" menu, select "RF > Configure > Level Sweep" or use the
MENU key under "RF".

RF Level Sweep Settings

In the top section, the RF level sweep is activated and the sweep mode is selected. The
buttons are used to reset the level sweep (all sweep modes) or to execute the level sweep
("Single" mode).

The sweep range, sweep spacing and dwell time are set in the bottom section.

State - Level Sweep
Activates Level Sweep mode.

Note:
Activating a sweep mode automatically deactivates other sweeps and the list mode.

Remote command:
[ : SOURce<hw>] : POWer :MODE on page 345

Mode - Level Sweep
Selects the level sweep instrument operating mode and the sweep mode.

If you change the sweep mode during the execution, the signal generator stops the sweep
and starts with the next trigger event at the initial value.

The "Reset Sweep" button sets the sweep to the start value.

|
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"Extern Single"
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Sets an automatically repeated sweep cycle.

Example:

SOUR: SWE : POW:MODE AUTO
TRIG:PSW:SOUR AUTO
SOUR: POW:MODE SWE

Sets a single sweep cycle. The sweep is triggered by the "Execute Sin-
gle Sweep" button, or by means remote trigger commands, e.g. *TRG.

Example:

SOUR: SWE : POW: MODE AUTO

TRIG:PSW:SOUR SING

SOUR: POW:MODE SWE

SOUR: SWE : POW: EXEC

Sets a step-by-step sweep cycle.

If this mode is activated, the cursor moves to the value displayed for
"Current Level". Each sweep step is triggered by a variation of the value
in the "Current Level" entry window. The step width is set below at entry
field "Step".

If this mode is activated, the cursor moves to the value displayed for
"Current Level". If a different sweep mode was activated prior to the

"Step" mode, the current sweep is stopped. The step sweep starts at
the current level value.

Example:

SOUR: SWE : POW: MODE MAN

SOUR: SWE : POW: STEP 0.5

SOUR: POW:MODE SWE

SOUR:POW:MAN -16

The value entered with command SOUR: SWE : POW: STEP sets the step
width.

The value entered with command SOUR: POW : MAN has no effect, the
command only triggers the next sweep step. However, the value has to
be in the currently set sweep range (start to stop). In remote control only
a step-by-step sweep from start to stop frequency is possible.

Sets a single sweep cycle. The sweep is triggered by an external trigger
signal.

Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input (see chapter 2.2, "Rear Panel
Tour", on page 21).

Example:

SOUR: SWE : POW:MODE AUTO
TRIG:PSW:SOUR EXT

SOUR: POW:MODE SWE (External trigger)

|
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"Extern Step"  Sets a step-by-step sweep cycle. Each sweep step is triggered by an
external trigger signal (trigger source as described under "Extern Sin-
gle"). The step width corresponds to the step width of the rotary knob.

Example:

SOUR: SWE : POW:MODE STEP
SOUR:SWE:POW:STEP 0.5
TRIG:PSW:SOUR EXT

SOUR: POW:MODE SWE (External trigger)

"Extern Start/  Sets an automatically repeated sweep cycle that is started, stopped and
Stop" restartet by subsequent external trigger events.
The first external trigger signal starts the sweep (Start).
The next external trigger signal stops the sweep at the current fre-
quency (Stop).
The third external trigger signal starts the sweep at the start frequency
(Start).
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input (see section "Legend for Rear
Panel View").

Example:
SOUR: SWE : POW: MODE AUTO
TRIG:PSW:SOUR EAUT
SOUR: POW:MODE SWE (External trigger)
Remote command:
[ :SOURce<hw>] : SWEep: POWer : MODE on page 385
: TRIGger<hw>:PSWeep: SOURce on page 409.
[ : SOURce<hw>] : POWer :MODE on page 345

Reset Sweep - Level Sweep
Resets the sweep. The start level is set and the next sweep starts from there.

Remote command:
[ :SOURce<hw>] : SWEep:RESet [ :ALL] on page 387

Execute Single Sweep - Level Sweep
Triggers the sweep manually. A manual sweep can only be triggered if "Mode Single" is
selected.

|
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Example:
SOUR: SWE : POW: MODE AUTO
TRIG:PSW:SOUR SING
SOUR: POW:MODE SWE
SOUR: SWE : EXEC

Remote command:

[ :SOURce<hw>] : SWEep: POWer : EXECute on page 385
:TRIGger<hw>:PSWeep [ : IMMediate] on page 409
:TRIGger<hw>[:SWEep] [ : IMMediate] on page 411

Start Level - Level Sweep
Sets the start level.

Remote command:
[ :SOURce<hw>] : POWer: STARt on page 347

Stop Level - Level Sweep
Sets the stop level.

Remote command:
[ : SOURce<hw>] : POWer : STOP on page 349

Current Level - Level Sweep
Displays the current level.

If "Step" is set, the level for the next level step of the sweep is entered here.

Remote command:
[ :SOURce<hw>] : POWer :MANual on page 344

Shape - RF Level Sweep
Selects the cycle mode for a sweep sequence (shape).

"Sawtooth" One sweep runs from the start level to the stop level. The subsequent
sweep starts at the start level again, i.e. the shape of sweep sequence
resembles a sawtooth.

"Triangle" One sweep runs from start to stop level and back, i.e. the shape of the
sweep resembles a triangle. Each subsequent sweep starts at the start
level again.

Remote command:
[ :SOURce<hw>] : SWEep: POWer : SHAPe on page 386

Step - Level Sweep
Sets the step width for the individual sweep steps. This entry is effective for all sweep
modes.

With the level sweep, the logarithmic step width is a constant fraction of the current level.
This fraction is added to the current level. The logarithmic step width is entered in dB.

Remote command:
[ :SOURce<hw>] : SWEep:POWer: STEP[:LOGarithmic] on page 387
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Dwell Time - Level Sweep
Enters the dwell time and determines the duration of the individual sweep steps.
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The "Dwell Time" set by the user is used as the step time of the sweep. The effective net
dwell time is shorter, reduced by the setting time. This setting time may be greater than
the time specified in the data sheet.

Note:
It is recommended to switch off the GUI update for optimum sweep performance espe-
cially with short dwell times (see chapter 5.2.3.5, "Gui Update", on page 86).

Remote command:
[ :SOURce<hw>] : SWEep:POWer : DWEL1 on page 384

Trigger Input Slope
Sets the polarity of the active slope of an applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" The rising edge of the trigger signal is active.
"Negative" The falling edge of the trigger signal is active.

Remote command:
[ :SOURce] : INPut : TRIGger : SLOPe on page 310

5.3.7.4 List Mode

Similar to a sweep, a series of previously defined frequency and level points is processed
in List mode. In contrast to a sweep, however, a list with freely selectable value pairs
(frequency and level) can be created. The value range for frequency and level covers the
entire configurable value range of the instrument.

e List mode and sweeps can not be activated simultaneously, they deactivate each
other.

e Activating the list mode instantly disables NRP-Z Level Control.
A running list mode blocks "NRP-Z Level Control". It can not be activated
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The lists can be created in the "List Editor". Each list is stored in its own file with the
predefined file extension * . 1sw. The name of the list file can be freely selected. The files
are loaded from the "Lists..." file manager. Externally created tables with pairs of fre-
quency and level values can be converted into List files using the import function. The
external files must have the file extension * . txt or *.csv. These file formats are pro-

vided e.g. by the Microsoft®Excel program. The separators for table columns and for
decimal floating-point numerals can be set. In addition, internally created List data can
be exported into ASCII files using the export function.

The necessary hardware settings are calculated the first time a list is processed. With
long dwell times, this calculation can be performed while the list is being processed; the
entered dwell times are observed. With very short dwell times, calculation of the hardware
settings increases the dwell time for the initial processing cycle; the entered value is only
observed from the second processing cycle onwards. In this case a message appears to
inform the user that there is a deviation between the current and set dwell times. No
further calculations are required after the first run through a list. The current dwell times
will definitely no longer deviate from the set dwell times.

The list is processed from the beginning to the end of the list (modes "Auto”, ("Exter-
nal") "Single", ("External") "Step").
List Mode Dialog

To open the "List Mode" menu, select "RF > Configure > List Mode" or use the MENU
key under "RF".

The menu is used to activate/deactivate the operating mode List, to create, select and
activate the lists, and to select the trigger mode and the dwell time.

General Settings

State - List Mode
Activates/deactivates the List mode. The currently selected list is processed.

In case of a new or modified list, the necessary hardware settings are automatically
determined on activation of the list mode. The data determined in this way is stored along
with the list and is available whenever the list is used again.

|
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This means that when activating the list mode, the system checks whether any hardware
settings are present. If so, the list is started immediately, but if not they are automatically
determined (the list is learnt).

A "Learn List Mode Data" button is available for deliberately activating list learning.

Note: Activating the list mode automatically deactivates all sweeps. During list mode the
frequency and level indications do not display the currently set values.

Remote command:
[ : SOURce<hw>] : FREQuency : MODE on page 306

Mode - List Mode
Selects the cycle mode of the List mode.

"Auto” Cycle from the beginning to the end of the list with automatic restart at
the beginning. If a different mode was activated prior to the Auto mode,
the cycle continues from the beginning of the list. The duration of a list
step is determined by the set dwell time.

Button "Reset" restarts the list at the starting point.

"Single" Single cycle from the beginning to the end of the list. If "Single" is
selected, the cycle is not started immediately. The "Execute Single"
button appears under the "Mode" line. The cycle is started with this
button. The duration of a list step is determined by the set dwell time.
Button "Reset" restarts the list at the starting point.

IHude | Single Lrl
Execute Single |

"Step" Manual, step-by-step processing of the list. Activating "Step" stops the
current list and the cursor moves to the value displayed for "Current
Index". It is now possible to scroll up and down in the list in discrete
steps by varying the index. The duration of a list step is determined by
the time between two index entries.
Button "Reset" restarts the list at the starting point.

ICurrent Index | 1] I

"Extern Single" Single cycle from the beginning to the end of the list as with "Single",
but started by an external trigger.
The external trigger signal is input at the BNC connector INST TRIG.
Button "Reset" restarts the list at the starting point.

"Extern Step"  Step-by-step cycle using the external trigger signal. Each trigger event
starts a single step. The duration of a list step is determined by the time
between two trigger events.

The external trigger signal is input at the BNC connector INST TRIG.
Button "Reset" restarts the list at the starting point.

Remote command:
[ :SOURce<hw>] : LIST:MODE on page 330
[ :SOURce<hw>] :LIST:TRIGger : SOURce on page 332
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Execute Single - List Mode

Triggers the list manually. This button is available only if mode "Single" is selected.
Remote command:

[ :SOURce<hw>] :LIST:TRIGger:EXECute on page 332

Reset - List Mode

Resets the list to the starting point.

Remote command:

[ :SOURce<hw>] : LIST:RESet on page 331

Dwell Time - List Mode
Enters the dwell time. The dwell time determines the duration of a list step in list operating

modes "Auto", "Single" and "Extern Single". In these modes a complete list is processed
either once or continuously.

In list operating modes "Step" and "Extern Step", the set dwell time does not affect signal
generation. In this case, the duration of a list step is determined by the time between two
(internal or external) trigger events.

.
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The "Dwell Time" set by the user is used as the step time of the list mode. The effective
net dwell time is shorter, reduced by the setting time. This setting time may be greater
than the time specified in the data sheet.

Remote command:

[ :SOURce<hw>] :LIST:DWELL on page 327

Current Index - List Mode

Sets the list index in "Step" mode.

Remote command:

[ :SOURce<hw>] :LIST:INDex on page 328

Learn List Mode Data... - List Mode

Starts the determination of the hardware setting for the selected list. The data determined
in this way is stored along with the list.

It may be necessary to deliberately activate list learning in the event of greatly altered
environmental conditions that require new hardware settings.
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If this is not done, a previously learned hardware setting will continue to be used when
list mode is switched on ("State = On"). If no setting is available, e.g. when the list is used
for the first time, learning is automatically activated.

Remote command:
[ :SOURce<hw>] : LIST:LEARn on page 330

List Mode Data... - List Mode
Calls the "File Select" menu for selecting and creating a list or the "File Manager".

Remote command:

[ :SOURce<hw>] :LIST:SELect on page 332

[ :SOURce<hw>] :LIST:DELete on page 322
[:SOURce<hw>] : LIST:DELete:ALL Oon page 322

Edit List Mode Data... - List Mode
Calls the editor for editing the selected list. A list consists of any number of frequency/
level value pairs. The currently selected list is displayed.

FrequencyHz Power/dBm |~
100 000.000 -140.00
100010.000 -140.00
100 020.000 -140.00
100 030.000 -140.00
100 040.000 -140.00
100 050.000 -140.00
100 060.000 -140.00
100 070.000 -140.00
100080.000 -140.00

wlo |~ ||| fw|m)a

gt | Eat | sae |

"Frequency / Enter the frequency of the frequency/power value pair.
HZII

Remote command:
[ :SOURce<hw>] : LIST:FREQuency on page 327

"Power /dBm"  Enter the level of the frequency/power value pair.

Remote command:
[ :SOURce<hw>] :LIST:POWer on page 331

"Goto" Selects row for editing.

Goto first
Goto last
t

If "Goto row" is selected, a window opens for entering the requested
row.

0K | Cancel |
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"Edit" Calls a selection of possible actions described below.

Insert Row
Insert Range...
Fill...

Delete Row
Delete Range...

"Insert Row" Inserts a new row before the marked row.

"Insert Range" Inserts new rows before the marked row. The number of rows to be
inserted can be defined in an entry window.

IRows to Insert | I
OK | Cancel |
"Fill...." Opens a sub menu for defining a set of list values to be automatically

entered in the List Mode table (see "Filling the List Mode Data auto-
matically" on page 166).

"Delete Row" Deletes the marked row.

"Delete Allows to delete any number of rows starting with the marked row. The
Range..." number of rows to be deleted can be defined in an entry window.
IRnws to Delete | | I
OK | Cancel |
"Save" The list is saved under its current name.

List Range In - List Mode

Defines an index range in the current list by setting the start and stop index. Only the
values in the selected index range are processed in List mode, all other list entries are
ignored.

Remote command:
[ :SOURce<hw>] :LIST:INDex:STARt on page 329
[ :SOURce<hw>] :LIST:INDex:STOP on page 329

Trigger Input Slope
Sets the polarity of the active slope of an applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" The rising edge of the trigger signal is active.

"Negative" The falling edge of the trigger signal is active.

Remote command:

[ :SOURce] : INPut: TRIGger : SLOPe on page 310
Import/Export

Lists can be imported from externally created files or exported into text or CSV-files. The
import/export settings are available after clicking the "Import/Export" button.
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Import/Export - List Mode
Expands the menu with the area for import and export of list mode files.

Externally edited Excel tables with frequency/level pairs can be imported as text or CSV-
files and used for list mode.

On the other hand, internally created list mode lists can be exported as text or CSV-files.

Mode - List Mode
Selects if list mode lists should be imported or exported. The settings offered below
depend on the selected mode.

Remote command:
[ :SOURce<hw>] : LIST:DEXChange : MODE on page 326

Extension - List Mode
Selects the file extension of the ASCII file to be imported or exported. Selection TXT (text
file) or CSV (Excel file) is available.

Remote command:
[ : SOURce<hw>] : LIST:DEXChange:AFILe:EXTension on page 323

Decimal Point - List Mode
Selects the decimal separator used in the ASCII data between '.' (decimal point) and ',
(comma) with floating-point numerals.

Remote command:
[ :SOURce<hw>] : LIST:DEXChange:AFILe:SEParator:DECimal on page 325

Column Separator- List Mode
Selects the separator between the frequency and level column of the ASCII table.

Remote command:
[ :SOURce<hw>] :LIST:DEXChange:AFILe:SEParator:COLumn on page 324
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Select ASCII Source / Destination - List Mode
Calls the "File Manager" for selecting the ASCII file to be imported into a list mode list
(source) or the ASCII file the list mode list is exported (destination) in.

Remote command:
[ :SOURce<hw>] : LIST:DEXChange:AFILe:SELect on page 324

Select Destination / Source - List Mode
Calls the "File Manager" for selecting the list mode list to be exported (source) into an
ASCII file or the destination for the ASCII file to be imported (destination) in.

Remote command:
[ :SOURce<hw>] : LIST:DEXChange: SELect on page 326

Import / Export - List Mode
Starts the export or import of the selected file.

When import is selected, the ASCII file is imported as list mode list.
When export is selected, the list mode list is exported into the selected ASCII file.

Remote command:
[ :SOURce<hw>] : LIST:DEXChange:EXECute on page 325

Filling the List Mode Data automatically

The "Fill List Mode Data" menu enables you to automatically set the values in the List
Mode table.

The start line and the number of rows to be filled are defined under "From" and
"Range".

The column to be filled is selected under "Select column to fill". Depending on the selec-
tion here, the default for start, end, and increment value are set. As the settings are
interdependent, a change of one parameter may result in the automatic change of one
or more of the other parameters.

The filling of the column with the selected value settings is started with button "Fill".

The list entries are only computed when the "Fill" button is pressed.
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5.4.1

Modulation

From
Sets the start value of the index range.

Remote command:
n.a.

Range
Sets the range for filling the table.

Remote command:
n.a.

Select column to fill
Selects either the frequency or the level column to be filled with the value defined below.

Remote command:
n.a.

Start value
Sets the start value for the frequency or the level entries.

Remote command:
n.a.

End value
Sets the end value for the frequency or the level entries.

Remote command:
n.a.

Increment value
Sets the increment for the frequency or the level entries.

Remote command:
n.a.

Fill

Fills the selected column in the set range with values, starting with the start value and
using the set increment.

Remote command:

n.a.

Modulation

Overview of Modulation

The R&S SMB provides amplitude modulation (AM), frequency modulation (FM), phase
modulation (PM), pulse modulation and stereo modulation. In addition, the RF signal can
be modulated with internal modulations waveforms, e.g. sine waves and rectangular sig-
nals.
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5.4.1.2

Modulation

Amplitude, frequency and phase modulation are available for the basic unit (R&S SMB
+ frequency option R&S SMB-B10x) without additional equipment options. A standard LF
generator is provided for internal modulation. A Pulse Generator is provided by option
R&S SMB-K23. Option R&S SMB-K22, Pulse Modulation, is designed for instruments
equipped with frequency-options up to 6 GHz and R&S SMB-K21 for instruments with
high frequency options. Stereo modulation is available with option Stereo/RDS coder,
R&S SMB-B5.

Settings for the modulation are made in separate modulation menus. These menus can
be accessed in the block diagram by way of the "Modulation" function block, or by means
of the menu with the same name which is opened using the MENU key.

Enabling/Disabling Analog Modulations using the MOD On/Off Key
The MOD ON/OFF key switches the modulations on and off.

MOD ON/OFF
Press the MOD ON/OFF key to enable/disable analog modulations.

Pressing the key again restores the status that was active before the last switch-off. "MOD
OFF" is displayed in the info line of the header next to the "Level" field.

Remote command:
[ :SOURce<hw>] :MODulation[:ALL] [:STATe] on page 333

Modulation Sources

The following modulations use internal and external modulation sources:
e Amplitude modulation

e Pulse modulation

e Frequency modulation

Phase modulation

Internal Modulation Sources

An LF generator and a pulse generator are available as internal modulation sources for
a fully equipped instrument. The LF generator supplies sinusoidal or rectangular signals.

The optional pulse generator (option R&S SMB-K27) provides single and double pulse
modulation with selectable pulse widths and periods or a user-definable pulse train.

See also chapter 5.5.1, "Overview of LF Generator", on page 187.

External Modulation Sources

The modulation inputs MOD EXT and PULSE EXT at the rear of the instrument are pro-
vided as the external modulation source for amplitude, pulse, frequency and phase mod-
ulation.

The external audio signal for stereo modulation is input via the analog L and R inputs or
via the digital S/P DIF interface at the rear of the instrument.

|
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The external modulation signal at the input must have a voltage of Ug =1V (Uggr =0.707
V) in order to achieve the displayed modulation depth and range. The input voltage should
not exceed 1.1 Vs, otherwise modulation distortions might occur. With external pulse
modulation, the switching point is max. 2.4 V and the voltage at the input should not
exceed 5 V. The maximum modulation frequency is 10 MHz for frequency and phase
modulation.

Simultaneous Operation of Several Modulations or Other Operating Modes

The table shows the modulations and operating modes which can be activated simulta-
neously (+) or which deactivate each other (-).

AM FM PhiM Pulse
Amplitude modulation (AM) / + + (+)
Frequency modulation (FM) + / - +
Phase modulation (PhiM) + - / +
Pulse modulation (Pulse) R&S SMB-K22 (+) + + /

5.4.2 Amplitude Modulation (AM)
An internal and/or external source can be selected for amplitude modulation. The LF
modulation generator is available as the internal source.
Two-tone AM is possible by simultaneously switching on the external and internal source.

The MOD EXT input connector for external feed of analog modulation signals is at the
front of the instrument. The coupling mode of the input (AC or DC) can be selected.

The AM modulation depth is limited by the maximum peak envelope power (PEP).

Exponentional AM (Instruments with 12, 20, or 40 GHz frequency options)

Besides the linear amplitude modulation, whereby the signal voltage is proportional to
the modulation signal, instruments equipped with the frequency options (R&S SMB-
B112(L) /-B120(L) /-B140(L)) in addition provide a level-proportional power or amplitude
modulation.

In this case, the R&S SMB exponentially distorts the modulation signal, before it is output
atthe LF CONNECTOR - regardless of the AM Source Int, or Ext. The AM Depth is then
indicated in dB.

Signal Sources for Exponential AM

You can perform exponential AM using either the internal, or an external modulation
signal. However, in contrast to linear AM, the signal at the LF output connector is distorted
in any operating mode. AM Source Int+Ext is not available.

Operating Manual 1407.0806.32 — 13 169



R&S®SMB100A Instrument Function

Modulation

5.4.21 Amplitude Modulation Settings

Modulation

To open the "Amplitude Modulation" dialog, select "Modulation > Configure > Amplitude

| Modulation" or use the MENU key under "Modulation".

Pulse Madulation..

In the upper section of the dialog, the modulation source is selected and the modulation
switched on. The modulation source can be selected independently for the different
modulation types and the LF output.

The configuration of the selected external and/or internal modulation source is performed
in the lower section of the dialog or in the "LF Output" dialog (internal source only).

These settings affect all modulations which use the same modulation source.

E# amplitude Madulatio N [=] 5]

AM Source Ext -
AM Type Linear -
At Depth 0% hd

AM Source = EXTemnal
AN Sensitivity 30.0 % per volt|
Mod Ext Coupling AC -
Ext Impedance High -

State
Activates/deactivates AM modulation.

Remote command:
[ :SOURce<hw>] :AM: STATe on page 290

AM Source
Selects the source for the AM signal.
"Internal” Selects the internal LF generator as the source for AM modulation.
"External” Selects the external source.

The external signal is input via the MOD EXT connector.
"Intern + Selects the internal and external source at the same time, e.g. for per-
Extern” forming two-tone AM.

Note: This setting applies to linear AM, see "Exponentional AM (Instru-
ments with 12, 20, or 40 GHz frequency options)" on page 169.

Remote command:
[ : SOURce<hw>] : AM: SOURce on page 290

AM Type
Selects between linear or exponential (logarithmic) amplitude modulation, if you work with
an instrument that is equipped with a 12 GHz, or higher frequency option.

Remote command:
[ : SOURce<hw>] : AM: TYPE on page 291

AM Depth
Sets the modulation depth in percent.

Note: With two-tone modulation, observe that the set modulation depth is valid for both
signals and the sum modulation depth is determined by doubling the set modulation
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depth. This results in overmodulation if the maximal value for modulation depth is excee-
ded (see data sheet).

For instruments with frequency option 12 GHz or higher, you can additionally select AM
Type Exponential. In this case, the generator sets modulation depth in dB (logarithmic).

Modulation is possible both, upwards and downwards. Accordingly, the dynamic range
extends for instruments without attenuator from minimum to maximum level. For instru-
ments with attenuator, the dynamic range corresponds to the Fixed Range (PEP) In;
these are downwards about 20 dB, and upwards about 5 dB, i.e. in total about 25 dB
around the set level.

Effects of positive/negative modulation depth:
e AM Source Int

— positive depth -> downwards modulation

— negative depth -> upwards modulation
e AM Source Ext
positive depth and negative external voltage -> downwards modulation
positive depth and positive external voltage -> upwards modulation
negative depth and negative external voltage -> upwards modulation
negative depth and positive external voltage -> downwards modulation

Remote command:
[ : SOURce<hw>] : AM: DEPTh:L,INear on page 289
[ :SOURce<hw>] :AM: DEPTh:EXPonential on page 288

LF Gen Frequency
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

Remote command:
[ :SOURce] : LFOutput<ch>:FREQuency on page 311

LF Gen Shape
Selects the waveform shape of the LF signal.

LFGen Shape Sine :

Source Impedance
Sguare
Sawtooth

Note: The installed hardware determines the available settings. Use the Hardware Con-
fig dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[ :SOURce] : LFOutput : SHAPe on page 319

AM Sensitivity
(Source External only)

Displays the input sensitivity of the MOD EXT inputin % per Voltin AM Type Linear mode,
and dB/V for AM Type Exponential.
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The modulation depth entered under "AM Depth" is reached with 1 volt modulation of the
input.

Remote command:
[ :SOURce<hw>] :AM: SENSitivity? on page 290

AM External Coupling
(Source External only)

Selects the coupling mode (AC or DC) for external feed.

Note: Coupling for external feed via input MOD EXT is set for all modulations with external
source.

Remote command:
[ : SOURce<hw>] :AM:EXTernal : COUP1ing on page 289

External Input Impendance
(Source External only)

Selects the impedance for external feed via the EXT MOD input.
Selection 600 Ohm and high (>100 kOhm) is available.

Note: This setting affects all analog modulations which use the external modulation
source.

Remote command:
[ : SOURce<hw>] : INPut :MODext : IMPedance on page 310

5.4.3 Frequency Modulation (FM)

Aninternal and/or external source can be selected for frequency modulation. The LF GEN
modulation generator is available as the internal source. Two-tone FM is possible by
simultaneously switching on the external and internal source.

The MOD EXT input connectors for external feed of analog modulation signals are at the
front of the instrument. The coupling mode of the input (AC or DC) can be selected.
Selection between three modulation modes is possible:

e "Normal" mode with full setting range for modulation bandwidth and FM deviation.

e "Low Noise" mode with better signal/noise ratio, but reduced setting range for mod-
ulation bandwidth

e "High Deviation" mode with full setting range for FM deviation and a reduced setting
range for modulation bandwidth (see data sheet).

It is not possible to use frequency modulation simultaneously with phase modulation.
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Armplitude Modulation...
Frequency Modulation...

Pulse Madulation..

Modulation

Frequency Modulation Settings
To open the "Frequency Modulation" menu, select "Modulation > Configure > Frequency
Modulation" or use the MENU key under "Modulation".

In the upper section of the menu, the modulation source is selected and the modulation
is switched on. The modulation source can be selected independently for the different
modulation types and the LF output.

The configuration of the selected external and/or internal modulation source is performed
in the lower section of the menu (internal source only).

These settings affect all modulations which use the same modulation sources.

Frequency Modulation

State

FM Source IInt+Ex1 'I
FM Mode INUrmaI 'I
FIM Deviation I 1.000 0 IkHz vl

FIM Source = INTernal
LFGenFreq | 100000 |kHz ~|

LFGen Shape ISine vl

FM Source = EXTernal

Adjust FM Oﬁsetl
FIM Sensitivity I 500.00 HzMalt

Mod Ext Coupling  |AC -

Ext Impedance IHigh vl

State
Activates/deactivates FM modulation.

Activation of FM deactivates phase modulation.

Remote command:
[ : SOURce<hw>] :FM: STATe on page 302

FM Source
Selects the source for the FM signal.
"Internal” Selects the internal LF generator as the source for FM modulation.
"External" Selects the external source.

The external signal is input via the MOD EXT connector.
"Internal + Selects the internal and external source at the same time.
External" This setting enables two-tone FM modulation.

Remote command:
[ : SOURce<hw>] : FM: SOURce on page 302
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FM Mode
Selects the mode for the frequency modulation.
"Normal" The maximum range for modulation bandwidth and FM deviation is
available.
"Low Noise" Frequency modulation with phase noise and spurious characteristics

close to CW mode. The range for modulation bandwidth and FM devi-
ation is reduced (see data sheet).

"High Devia- Frequency modulation with full setting range for FM deviation. The
tion" range for modulation bandwidth is reduced (see data sheet).

Remote command:
[ : SOURce<hw>] : FM: MODE on page 301

FM Deviation
Sets the modulation deviation in Hz.

The maximal deviation depends on the RF frequency set and the selected modulation

mode (see data sheet). It is possible to enter a deviation that is too high for a certain RF
frequency or to vary the RF frequency to a range in which the deviation can no longer be
set. In this case the maximally possible deviation is set and an error message is displayed.

The deviation of the internal source must not exceed the deviation of the external source
in case of modulation source "Int+Ext".

Remote command:
[ :SOURce<hw>] :FM[:DEViation] on page 300

LF Gen Frequency
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

Remote command:
[:SOURce] : LFOutput<ch>:FREQuency on page 311

LF Gen Shape
Selects the waveform shape of the LF signal.

LFGen Shape Sine :

Source Impedance
Sguare
Sawtooth

Note: The installed hardware determines the available settings. Use the Hardware Con-
fig dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[ :SOURce] : LFOutput: SHAPe on page 319

FM Sensitivity
(Source External only)

Displays the input sensitivity of the MOD EXT input in Hz/V.
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The modulation depth entered under "FM Depth" is reached with 1 Volt (= U,) of the
input signal.

Note: The input voltage should not exceed 1.1V, otherwise modulation distortions might
occeur.

Remote command:
[:SOURce<hw>] : FM: SENSitivity? on page 302

Adjust FM Offset
Starts the adjustment for the FM/PhiM modulator. The option is adjusted with respect to
DC-offset.

Remote command:
:CALibration<hw>:FMOFfset [:MEASure] ? on page 250

FM External Coupling
(Source External only)

Selects the coupling mode (AC or DC) for external feed.

Note: Coupling for external feed via input MOD EXT is set for all modulations with external
source.

"AC" The d.c. voltage content is separated from the modulation signal.
"DC" The modulation signal is not altered.

Remote command:
[ :SOURce<hw>] : FM:EXTernal :COUP11ing on page 300

External Input Impendance
(Source External only)

Selects the impedance for external feed via the EXT MOD input.
Selection 600 Ohm and high (>100 kOhm) is available.

Note: This setting affects all analog modulations which use the external modulation
source.

Remote command:
[ : SOURce<hw>] : INPut :MODext : IMPedance on page 310

Phase Modulation (PhiM)

It is not possible to use phase modulation simultaneously with frequency modulation.

An internal and/or external source can be selected for phase modulation. The LF GEN
modulation generator is available as the internal source.

The MOD EXT input connector for external feed of analog modulation signals is at the
front of the instrument. The coupling mode of the input (AC or DC) and the impedance
can be selected.

|
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Selection between the following modulation modes is possible:
e "Normal" mode with full setting range for modulation bandwidth and PhiM deviation.

e "Low Phase" mode with better signal/noise ratio, but reduced setting range for mod-
ulation bandwidth and deviation (see data sheet)

e "High Deviation" mode with full setting range for PhiM deviation and a reduced setting
range for modulation bandwidth. Phase noise is reduced in the lower modulation
frequency range compared to the default mode.

5.4.41 Phase Modulation Menu

Modulation

e mewaien. | 1O Open the "Phase Modulation" menu, select "Modulation > Configure > Phase Modu-
el |ation" or use the MENU key under "Modulation".

Pulse Modulation...

EIE3
State

PhiM Source IInt+Ex1 v|

Phil Mode [Normal =
Phil Deviation | 1.000 00 Irad =
PhiM Source = INTernal
LFGenFreq [ 1.00000fkHz  ~|

LFGen Shape ISine v|

PhiM Source = EXTernal

PhiM Sensitivity I 0.500 000 rad per Volt

Mod Ext Coupling AC hd

Ext Impedance IHigh v|

In the upper section of the menu, the modulation source is selected and the modulation
switched on. The modulation source can be selected independently for the different
modulation types and the LF output.

The configuration of the selected external and/or internal modulation source is performed
in the lower section of the menu (internal source only).

These settings affect all modulations which use the same modulation sources.

An LF generator and a pulse generator are available as internal sources.

State
Activates/deactivates PhiM modulation.

Activation of PhiM deactivates frequency modulation.

Remote command:
[ : SOURce<hw>] : PM: STATe on page 338

PhiM Source
Selects the source for the PhiM signal.

"Internal” Selects the internal LF generator as the source for PhiM modulation.

|
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"External” Selects the external source.

The external signal is input via the MOD EXT connector.
"Internal + Selects the internal and external source at the same time.
External" The external signal is input via the MOD EXT connector.
Remote command:
[ : SOURce<hw>] : PM: SOURce on page 338
PhiM Mode
Selects the mode for the phase modulation.
"Normal" The full range for modulation bandwidth and PM deviation is available.
"High Devia- The maximum range for PhiM deviation is available. Phase noise is
tion" improved for low frequencies compared to the default mode. The range

for modulation frequency is limited (see data sheet).
This mode is recommended for low modulation frequencies and/or high
PhiM deviation.

"Low Noise" Phase modulation with phase noise and spurious characteristics close
to CW mode. The range for modulation bandwidth and PM deviation is
reduced (see data sheet).

Remote command:
[ : SOURce<hw>] : PM: MODE on page 337

PhiM Deviation
Sets the modulation depth in RAD.

The maximal deviation depends on the RF frequency set and the selected modulation

mode (see data sheet). It is possible to enter a deviation that is too high for a certain RF
frequency or to vary the RF frequency to a range in which the deviation can no longer be
set. In this case the maximally possible deviation is set and an error message is displayed.

Remote command:
[ :SOURce<hw>] :PM[:DEViation] on page 335

LF Gen Frequency
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

Remote command:
[:SOURce] : LEFOutput<ch>:FREQuency on page 311

LF Gen Shape
Selects the waveform shape of the LF signal.

LFGen Shape Sine :

Source Impedance
Square
Sawtooth

Note: The installed hardware determines the available settings. Use the Hardware Con-
fig dialog to check the hardware the instrument is equipped with.
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For information on the required hardware revision, refer to the release notes.

Remote command:
[ :SOURce] : LFOutput : SHAPe on page 319

PhiM Sensitivity
(Source External only)

Displays the input sensitivity of the MOD EXT input in RAD/V.

The modulation depth entered under "PhiM Depth" is reached with 1 volt (=U,.4) of the
input signal.

Note: The input voltage should not exceed 1.1V, otherwise modulation distortions might
occur.

Remote command:
[ :SOURce<hw>] :PM: SENSitivity? on page 337

Mod External Coupling
Selects the coupling mode (AC OR DC) for external feed.

Note: Coupling for external feed via input MOD EXT is set for all modulations with external
source.

"AC" The DC voltage content is separated from the modulation signal.
"DC" The modulation signal is not altered.

Remote command:
[ :SOURce<hw>] : PM:EXTernal :COUP1ling on page 336

External Input Impendance
(Source External only)

Selects the impedance for external feed via the EXT MOD input.
Selection 600 Ohm and high (>100 kOhm) is available.

Note: This setting affects all analog modulations which use the external modulation
source.

Remote command:
[ :SOURce<hw>] : INPut :MODext : IMPedance on page 310

Pulse Modulation (PM)

The equipment layout for generating the pulse modulation signals includes:
e option Pulse Modulator (R&S SMB-K22)

e option Pulse Generator (R&S SMB-K23) , comprises "Single" and "Double" pulse
generation

e option Pulse Train (R&S SMB-K27), enables generation of pulse trains.
An internal or external source can be selected for pulse modulation. In case of external

source, the external signal is input via the PULSE EXT connector at the rear of the instru-
ment. In case of internal source, this connector can be used as external trigger or gate
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signal input for internal pulse modulation. The polarity and input impedance of the con-
nector can be selected.

The pulse signal is output at the PULSE VIDEO connector at the rear of the instrument.

Automatic Level Control is deactivated with pulse modulation!

When pulse modulation is activated, the ALC state of the R&S SMB is automatically
changed to "ALC OFF" ("Sample & Hold"). In this state, the ALC loop is opened and the
output level is not regulated but the level modulator is set directly. In order to set the
correct output level, a sample & hold measurement is executed after each frequency or
level setting.

The level is decreased by 30 dB during "Sample&Hold" measurement.

5.4.5.1 Pulse Modulation Settings

Modulation

| 10 Open the "Pulse Modulation" menu, select "Modulation > Configure > Pulse Modula-
el tion" or use the MENU key under "Mod".

Pulse Modulation

In the upper section of the menu, the modulation source is selected and the modulation
switched on. The configuration of the selected external and/or internal modulation source
is performed in the lower section of the menu.

The menu varies according to the selected modulation source.

& Pulse Modulation 10l =|
|State ﬁ
Source IPuIse Generatar vl

Fulse Generatar

Fulse Mode lm
Fulse Period IWIE,
Pulse Width [ zoofes <]
Fulse Delay I—DMIE,

ConnectorTrigger Settings

Trigger Mode IExtTriggered vl
Ext Trigger Input Slope IPositive vl
External Impedance ISD ] vl

Use SIGHNALVALID as Pulse Syne ¥ on

In case of modulation source pulse generator, the settings for the pulse characteristics
and the trigger are offered in the "Pulse Generator" section of the "Pulse Modulation"
dialog. Option R&S SMB-K23 offers extended features, e.g. generation of double pulse
or selection of trigger mode. For description of the pulse generator dialog, see chap-
ter 5.5.4, "Pulse Generator", on page 194.

Additionally, you can use the internally generated Valid Signal for synchronizsation of the
pulse modulation, and assign this signal to the VALID SIGNAL connector. See also
chapter 5.5.4, "Pulse Generator", on page 194 for description.
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Option R&S SMB-K27 enables the generation of pulse trains. For description of the pulse
train dialog, see chapter 5.5.4.2, "Pulse Train Generation", on page 197.

State
Activates/deactivates pulse modulation.

When the internal modulation source (pulse generator) is selected, the pulse generator
is switched on automatically and the video/sync signal is output at the PULSE VIDEO
output at the rear of the instrument. Signal output can be switched off in the "Pulse Gen-
erator" dialog (see chapter 5.5.4, "Pulse Generator", on page 194).

Remote command:
[ : SOURce<hw>] : PULM: STATe on page 354

Source
Selects the source for the pulse modulation signal.

"Pulse Genera- Selects the Pulse Generator as modulation source.

tor" The internally generated reactangular signal is used for the pulse mod-
ulation.
"External" Selects the external source.

The external modulation signal is input via the PULSE EXT connector.

Remote command:
[ : SOURce<hw>] : PULM: SOURce on page 353

Polarity
(External Source only)

Selects the polarity of the modulation signal.
"Normal" The RF signal is On while the level is high at the modulation input.
"Inverse" The RF level is Off if the level is high at the modulation input.

Remote command:
[ :SOURce<hw>] : PULM: POLarity on page 353

5.4.6 Stereo Modulation

Options R&S SMB-B5, Stereo/RDS Coder enables generation of stereo-modulated RF
signals according to standard. Beside the MPX (FM stereo multiplex) signal, also the
radio traffic service ARI (Automotive Radio Information) and Radio Data System (RDS)
are supported by the option.

An internal or external source can be selected for the audio signal of the stereo modu-
lation. In case of external source, the external signal is input via the analog L and R inputs
or via the digital S/P DIF interface at the rear of the instrument. In case of internal source,
the LF generator is used. Measurements can be performed in the operating modes L and
R,and L = R, L =-R and R!=L (ext. signals only).

A typical setup with the R&S SMB with the option Stereo/RDS Coder in connection with
the Audio Analyzer UPV is shown in the following graph.
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5.4.6.1 Stereo Modulation Dialog

To open the "Stereo Modulation" dialog, select "Modulation > Configure > Stereo Mod-
ulation" or use the MENU key under "Modulation".

In the upper section of the menu, the stereo modulation is configured and switched on.
The configuration and activation of the additional pilot tone, ARl and RDS settings is
performed in the lower section of the dialog.
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FII Deviation I 40.000 IkHz -
Audio Source IExtLR -
Made ||'.'|DnD Left -
Ext R L Impedance IﬂDD kOhm -
Preemphasis ISD ys -
Max Modulation Freq I 1.000 IkHz -
Stereo Pilot Tone Seftings
Pilot State
Pilot Deviation 5.750 IkHz 'l
Filot Phase 0.0 Ideg 'l
AR Setting
ARI State Qff
ARI Deviation 3.500 IKHZ 'l
ARI Identification Off 'l
ARI BK & -l
RDS Settings
RDS State _
RDS Deviation 2.000 IKHZ 'l
RDS Data Set Ds1 'l
Program Service Mame
Pragram Identification
Traffic Program _
Traffic Announcement _
Stereo Coder:
AdjustmentData IFEICIOFY 'l
General Settings
State - Stereo Modulation
Activates/deactivates stereo modulation.
Remote command:
[:SOURce] : STEReo : STATe on page 376
FM Deviation - Stereo Modulation
Sets the MPX (Multiplex stereo signal) deviation.
Remote command:
[:SOURce] : STEReo [ : DEViation] on page 377
Audio Source - Stereo Modulation
Selects the source for the audio signal.
"Off" No audio signal is provided, ARI and RDS signal can be generated
separately.
"Ext L,R" The external audio stereo signal is feed in via the analog L and R inputs.
"Ext S/P Diff" The external audio signal is feed in via the digital S/P DIF input.
"LF Gen" The audio stereo signal is internally generated by the LF generator.

Remote command:
[ :SOURce] : STEReo: SOURce on page 376
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Mode - Stereo Modulation

Selects the mode for the audio signal. If the internal LF generator is selected as audio
source, the signal is generated according to the selection here. For external signals, the
signal type has to be entered.

"Mono Left" A mono signal containing the left channel is generated/fed in.
"Mono Right" A mono signal containing the right channel is generated/fed in.

"Stereo R=L" A stereo signal with right and left channel is generated/fed in. The
channels have the same frequency and phase.

"Stereo R=-L"  The signal on the left external audio input is used for both channels, left
and right. The right channel is inverted.

"Stereo RI=L"  (External source only)
A stereo signal containing different, independent right and left channels
is fed in. It is possible, for example, to feed a fixed audio frequency to
the first channel while a frequency sweep is being performed in the
second channel.

Remote command:
[:SOURce] : STEReo : AUDio :MODE on page 370

LF Gen Freq - Stereo Modulation
(Audio source "LF Gen" only)

Sets the frequency of the LF generator signal.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

Remote command:

(two alias commands are available)

[ :SOURce] : STEReo: AUDio [ : FREQuency] on page 372
[:SOURce] : LFOutput<ch>:FREQuency on page 311

LF Gen Shape - Stereo Modulation
(Audio source "LF Gen" only)

Selects the shape of the LF generator signal.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

Remote command:
[ :SOURce] : LFOutput : SHAPe on page 319

External R/L Impedance - Stereo Modulation
(External analog audio signal input only)

Selects the input impedance for the external analog audio signal inputs L and R.

Remote command:
[:SOURce] : STEReo:EXTernal : IMPedance on page 373

|
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Preemphasis - Stereo Modulation
Activates and sets the pre-emphasis used for signal generation.

Remote command:
[:SOURce] : STEReo:AUDio: PREemphasis: STATe on page 372
[:SOURce] : STEReo: AUDio: PREemphasis on page 371

Max Modulation Freq- Stereo Modulation
Sets the maximum modulation frequency that may be used.

This parameter is valid/required only when pre-emphasis has been activated and an
external modulation source is used.

Pre-emphasis increases the high-frequency portions of the signal in the level before the
FM modulator is reached. This can lead to internal overload of the modulator in the case
of sinewave signals with full modulation. The MMF parameter is used to reduce the inter-
nal full modulation to such an extent that sinewave signals with nominal voltage can be
transmitted with low distortion at the stereo input even when pre-emphasis up to the set
frequency has been activated. However, this reduces the S/N ratio on the basis of the
increase in level by the pre-emphasis (at the MMF that has been set).

In the case of normal modulation signals such as voice or music, this parameter can be
left at its default value because the amplitude of the high-frequency portions of these
signals normally decreases substantially.

Remote command:
[ :SOURce] : STEReo : MMF on page 373

Stereo Pilot Tone Settings

The 19 kHz pilot tone is configured in the "Stereo Pilot Tone Settings" section.

Pilot State - Stereo Modulation
Activates/deactivates the pilot tone generation.

Remote command:
[:SOURce] : STEReo: PILot: STATe on page 374

Pilot Deviation - Stereo Modulation
Sets the deviation of the pilot tone.

Remote command:
[:SOURce] : STEReo:PILot [:DEViation] on page 374

Pilot Phase - Stereo Modulation
Sets the phase of the pilot tone in relation to the 38 kHz carrier signal of the receiver. For
a correct demodulation, the pilot tone must be in phase with the 38 kHz carrier.

Remote command:
[:SOURce] : STEReo: PILot : PHASe on page 373
ARI Settings

The radio traffic service ARI (Automotive Radio Information) is configured in the "ARI
Settings" section.

|
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ARI State - Stereo Modulation
Activates/deactivates the ARI signal generation. ARI signals can be generated simulta-
neously with MPX and RDS signals.

Remote command:
[:SOURce] : STEReo:ART : STATe on page 369

ARI Deviation - Stereo Modulation
Sets the frequency deviation of the ARI subcarrier signal.

Remote command:
[:SOURce] : STEReo:ARI[:DEViation] on page 370

ARI Identification - Stereo Modulation
Selects the generated identifiers of the ARI signal.

"Off" Only the 57 kHz subcarrier is generated (Senderkennung). It marks the
stations which broadcast traffic programs and enables the receiver to
recognize the frequency as being ARI-capable.

"DK" The message identification (Durchsagekennung) is generated in addi-
tion (low-frequency 30% AM). It signalizes that a traffic message is cur-
rently broadcasted.

"BK" The area identification (Bereichskennung) is generated in addition
(60% AM). This code is used to identify the geographical region covered
by the radio station. The specific code is selected below.

"DK+BK" The area and message identification are generated in addition.

Remote command:
[ :SOURce] : STEReo:ART : TYPE on page 369

ARI BK - Stereo Modulation
Selects the specific area identification (BK) code of the ARI signal. The six letters (six
different frequencies) identify a specific region in each country.

Remote command:
[:SOURce] : STEReo:ARI :BK[:CODE] on page 368

RDS Settings

The RDS (Radio Data System) is configured in the RDS Settings section, RDS is a com-
munications protocol standard from the European Broadcasting Union for sending digital
information embedded in conventional FM radio broadcasts. The RDS system standard-
ises several types of transmitted information, including time, track/artist info and station
identification.

RDS State - Stereo Modulation
Activates/deactivates the RDS signal generation. RDS signals can be generated simul-
taneously with MPX and ARI signals.

Remote command:
[:SOURce] : STEReo :RDS: STATe on page 375
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RDS Deviation - Stereo Modulation
Sets the deviation of the RDS subcarrier.

Remote command:
[:SOURce] : STEReo:RDS[:DEViation] on page 376

RDS Data Set - Stereo Modulation

Selects the data set used in the RDS signal. Five data sets are provided on the instrument.
The values of the data sets can be defined via remote control (command
SOURce:STEReo:DIRect)

Each of these data sets contains predefined values for:

PI (program identification, identifies the broadcast station )

PS or scrolling PS (program service name, represents the station identity name)
TP (traffic program, mark stations with regular traffic programs )

TA (traffic announcement, marks the start of a traffic program)

PTY (program type, predefined genres of broadcasting programs, e.g. news)
PTYN (program type name)

DI (decoder information)

MS (music /speech)

CT (clock time, used for synchronization)

The following values are empty:

e RT (radio text, two text blocks with 64 symbols each)

e AF (alternative frequencies, maximum of five lists with 25 frequencies each, enables
the receiver to re-tune to a different frequency providing the same station when the
first signal becomes too weak)

TMC (traffic message channel)
EON (enhanced other networks, eight PS with five EON AF lists each, enables the
receiver to automatically tune into these stations if a traffic programs are broadcasted)

The program identification and the program service name of the selected data set are
indicated in the menu.

Remote command:
[:SOURce] : STEReo:RDS:DATaset on page 374

RDS Program Service Name - Stereo Modulation
Indicates the RDS program service name.

Remote command:
[ :SOURce] : STEReo: DIRect on page 372

RDS Program Identification - Stereo Modulation
Indicates the RDS program identification.

Remote command:
[ :SOURce] : STEReo: DIRect on page 372

RDS Traffic Program State - Stereo Modulation
Activates the RDS traffic program (TP function). The receiver can recognize a frequency
as being capable of traffic information only if the TP function is active.

Remote command:
[:SOURce] : STEReo:RDS: TRAFfic: PROGram|[:STATe] on page 375

|
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RDS Traffic Announcement State - Stereo Modulation

Activates the RDS traffic announcement (TA function). If activated, the receiver switches
from the current status, e.g. playing a CD, to the receive mode and enables the broadcast
of a traffic announcement. The TP state has to be on.

Remote command:
[ :SOURce] : STEReo:RDS: TRAFfic:ANNouncement [ : STATe] on page 375

Adjustment Data
Indicates the adjustment state of the analog channels of the stereo coder. For the adjust-
ment of the S/P DIF see service manual, chapter 2, "Adjustment”.

See also "Adjust Stereo Coder" on page 83.

Modulation Generator and LF Output

Overview of LF Generator

An LF generator providing sinusoidal and square signals in the frequency range 0.1 Hz
to 1 MHz is available for the basic unit without additional equipment options.

The LF-Generator is the internal source for the analog modulations AM, FM and PhiM,
and provides the signal also at the LF output (front) of the instrument.

The frequency setting for the LF generator can be made both in the modulation dialogs
and in the "LF Generator / Output” dialog. The settings are effective for all modulations
using the internal modulation source.

A change to the frequency of the LF generator automatically has an effect on modulation
if the LF generator is selected as the modulation source (i.e. "Internal" is selected as
"Source").

The LF Sweep mode is activated in the "LF Frequency Sweep" dialog (see chapter 5.5.3,
"LF Frequency Sweep", on page 189). "RF frequency" and "RF Level" sweeps are acti-
vated in the respective dialogs of the RF block.

The option Pulse Generator (R&S SMB-K23) enables the generation of single and double
pulse signals.

Option (R&S SMB-K27), Pulse Train, enables generation of pulse trains.

The generator is activated and configured in the "Pulse Generator" dialog of the "Mod
Gen" block or in the "Pulse Modulation" dialog of the "Modulation" block ("Pulse Gener-
ator" is selected as "Source").

LF Output

To open the "LF Generator / Output” dialog, select "Mod Gen" > "Configure" > "LF Gen-
erator / Output" or use the MENU key under "Mod Gen".
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The "LF Output" dialog provides access to the configuration of the internal modulation
generators. In addition, the LF output is configured in this menu. The available settings
depend on the source selected and on the installed options.

In the upper section of the menu, the LF output is switched on. The configuration of the
internal source is performed in the lower section of the "LF Output" menu or in the indi-
vidual modulation menus (e.g. "Amplitude Modulation" menu). These settings affect all
modulations which use the same modulation sources and the LF output.

AM Exponential (Instruments with 12, 20, or 40 GHz frequency options)
If you perform exponential AM (AM Type Exponential) with the internal signal of the LF
generator, the LF output provides the exponential modulation signal.

Using AM Source External, the instrument supplies the distorted external signal. The
signal of the internal modulation generator is not available, as well as setting the param-
eters LF Gen Frequency and "LF Gen Shape" on page 171.

5.5.21

LF Output Dialog

State - LF Output
Activates/deactivates the LF output. This setting has no effect on the modulations.

The modulation signal is output at the LF OUTPUT connector of the instrument.

Remote command:
[:SOURce] : LFOutput [: STATe] on page 314

Output Voltage - LF Output
Sets the output voltage of the LF output. The entered value determines the peak voltage.

Remote command:
[:SOURce] : LFOutput:VOLTage on page 319

LF Gen Frequency
Sets the frequency of the LF generator.

This setting affects all analog modulations which use the LF generator as the internal
modulation source.

Remote command:
[ :SOURce] : LFOutput<ch>:FREQuency on page 311
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LF Gen Shape
Selects the waveform shape of the LF signal.

LFGen Shape Sine :

Source Impedance
Sguare
Sawtooth

Note: The installed hardware determines the available settings. Use the Hardware Con-
fig dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[ :SOURce] : LFOutput: SHAPe on page 319

LF Source Impedance
Selects the output impedance of the LF generator. Selection LOW and 600 Ohm are
available.

Note: The installed hardware determines the available settings. Use the Hardware Con-
fig dialog to check the hardware the instrument is equipped with.

For information on the required hardware revision, refer to the release notes.

Remote command:
[ :SOURce] : LFOutput: SIMPedance on page 319

LF Frequency Sweep
The "LF Frequency Sweep" dialog is used to activate and configure a sweep for the LF
frequency.

To open the "LF Frequency Sweep" dialog, select "Mod Gen" > "Configure" > "LF Fre-
quency Sweep" or use the MENU key under "Mod Gen".

The LF sweep mode is activated and the sweep mode is selected. The buttons are used
to reset the LF sweep (all sweep modes) or to execute the LF sweep ("Single" mode).

The sweep range, sweep spacing and dwell time are set in the bottom of the section.

|
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State - LF Sweep
Activates LF Sweep mode.

Note:
Activating a sweep mode automatically deactivates other sweeps and the list mode.

Remote command:
[ :SOURce] : LFOutput : FREQuency : MODE on page 312

Mode - LF Frequency Sweep
Selects the sweep instrument operating mode and sweep mode.

If you change the sweep mode during the execution, the signal generator stops the sweep
and starts with the next trigger event at the initial value.

The "Reset Sweep" button sets the sweep to the start value.

"Auto" Sets an automatically repeated sweep cycle.

Example:
SOUR:LFO:SWE:FREQ:MODE AUTO
TRIGO:SWE:SOUR AUTO
SOUR:LFO:FREQ:MODE SWE

"Single" Sets a single sweep cycle. The sweep is triggered by the "Execute Sin-
gle Sweep" button, or by means remote trigger commands, e.g. *TRG.

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR SING
SOUR:LFO:FREQ:MODE SWE
SOUR:LFO:SWE: FREQ:EXEC

"Step" Sets a step-by-step sweep cycle. Each sweep step is triggered by a
variation of the value in the "Current Freq" entry window.
If this mode is activated, the cursor moves to the value displayed for
"Current Freq".

Example:

SOUR:LFO: SWE: FREQ:MODE MAN
SOUR:LFO:FREQ:MODE SWE
SOUR:LFO:SWE:FREQ:SPAC LIN
SOUR:LFO:SWE:FREQ:STEP:LIN 1E34
SOUR:LFO:FREQ:MAN 12 kHz

The value entered with command
SOUR:LFO:SWE:FREQ:STEP:LIN|LOG sets the step width.

The value entered with command SOUR : LFO : FREQ : MAN has no effect,
the command only sets the next sweep step. In remote control only a
step-by-step sweep from start to stop frequency is possible.

|
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"Extern Single" Sets a single sweep cycle. The sweep is triggered by an external trigger
signal.
The external trigger signal is input at the BNC connector INST TRIG.

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR EXT
SOUR:LFO:FREQ:MODE SWE (External trigger)

"Extern Step"  Sets a step-by-step sweep cycle. Each sweep step is triggered by an
external trigger signal (trigger source as described under "Extern Sin-
gle"). The step width corresponds to the step width set for the rotary
knob.

Example:

SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR EXT
SOUR:LFO:FREQ:MODE SWE (External trigger)

"Extern Start/  Sets an automatically repeated sweep cycle that is started, stopped and
Stop" restartet by subsequent external trigger events.
The first external trigger signal starts the sweep (Start).
The next external trigger signal stops the sweep at the current fre-
quency (Stop).
The third external trigger signal starts the sweep at the start frequency
(Start).
Refer to the description of the rear panel for information about the con-
nectors for external trigger signal input (see chapter 2.2, "Rear Panel
Tour", on page 21).

Example:
SOUR:LFO:SWE: FREQ:MODE AUTO
TRIGO:SWE:SOUR EAUT
SOUR:LFO:FREQ:MODE SWE (External trigger)
Remote command:
[:SOURce] : LFOutput:SWEep [ : FREQuency] : MODE on page 315
:TRIGger<hw>[:SWEep] : SOURce on page 410
[:SOURce] : LEFOutput : FREQuency : MODE on page 312

Execute Single Sweep - LF Sweep
Triggers the sweep manually. A manual sweep can only be triggered if "Mode Single" is
selected.
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Example:
SOUR:LFO: SWE: FREQ:MODE AUTO
TRIG:LFFS:SWE:SOUR SING
TRIG:LFFS

Remote command:

[:SOURce] : LFOutput:SWEep [ : FREQuency] : EXECute on page 314
:TRIGger<hw>:LFFSweep: IMMediate on page 408
:TRIGger<hw>:LEFFSweep on page 407
:TRIGger<hw>[:IMMediate] on page 411

Reset Sweep - LF Sweep
Resets the sweep. The start frequency is set and the next sweep starts from there.

Remote command:
[ :SOURce<hw>] : SWEep:RESet [ : ALL] on page 387

Start Freq - LF Sweep
Sets the start frequency.

Remote command:
[:SOURce] : LFOutput : FREQuency: STARt on page 313

Stop Freq - LF Sweep
Sets the stop frequency.

Remote command:
[:SOURce] : LFOutput : FREQuency: STOP on page 314

Current Freq - LF Sweep
Displays the current frequency.

If "Step" is set, the frequency for the next frequency step of the sweep is entered here.

Remote command:
[:SOURce] : LEOutput : FREQuency:MANual on page 312

Spacing - LF Sweep
Selects linear or logarithmic sweep spacing.

Remote command:
[ :SOURce] : LFOutput:SWEep [ : FREQuency] : SPACing on page 317

Shape - LF Frequency Sweep
Selects the cycle mode for a sweep sequence (shape)

|
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"Sawtooth" One sweep runs from start to stop frequency. Each subsequent sweep
starts at the start frequency, i.e. the shape of the sweep sequence
resembles a sawtooth.

"Triangle" One sweep runs from start to stop frequency and back, i.e. the shape
of the sweep resembles a triangle. Each subsequent sweep starts at
the start frequency.

Remote command:
[:SOURce] : LFOutput:SWEep [ : FREQuency] : SHAPe on page 316

Step Lin/Log - LF Sweep
Sets the step width for the individual sweep steps. This entry is effective for all sweep
modes.

"Step Lin" or "Step Log" is displayed depending on whether "Spacing Lin" or "Log" is

selected.

"Step Lin" With the linear sweep, the step width is a fixed frequency value which
is added to the current frequency. The linear step width is entered in
Hz.

Remote command:
[ :SOURce] : LFOutput:SWEep [ : FREQuency] : STEP [ : LINear] on page 317

"Step Log" With the logarithmic sweep, the step width is a constant fraction of the
current frequency. This fraction is added to the current frequency. The
logarithmic step width is entered in %.

Remote command:
[ :SOURce] : LFOutput:SWEep [ : FREQuency] : STEP:LOGarithmic on page 318

Dwell Time - LF Sweep
Sets the dwell time. The dwell time determines the duration of the individual sweep steps.
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The "Dwell Time" set by the user is used as the step time of the sweep. The effective net
dwell time is shorter, reduced by the setting time. This setting time may be greater than
the time specified in the data sheet.

Note:
It is recommended to switch off the GUI update for optimum sweep performance espe-
cially with short dwell times (see chapter 5.2.3.5, "Gui Update", on page 86).

Remote command:
[ :SOURce] : LFOutput:SWEep [ : FREQuency] : DWEL1 on page 314

Trigger Input Slope

Sets the polarity of the active slope of an applied instrument trigger.

This setting affects the INST TRIG input (BNC connector at the rear of the instrument).
"Positive" The rising edge of the trigger signal is active.
"Negative" The falling edge of the trigger signal is active.

Remote command:
[ :SOURce] : INPut : TRIGger : SLOPe on page 310

Pulse Generator

The "Pulse Generator" dialog is used to activate and configure a pulse modulation signal.

To open the "Pulse Generator" dialog, select "Mod Gen" > "Configure" > "Pulse Gener-
ator" or use the MENU key under "Mod gen". Alternatively, you can configure the pulse
generator in the "Pulse Modulation" dialog of the "Modulation" block.
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5.5.4.1 Pulse Generator Settings
The dialog provides the settings for the pulse characteristics and trigger mode.

Video Sync Signal State - Pulse Generator

Switches on/off the output of the video/sync signal at the PULSE VIDEO connector. The
signal output and the pulse generator are automatically switched on with activation of
pulse modulation if pulse generator is selected as modulation source. The signal output
can be switched off subsequently.

Pulse modulation of the RF carrier is activated in the "Pulse modulation" menu of the
"Modulation" block.

Remote command:
[ :SOURce<hw>] : PGENerator:STATe on page 334

Pulse Mode - Pulse Generator
Sets the mode of the pulse generator.

"Single" A single pulse is generated in one pulse period.

"Double" Two pulses are generated in one pulse period. Additional settings for
the double pulse are available in the menu.

"Train" Requires option R&S SMB-K27.

A user-defined pulse train is generated. Additional settings for the pulse
train are available in the menu after selection of the pulse train mode
(see chapter 5.5.4.2, "Pulse Train Generation", on page 197).

A pulse train is a sequence of pulses with user-defined on and off times.
The ontime/offtime value pairs are defined in a pulse train list. The cur-
rently used pulse train file is displayed in the sub menu.

Remote command:
[ : SOURce<hw>] : PULM:MODE on page 352
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Pulse Period - Pulse Generator
Sets the period of the generated pulse. The period determines the repetition frequency
of the internal signal.

Remote command:
[ :SOURce<hw>] : PULM: PERiod on page 352

Pulse Width - Pulse Generator
Sets the width of the generated pulse. The width determines the pulse length. The pulse
width must be at least 20 ns less than the set pulse period.

Remote command:
[ :SOURce<hw>] : PULM:WIDTh on page 364

Pulse Delay - Pulse Generator
(External trigger only)

Sets the pulse delay. The pulse delay determines the time that elapses after a trigger
event before pulse modulation starts. The pulse delay is not effective for double pulse
generation.

Remote command:
[ :SOURce<hw>] : PULM: DELay on page 350

Double Pulse Width - Pulse Generator
(Double Pulse only)

Sets the width of the second pulse.

Remote command:
[ : SOURce<hw>] : PULM: DOUBle:WIDTh on page 351

Double Pulse Delay - Pulse Generator
(Double Pulse only)

Sets the delay from the start of the first pulse to the start of the second pulse.

Remote command:
[ : SOURce<hw>] : PULM: DOUBle: DELay on page 351

Trigger Mode - Pulse Generator
Selects the trigger mode for pulse modulation.

Note: An external trigger signal is supplied via the PULSE EXT connector.
"Auto" The pulse generator signal is generated continuously.

"Extern Single" The pulse modulation is triggered by an external trigger event.
"Extern Gated" The pulse generator signal is gated by an external gate signal.

Remote command:
[ :SOURce<hw>] : PULM: TRIGger : MODE on page 359

Execute Single Trigger
Triggers the pulse signal manually.
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This function is enabled in "Single Trigger ", see Trigger Mode - Pulse Generator

Remote command:
[:SOURce] : PULM[ : INTernal] [ : TRAin] : TRIGger: IMMediate on page 360

External Trigger Input Slope - Pulse Generator
(External Trigger only)

Sets the polarity of the active slope of an applied trigger signal.

"Positive" The pulse generator is triggered on the positive slope of the external
trigger signal.

"Negative" The pulse generator is triggered on the negative slope of the external
trigger signal.

Remote command:
[ :SOURce<hw>] : PULM: TRIGger:EXTernal : SLOPe on page 359

Gate Input Polarity - Pulse Generator
(Trigger Mode External Gated only)

Selects the polarity of the Gate signal.

The signal is supplied via the PULSE EXT connector.

"Normal" The pulse signal is generated while the gate signal is high.
"Inverse" The pulse signal is generated while the gate signal is low.

Remote command:
[ :SOURce<hw>] : PULM: TRIGger:EXTernal : GATE : POLarity on page 358

Pulse External Input Impedance
Selects the inputimpedance (10 kOhm or 50 Ohm) for the external trigger and gate signal
input (PULSE EXT).

Remote command:
[ : SOURce<hw>] : PULM: TRIGger:EXTernal : IMPedance on page 359

Use SIGNAL VALID as Pulse Sync
Configures the signal at the SIGNAL VALID connector (rear panel):

"selected"” Indicates the validity of the RF signal at the output:
e high: while the signal settles.
e low: when it is stable (valid).

"cleared" Generates a single pulse at the beginning of a pulse sequence, e.g. to
synchronize pulse modulation.

Remote command:
[ :SOURce<hw>] : PULM:OUTPut : SYNC [ : STATe] on page 352

Pulse Train Generation

Upon selection of mode pulse train the menu is extended for configuring a user-defined
pulse train.
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A pulse train is a sequence of pulses with user-defined on and off times. The ontime/
offtime value pairs are defined in a pulse train list. The currently used pulse train file is
displayed in the sub menu.

An internally created pulse train list can be exported or externally created list can be
imported.

Pulse Train Data — Pulse Generator

Calls the "File Select" menu for selecting and creating a pulse train file or to open the
"File Manager".

Remote command:

[ :SOURce<hw>] : PULM: TRAin:CATalog? on page 354

[ : SOURce<hw>] : PULM: TRAin: SELect on page 358

[ :SOURce<hw>] : PULM: TRAin:DELete on page 354

Edit Pulse Train Data — Pulse Generator
Calls the Pulse Train Dialog.

Pulse Train Dialog

The pulse train defined by the selected file is displayed.

The display of the pulse train can be zoomed, the zoom center is defined by the blue
marker.

"Edit" Calls the Edit Pulse Train Data dialog for editing the pulse train.

"Zoom Position"
Positions the blue marker in the pulse train. The marker defines the
center of any zoom in or zoom out action.

"Zoom In/Out" Zooms in or out the graphical display of the pulse train. The zoom factor
of each zoom action is 2.

Edit Pulse Train Data
(For Pulse Mode Train only)
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Calls the editor for editing the ontime/offtime values of the selected file. A file consists of
any number of ontime/offtime value pairs. The currently selected file is displayed.

"Ontime/us" Sets the ontime of the ontime/offtime value pair.

Remote command:
[ :SOURce<hw>] : PULM: TRA1in :ONTime on page 356

"Offtime/us” Sets the offtime of the ontime/offtime value pair.

Remote command:
[ :SOURce<hw>] : PULM: TRAin: OFFTime on page 355

"Count" Sets the number of repetitions for each ontime/offtime value pair.
Tip: If you set "Count = 0", the corresponding value pair is ignored in
the pulse sequence. With this function you can omit value pairs indi-
vidually, without deleting them from the table. To activate them again
set a value other than 0.

Remote command:
[ :SOURce<hw>] : PULM: TRAIn:REPetition on page 357

"Goto" Selects row for editing.

If Goto row is selected, a window opens for entering the requested row.

(it is not possible to change individual positions of the list)
"Edit" Calls a selection of possible actions described below.

"Insert Row" Insert a new row before the marked row.

"Insert Range" Insert new rows before the marked row. The number of rows to be
inserted can be defined in an entry window.
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"Fill...." Opens a sub menu for defining a set of list values to be automatically
entered in the list.
The start line and the number of rows to be filled are defined under
"From" and "Range".
The column to be filled is selected under "Select column tofill". Depend-
ing on the selection here, the default for start, end, and increment value
are set. As the settings are interdependent, a change of one parameter
may result in the automatic change of one or more of the other param-

eters.
The filling of the column with the selected value settings is started with
button "Fill".

"Delete Row" Deletes the marked row.

"Delete Range" Deletes the selected number of rows including the marked row. The
number of rows to be inserted can be defined in an entry window.

"Save As" Open the file menu to save the list under a new name.
Each list is saved to the CpompactFlash™ card as a separate file with
the file prefix * . pulstrn. The file name and the directory to which the
file is saved are user-selectable.

"Save" The list is saved under its current name.

Import/Export - Pulse Train Mode
Expands the menu with the area for import and export of pulse train files.

Externally edited Excel tables with on/off time and repetition triplets can be imported as
text files or CSV files and used for pulse train mode.

On the other hand, internally created pulse train lists can be exported as text files or CSV
files.

Mode — Import/Export Pulse Train Files
Selects if pulse train lists should be imported or exported. The settings offered below
depend on the selected mode.

Remote command:
[ :SOURce<hw>] : PULM: TRAin: DEXChange : MODE on page 363

Extension — ASCII File Settings
Selects the file extension of the ASCII file to be imported or exported. Selection TXT (text
file) or CSV (Excel file) is available.

Remote command:
[ :SOURce<hw>] : PULM: TRAin:DEXChange:AFILe:EXTension on page 361

Decimal Point - ASCII File Settings
Selects the decimal separator used in the ASCII data between "' (decimal point) and '’
(comma) with floating-point numerals.

Remote command:
[ :SOURce<hw>] : PULM: TRAin:DEXChange:AFILe:SEParator:DECimal
on page 362
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Column Separator- ASCII File Settings
Selects the separator between the frequency and level column of the ASCII table.

Remote command:

[ :SOURce<hw>] : PULM: TRAin:DEXChange:AFILe:SEParator:COLumn
on page 362

Select ASCII Source / Destination - Import/Export Pulse Train Files

Calls the "File Manager" for selecting the ASCII file to be imported into a pulse train list
(source) or the ASCII file the pulse train list is exported (destination) in.

Remote command:

[ :SOURce<hw>] : PULM: TRAin:DEXChange:AFILe:CATalog? on page 360

[ :SOURce<hw>] : PULM: TRAin:DEXChange:AFILe:SELect on page 361

Select Destination / Source - Import/Export Pulse Train Files
Calls the "File Manager" for selecting the pulse train list to be exported (source) into an
ASCII file or the destination for the ASCII file to be imported (destination) in.

Remote command:
[ :SOURce<hw>] : PULM: TRAin: DEXChange: SELect on page 364

Import / Export - Import/Export Pulse Train Files
Starts the export or import of the selected file.

If import is selected, the ASCII file is imported as pulse train list.
If export is selected, the pulse train list is exported into the selected ASCII file.

Remote command:
[ :SOURce<hw>] : PULM: TRA1in:DEXChange : EXECute on page 363
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6 Remote Control Basics

This chapter provides basic information on operating an instrument via remote control.

6.1 Remote Control Interfaces and Protocols

The instrument supports different interfaces for remote control. The following table gives

an overview.

Table 6-1: Remote control interfaces and protocols

Remarks

Interface Protocols, VISA") address string
Local Area Net- Protocols:
work (LAN) e  HiSLIP High-Speed LAN Instrument

Protocol (IVI-6.1)
VISA" address string:
TCPIP::host address::
hislipO[::INSTR]
o VXI-11
VISA" address string:
TCPIP::host address[::
LAN device name] [::INSTR]
e socket communication (Raw Ethernet,
simple telnet)
VISA" address string:
TCPIP::host address[::
LAN device name]::<port>::
SOCKET

A LAN connector is located on the front or rear panel of the instru-
ment, or both.

The interface is based on TCP/IP and supports various protocols.

For a description of the protocols refer to:

® chapter 6.1.3.1, "HIiSLIP Protocol", on page 205

® chapter6.1.3.2, "VXI-11 Protocol", on page 206

® chapter 6.1.3.3, "Socket Communication”, on page 206

Serial Interface VISA") address string:

ASRL[0-9] [::INSTR]

For a description of the interface refer to chapter 6.1.5, "Serial
Interface”, on page 207.

GPIB (IEC/IEEE
Bus Interface)

VISA" address string:
GPIB::primary address|[::INSTR]

(no secondary address)

Optional GPIB bus interfaces according to standard IEC 625.1/
IEEE 488.1 are located on the rear panel of the instrument.

For a description of the interface refer to chapter 6.1.6, "GPIB
Interface (IEC/IEEE Bus Interface)", on page 208.

chapter 6.1.1, "VISA Libraries", on page 203.

") VISA is a standardized software interface library providing input and output functions to communicate with instruments. A VISA
installation on the controller is a prerequisite for remote control over LAN (when using VXI-11 or HiSLIP protocol), USB and serial
interface. However, no VISA installation is necessary to remote control while using socket communication. For more information, see

Within this interface description, the term GPIB is used as a synonym for the IEC/IEEE

bus interface.

SCPI (Standard Commands for Programmable Instruments)

SCPI commands - messages - are used for remote control. Commands that are not taken
from the SCPI standard follow the SCPI syntax rules. The instrument supports the SCPI
version 1999. The SCPI standard is based on standard IEEE 488.2 and aims at the
standardization of device-specific commands, error handling and the status registers.
The tutorial "Automatic Measurement Control - A tutorial on SCPI and IEEE 488.2" from
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John M. Pieper (R&S order number 0002.3536.00) offers detailed information on con-
cepts and definitions of SCPI.

Tables provide a fast overview of the bit assignment in the status registers. The tables
are supplemented by a comprehensive description of the status registers.

VISA Libraries

VISA is a standardized software interface library providing input and output functions to
communicate with instruments. The I/O channel (LAN or TCP/IP, USB, GPIB,...) is
selected at initialization time by means of the channel-specific address string ("VISA
resource string"), or by an appropriately defined VISA alias (short name). A VISA instal-
lation is a prerequisite for remote control using the following interfaces:

e chapter 6.1.3, "LAN Interface", on page 204

e chapter 6.1.3.2, "VXI-11 Protocol", on page 206

e chapter 6.1.4, "USB Interface", on page 207

® chapter 6.1.6, "GPIB Interface (IEC/IEEE Bus Interface)", on page 208
e chapter 6.1.5, "Serial Interface", on page 207

For more information about VISA refer to the user documentation.

Messages

The messages transferred on the data lines are divided into the following categories:

e |Interface messages
Interface messages are transmitted to the instrument on the data lines, with the
attention line being active (LOW). They are used to communicate between the con-
troller and the instrument. Interface messages can only be sent by instruments that
have GPIB bus functionality. For details see the sections for the required interface.

e Instrument messages
Instrument messages are employed in the same way for all interfaces, if not indicated
otherwise in the description. Structure and syntax of the instrument messages are
described in chapter 6.3, "SCPI Command Structure", on page 222. A detailed
description of all messages available for the instrument is provided in the chapter
"Remote Control Commands".
There are different types of instrument messages, depending on the direction they
are sent:
— Commands

— Instrument responses

Commands

Commands (program messages) are messages the controller sends to the instrument.
They operate the instrument functions and request information. The commands are sub-
divided according to two criteria:

e According to the effect they have on the instrument:

|
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— Setting commands cause instrument settings such as a reset of the instrument
or setting the frequency.

— Queries cause data to be provided for remote control, e.g. for identification of the
instrument or polling a parameter value. Queries are formed by directly appending
a question mark to the command header.

e According to their definition in standards:
— Common commands: their function and syntax are precisely defined in standard
IEEE 488.2. They are employed identically on all instruments (if implemented).
They refer to functions such as management of the standardized status registers,
reset and self test.

— Instrument control commands refer to functions depending on the features of
the instrument such as frequency settings. Many of these commands have also
been standardized by the SCPI committee. These commands are marked as
"SCPI confirmed" in the command reference chapters. Commands without this
SCPI label are device-specific; however, their syntax follows SCPI rules as per-
mitted by the standard.

Instrument responses

Instrument responses (response messages and service requests) are messages the
instrument sends to the controller after a query. They can contain measurement results,
instrument settings and information on the instrument status.

LAN Interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, consisting of
a connector, a network interface card and protocols. For remote control via a network,
the PC and the instrument must be connected via the LAN interface to a common network
with TCP/IP network protocol. They are connected using a commercial RJ45 cable. The
TCP/IP network protocol and the associated network services are preconfigured on the
instrument. Software for instrument control and (for specified protocols only) the VISA
program library must be installed on the controller.

VISA library

Instrument access via VXI-11 or HiSLIP protocols is usually achieved from high level
programming platforms using VISA as an intermediate abstraction layer. VISA encapsu-
lates the low level VXI or GPIB function calls and thus makes the transport interface
transparent for the user. See chapter 6.1.1, "VISA Libraries", on page 203 for details.

IP address

Only the IP address or the computer name (LAN device name) is required to set up the
connection. The IP address/computer name is part of the "visa resource string" used by
the programs to identify and control the instrument.

Forms of the VISA resource string:
TCPIP::host address[::LAN device name] [::INSTR]

or

|
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TCPIP::host address::port::SOCKET
where

e TCPIP designates the network protocol used
e host address is the IP address or host name of the device

e LAN device name defines the protocol and the instance number of a sub-instrument:
— 1inst0 selects the VXI-11 protocol (optional, default)

— hislip0 selects the newer HiSLIP protocol
e INSTR indicates the instrument resource class (optional)
e port determines the used port number
e SOCKET indicates the raw network socket resource class

Example:

e [nstrument has the IP address 792.1.2.3; the valid resource string using VXI-11 pro-
tocol is:
TCPIP::192.1.2.3::INSTR

e The DNS host name name is RSSM1; the valid resource string is:
TCPIP::RSSM1::hislipO (HiSLIP)
TCPIP::RSSM1::INSTR (VXI-11)

e A raw socket connection can be established using:
TCPIP::192.1.2.3::5025::SOCKET

Identifying instruments in a network

If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
means of the resource string.

6.1.3.1 HiSLIP Protocol

The HiSLIP (High Speed LAN Instrument Protocol) is the successor protocol for VXI-11
for TCP-based instruments specified by the IVI foundation. The protocol uses two TCP
sockets for a single connection - one for fast data transfer, the other for non-sequential
control commands (e.g. Device Clear or SRQ).

HiSLIP has the following characteristics:

e High performance as with raw socket network connections

e Compatible IEEE 488.2 support for Message Exchange Protocol, Device Clear,
Serial Poll, Remote/Local, Trigger, and Service Request

e Uses a single IANA registered port (4880), which simplifies the configuration of fire-
walls

e Supports simultaneous access of multiple users by providing versatile locking mech-
anisms

e Usable for IPv6 or IPv4 networks
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Note that HiSLIP data is sent to the device using the "fire and forget" method with imme-
diate return, as opposed to VXI-11, where each operation is blocked until a VXI-11 device
handshake returns. Thus, a successful return of a VISA operation such as vilirite ()
does not guarantee that the instrument has finished or started the requested command,
but is delivered to the TCP/IP buffers.

6.1.3.2

6.1.3.3

6.1.3.4

For more information see also the application note at: http://www.rohde-schwarz.com/
appnote/1TMA208.

VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport layer.
The TCP/IP network protocol and the associated network services are preconfigured.
TCP/IP ensures connection-oriented communication, where the order of the exchanged
messages is adhered to and interrupted links are identified. With this protocol, messages
cannot be lost.

Socket Communication

An alternative way for remote control of the software is to establish a simple network
communication using sockets. The socket communication, also referred to as "Raw
Ethernet communication”, does not necessarily require a VISA installation on the remote
controller side. It is available by default on all operating systems.

The simplest way to establish socket communication is to use the built-in telnet program.
The telnet program is part of every operating system and supports a communication with
the software on a command-by-command basis. For more convenience and to enable
automation by means of programs, user-defined sockets can be programmed.

Socket connections are established on a specially defined port. The socket address is a
combination of the IP address or the host name of the instrument and the number of the
port configured for remote-control. All R&S Signal Generator use port number 5025 for
this purpose. The portis configured for communication on a command-to-command basis
and for remote control from a program.

LAN Interface Messages

In the LAN connection, the interface messages are called low—level control messages.
These messages can be used to emulate interface messages of the GPIB bus.

Command Long term Effect on the instrument
&ABO Abort Aborts processing of the commands just received.
&DCL Device Clear Aborts processing of the commands just received and sets

the command processing software to a defined initial state.
Does not change the instrument setting.

&GTL Go to Local Transition to the "local" state (manual control).

|
Operating Manual 1407.0806.32 — 13 206


http://www.rohde-schwarz.com/appnote/1MA208
http://www.rohde-schwarz.com/appnote/1MA208

R&S®SMB100A

Remote Control Basics

6.1.4

6.1.5

Remote Control Interfaces and Protocols

Command Long term Effect on the instrument
&GTR Go to Remote Transition to the "remote" state (remote control).
&GET Group Execute Trigger Triggers a previously active instrument function (e.g. a

sweep). The effect of the command is the same as with that
of a pulse at the external trigger signal input.

&LLO Local Lockout Disables switchover from remote control to manual control
by means of the front panel keys.

&NREN Not Remote Enable Enables switchover from remote control to manual opera-
tion by means of the front panel keys

&POL Serial Poll Starts a serial poll.

USB Interface

For remote control via the USB connection, the PC and the instrument must be connected
via the USB type B interface. A USB connection requires the VISA library to be installed.
VISA detects and configures the R&S instrument automatically when the USB connection
is established. You do not have to enter an address string or install a separate driver.

USB address
The used USB address string is:

USB: :<vendor ID>::<product ID>::<serial number>[::INSTR]
where:

e <vendor ID> is the vendor ID for Rohde&Schwarz
e <product ID> is the product ID for the R&S instrument
e <serial number> is the individual serial number on the rear of the instrument

Example:

USB: :0x0AAD: :0x0054::100001::INSTR
0x0AAD is the vendor ID for Rohde&Schwarz

0x54 is the product ID for the R&S SMB

100001 is the serial number of the particular instrument

Serial Interface

Remote control via the serial interface is possible either via RS232 interface or via a
Bluetooth connection. The controller/Bluetooth device and the instrument must be con-
nected via an external USB/serial-adapter (see recommended extras, data sheet) and a
serial crossover (null modem) cable. A USB connection requires the VISA library to be
installed on the controller. VISA will detect and configure the R&S SMB automatically
when the USB connection is established.

|
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Serial address

The used serial address string is:
ASRL[0-9] [::INSTR]

where ASRL[0-9] determines the number of the COM port on the controller side, that
has to be used for the serial connection.

Access via a bluetooth device requires the entry of the bluetooth pin in addition (see
chapter 5.2.3.15, "Security", on page 97).

To enable an error-free and correct data transmission, the parameters of the generator
and the controller must have the same setting. The serial interface is preset for a baud
rate 115200, no parity and one stop bit. The parameters can be manually changed in
"Remote Channel Settings" dialog (see chapter 5.2.3.13, "Remote Channel Settings",
on page 93).

6.1.6 GPIB Interface (IEC/IEEE Bus Interface)

To be able to control the instrument via the GPIB bus, the instrument and the controller
must be linked by a GPIB bus cable. A GPIB bus card, the card drivers and the program
libraries for the programming language used must be provided in the controller. The con-
troller must address the instrument with the GPIB bus address (see chapter 6.1.6.2,
"GPIB Instrument Address", on page 209).

Characteristics
The GPIB interface is described by the following characteristics:

e Up to 15 instruments can be connected

e The total cable length is restricted to a maximum of 15 m; the cable length between
two instruments should not exceed 2m.

e A wired "OR"-connection is used if several instruments are connected in parallel,
since the slowest instrument determines the speed.

Any connected IEC bus cable must be terminated by an instrument or controller.

6.1.6.1 GPIB Interface Messages

Interface messages are transmitted to the instrument on the data lines, with the attention
line (ATN) being active (LOW). They are used for communication between the controller
and the instrument and can only be sent by a computer which has the function of a GPIB
bus controller. GPIB interface messages can be further subdivided into:

e Universal commands: act on all instruments connected to the GPIB bus without
previous addressing

e Addressed commands: only act on instruments previously addressed as listeners
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Universal Commands

Universal commands are encoded in the range 10 through 1F hex. They affect all instru-
ments connected to the bus and do not require addressing.

Command Effect on the instrument

DCL (Device Clear) Aborts the processing of the commands just received and sets the command
processing software to a defined initial state. Does not change the instrument
settings.

IFC (Interface Clear) *) Resets the interfaces to the default setting.

LLO (Local Lockout) The LOC/IEC ADDR key is disabled.

SPE (Serial Poll Enable) Ready for serial poll.

SPD (Serial Poll Disable) End of serial poll.

PPU (Parallel Poll Unconfig- | End of the parallel-poll state.

ure)

*) IFC is not a real universal command, it is sent via a separate line; however, it also affects all instruments
connected to the bus and does not require addressing

Addressed Commands

Addressed commands are encoded in the range 00 through OF hex. They only affect
instruments addressed as listeners.

Command Effect on the instrument

GET (Group Execute Trigger) Triggers a previously active instrument function (e.g. a sweep). The
effect of the command is the same as with that of a pulse at the
external trigger signal input.

GTL (Go to Local) Transition to the "local" state (manual control).

GTR (Go to Remote) Transition to the "remote” state (remote control).

PPC (Parallel Poll Configure) Configures the instrument for parallel poll.

SDC (Selected Device Clear) Aborts the processing of the commands just received and sets the

command processing software to a defined initial state. Does not
change the instrument setting.

6.1.6.2 GPIB Instrument Address

In order to operate the instrument via remote control, it must be addressed using the
GPIB address. The remote control address is factory preset, but it can be changed if it
does not fit in the network environment. For remote control, addresses 0 through 30 are
allowed. The GPIB address is maintained after a reset of the instrument settings.
Changing the GPIB address of the instrument

The GPIB address can be changed manually or using a remote control command.

1. Manually: press the SETUP key and select "Remote > GPIB".
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Select parameter "GPIB channel address" and set the GPIB address.

2. Using remote control command:
SYST:COMM:GPIB:ADDR 18

6.2 Starting a Remote Control Session

The instrument and the controller have to be connected with the suitable cable and
switched on.

A remote control program must open a connection to the instrument (using VISA func-
tionality), before it can send commands to and receive device responses from the instru-
ment.

Instrument Address

In order to operate the instrument via remote control it must be addressed using the
defined interface address. See chapter 6.1.3, "LAN Interface", on page 204, chap-

ter 6.1.4, "USB Interface", on page 207, chapter 6.1.5, "Serial Interface", on page 207or
chapter 6.1.6, "GPIB Interface (IEC/IEEE Bus Interface)", on page 208 for details.

The VISA resource strings are indicated in the "Setup > Remote Channel Settings" menu.

6.2.1

Refer to chapter 6.2.3, "Examples", on page 211 for practical examples on setting up of
a remote control link and starting of a remote control session.

Switching to Remote Control

When it is switched on, the instrument is always in the manual operating state and can
be operated via the front panel controls (for instruments equipped with a display) or via
mouse and external keyboard.

Starting remote control

1. Send a command from a controller to the instrument.

The instrument is switched to remote control as soon as it receives a command from
the controller.

While remote control is active, operation via the front panel or via mouse and key-
board is disabled and "REMOTE" is displayed in the status line.

|
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The instrument remains in the remote state until it is reset to the manual state via the
instrument or via the remote control interface (see chapter 6.2.2, "Returning to Man-
ual Operation", on page 211).

Tip: Switching from manual operation to remote control and vice versa does not affect
the other instrument settings.

Although operation via front panel, mouse and keyboard is disabled, the dialog boxes
can still be opened, e.g. to verify settings, but buttons and setting fields are displayed
in gray and cannot be activated.

Use the command SYST:KLOC ON to disable the access to the dialogs.

To prevent unintentional return to manual operation, disable the LOCAL key of the
instrument using the sLLO command (see chapter 6.1.3.4, "LAN Interface Mes-
sages”, on page 206).

The instrument switches to "REM-LLO" state and transition to manual mode is not
anymore possible via the remote control command *GTL.

Switching to manual mode is only possible via remote control then.

Enable the LOCAL key with the interface message &NREN.

6.2.2 Returning to Manual Operation

Before returning to manual control, command processing must be completed. Otherwise,
the instrument switches back to remote control immediately.

6.2.3

>

To return to manual operation, use one of the following ways:

a) Press the LOCAL key on the front panel.

b) Select "Setup > Remote Control Channels" and press "Local".

c) While using the socket communication, terminate the remote control session.
d) Send the interface command sGTL via the remote control interface.

Tip: Use the sNREN to enable the LOCAL key if the key is disabled.

Examples

This sections provides examples for setting up of remote control connection and starting
a remote control session over LAN and GPIB interfaces.

This section assumes basic knowledge of programming and operation of the controller.
A description of the interface commands can be obtained from the relevant manuals.
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Remote Control over GPIB

The program example in this section is written in VISUAL BASIC. A condition for pro-
gramming in VISUAL BASIC is that the modules NIGLOBAL (Niglobal.bas) and
VBIB32 (Vbib_ 32.bas) are added to the projects.

@

Drivers for instrument, e.g. IVI-COM and LabVIEW drivers, are available in the download
area of the product website (http://www.rohde-schwarz.com/en/products/test and_mea-
surement/product_categories/signal_generation/).

6.2.3.2

Starting a remote control session over GPIB

As a prerequisite, the GPIB address of the instrument, which is factory-set to 28, must
not have been changed.

1. Connect instrument and controller using GPIB cable and switch them on.

2. Execute following commands on the controller:
a) Open port to the instrument
CALL IBFIND("DEV1", generator%)

b) Inform controller about instrument address
CALL IBPAD (generator%, 28)

c) Resetinstrument
CALL IBWRT (generator%, "*RST;*CLS")

d) Setinstrument to new address
CALL IBWRT (generator%, "SYST:COMM:GPIB:ADDR 18")

e) Inform controller about new address
CALL IBPAD (generator%, 18)

The GPIB address of the instrument is changed.

3. To return to manual operation, press the LOCAL key at the front panel.

Remote Control over LAN using VXI-11 Protocol

Through the examples in this section, the program 'Measurement & Automation Explorer'
from National Instruments under Windows operating system is used for setting up a LAN

remote control link and starting a remote control session.

Configuring the controller

The instrument is preconfigured for networks using DHCP (dynamic host configuration
protocol). If this configuration is used, enter the computer name in the position of the IP
address.
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To enable the external controller to communicate with the software via TCP/IP protocol,
set up a remote control link as follow:

1. Connect the controller and the instrument to the network (network cable) and switch
them on.

2. Start the 'Measurement & Automation Control' program on the controller.

3. Select "Devices and Interfaces > Create New".

4. Select "VISA TCP/IP Resource" and confirm with "Next".

5. Choose the type of TCP/IP resource you wish to add and select Next.

6. Enter the IP address or the host name of the R&S SMB and select "Next".
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7. Enter the alias name if required.
The alias name must not be mistaken for the computer name. It is only used for
instrument identification within the program and displayed in the menu as an option
in case of an Ethernet link.

8. Confirm the settings with "Finish".
The instrument is configured and the settings are displayed in the "TCP/IP Set-
tings" tab.

9. To test the connection, select "Validate".
A message indicates whether the link to the instrument can be set up or not.
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If a connection cannot be set up, check whether the controller and the instrument are
connected to the network (network cable) and switched on. Correct spelling of the IP
address or the computer name can also be checked. For further error location, inform
the network administrator. In large networks, specification of additional addresses
may be required for link setup, e.g. gateway and subnet mask, which are known to
the network administrator.

The instrument is now registered in the program and can be addressed via the
resource string or alias name.

Starting a remote control over LAN (using VXI-11)

1. Start the 'Measurement & Automation Explorer' on the controller.

2. Inthe "Configuration" window, select "Device and Interfaces > VISA TCP/IP Resour-
ces", select the required instrument and select "Open VISA Test Panel".

3. In the "viWrite" tab, write the command to be send to the instrument and select
"Execute".
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Instrument responses are displayed on the "viRead" tab.
Tip: For further program operation refer to the online help of the program.

6.2.3.3 Remote Control over LAN using Socket Communication

This chapter provides an example on how to establish a remote control connection over
telnet protocol and a simple sockets-based program example that can be further devel-
oped.

Setting up a Telnet Connection

To control the software, only a telnet program is required. The telnet program is part of
every operating system.

1. To establish a Telnet connection with the R&S SMB, start the telnet program and

enter the socket address.
The socket address is a combination of the |P address or the host name of the R&S

SMB and the number of the port configured for remote-control via telnet.
Tip: The R&S SMB uses the port number 5025 for remote connection via Telnet.

The connection to the instrument is set up and remote-control commands can be
sent.

|
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& Telnet 10.111.11.56 H=1E

2. Even if the cursor is not visible on the screen, enter blind a remote-control command
and confirm with Enter.

% Telnet 10.111.11.56 Hi=1E

After the first remote-control command had been send, the instrument is in the
"REMOTE" state, i.e. instrument control from the front panel or via mouse and key-
board is disabled and "REMOTE" is displayed in the status line.

Telnet program examples

The following program example shows a simple TcpClient class that is intended to explain
on how to get started with programming of sockets.

The example sets up a socket communication to R&S SMB and opens a simple user
interface, very similar to the telnet, which allows input of commands. To enable real
automation, further development of the program is required.

TcpClient.h

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr in SockAddrStruct;
typedef struct hostent HostInfoStruct;
class TcpClient
{
public:
TcpClient () ;
~TcpClient () ;
void connectToServer ( string &hostname, int port );
void disconnect( );

void transmit( string &txString );
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void receive( string &rxString );

string getCurrentHostName ( ) const;

int getCurrentPort ( ) const;
private:

string currentHostName;

int currentPort;

int currentSocketDescr;

SockAddrStruct serverAddress;
HostInfoStruct * currentHostInfo;
bool clientIsConnected;

int receiveBufferSize;

TcpClient.cpp

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr in SockAddrStruct;
typedef struct hostent HostInfoStruct;
class TcpClient
{
public:
TcpClient () ;
~TcpClient () ;
void connectToServer( string &hostname, int port );
void disconnect( );
void transmit( string &txString );

void receive( string &rxString );

string getCurrentHostName ( ) const;

int getCurrentPort ( ) const;
private:

string currentHostName;

int currentPort;

int currentSocketDescr;

SockAddrStruct serverAddress;
HostInfoStruct * currentHostInfo;
bool clientIsConnected;

int receiveBufferSize;

#include <netdb.h>
#include <netinet/in.h>
#include <unistd.h>
#include "TcpClient.h"
TcpClient::TcpClient ()
: currentHostName ( "" )
, currentPort( 0 )

, currentSocketDescr( 0 )
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, serverAddress ( )
, currentHostInfo( NULL )
, clientIsConnected( false )

, receiveBufferSize( 1024 )

TcpClient::~TcpClient ()
{
currentHostInfo = NULL;

void TcpClient::connectToServer ( string &hostname, int port )

{

currentHostInfo = gethostbyname( hostname.c_str( ) );
if ( currentHostInfo == NULL )
{

currentHostName = "";

currentPort = 0;

currentHostInfo = NULL;

clientIsConnected = false;

printf ("error connecting host\n" );
}
currentHostName = hostname;
currentPort = port;

currentSocketDescr = socket (AF _INET, SOCK STREAM, 0);

if ( currentSocketDescr == 0 )
{
currentHostName = "";
currentPort = 0;
currentHostInfo = NULL;

clientIsConnected = false;
printf ("can't create socket\n" );
}
serverAddress.sin family = currentHostInfo->h addrtype;
serverAddress.sin_port = htons( currentPort );
memcpy ( (char *) &serverAddress.sin addr.s_addr,
currentHostInfo->h addr 1ist[0], currentHostInfo->h length );
if ( connect ( currentSocketDescr, ( struct sockaddr *) &serverAddress,
sizeof ( serverAddress ) ) < 0 )
{
throw string("can't connect server\n" );
}
clientIsConnected = true;
}
void TcpClient::disconnect( )
{
if( clientIsConnected )
{

close( currentSocketDescr );
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currentSocketDescr = 0;

currentHostName = "";
currentPort = 0;
currentHostInfo = NULL;
clientIsConnected = false;

}
void TcpClient::transmit( string &txString )
{
if( !'clientIsConnected )
{
throw string("connection must be established before any data can be sent\n");
}
char * transmitBuffer = new char[txString.length() +1];
memcpy ( transmitBuffer, txString.c str(), txString.length() );
transmitBuffer[txString.length()] = '\n'; //newline is needed!
if( send( currentSocketDescr, transmitBuffer, txString.length() + 1, 0 ) < 0 )
{
throw string("can't transmit data\n");
}
delete [] transmitBuffer;
}
void TcpClient::receive( string &rxString )
{
if( !'clientIsConnected )
{
throw string("connection must be established before any data can be received\n");
}
char * receiveBuffer = new char[receiveBufferSize];
memset ( receiveBuffer, 0, receiveBufferSize );
bool receiving = true;
while( receiving )
{
int receivedByteCount = recv( currentSocketDescr,
receiveBuffer, receiveBufferSize, 0 );
if ( receivedByteCount < 0 )
{
throw string("error while receiving data\n");
}

rxString += string( receiveBuffer );

receiving = ( receivedByteCount == receiveBufferSize );
}
delete [] receiveBuffer;
}
string TcpClient::getCurrentHostName( ) const

{

return currentHostName;

}
int TcpClient::getCurrentPort( ) const

{



Starting a Remote Control Session

return currentPort;

TelnetClient.cpp

#include <iostream>
#include "TcpClient.h"
void printUsage ()
{
cout<<"usage: EthernetRawCommand <server-ip> [scpi-command]"<<endl;
}
int main( int argc, char *argv([] )
{
int errorCode = 0; //no error

bool useSingleCommand = false;

string singleCommand = "";
string hostname = nn,
int port = 5025;
string input = nw,

TcpClient client;
switch( argc )
{

case 3:

useSingleCommand = true;

singleCommand = argv[2];
case 2:
hostname = argv[1l];
break;
default:

printUsage () ;

return(-1);
try

client.connectToServer ( hostname, port );
bool terminate = false;
while( !terminate )
{
char buffer[1024];
if ( useSingleCommand )
{
input = singleCommand; //send string
}
else
{
cin.getline( buffer, 1024 );
input = buffer;
if ( input == "end" )
{

terminate = true;
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}
if( 'termin
{
client.tr
int gPos
//receive
if ( gPos
{
string
client.

cout <<

}
if ( useSing
{

terminate

}

}catch( const s

{

cout<<errorSt

}

client.disconne

ate)
ansmit ( input ); //send string
= input.find( "?", 0 );
string only when needed
>0 )
rcStr = "";
receive ( rcStr );
rcStr << endl;

leCommand )

= true;

tring errorString )

ring<<endl;

ct( )

return errorCode;

6.3 SCPI Command Structure

Remote Control Basics
|

SCPI Command Structure

SCPI commands consist of a so-called header and, in most cases, one or more param-
eters. The header and the parameters are separated by a "white space" (ASCII code 0
to 9, 11 to 32 decimal, e.g. blank). The headers may consist of several mnemonics (key-

words). Queries are formed by appending a question mark directly to the header.

The commands can be either device-specific or device-independent (common com-
mands). Common and device-specific commands differ in their syntax.

6.3.1 Syntax for Common Commands

Common (=device-independent) commands consist of a header preceded by an asterisk
(*) and possibly one or more parameters.

Examples:

*RST

RESET

Resets the instrument.

*ESE

EVENT STATUS ENABLE

Sets the bits of the event status enable

registers.
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*ESR? EVENT STATUS QUERY Queries the contents of the event status
register.

*IDN? IDENTIFICATION QUERY Queries the instrument identification
string.

6.3.2 Syntax for Device-Specific Commands

Not all commands used in the following examples are necessarily implemented in the
instrument.

For demonstration purposes only, assume the existence of the following commands for
this section:

e DISPlay[:WINDow<l...4>]:MAXimize <Boolean>

e FORMat:READings:DATA <type>[,<length>]

e HCOPy:DEVice:COLor <Boolean>

e HCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
e HCOPy[:IMMediate]

e HCOPy:ITEM:ALL

e HCOPy:ITEM:LABel <string>

e HCOPy:PAGE:DIMensions:QUADrant [<N>]

e HCOPy:PAGE:0ORIentation LANDscape | PORTrait

e HCOPy:PAGE:SCALe <numeric value>

e MMEMory:COPY <file source>,<file destination>

e SENSE:BANDwidth|BWIDth[:RESolution] <numeric value>
® SENSe:FREQuency:STOP <numeric value>

® SENSe:LIST:FREQuency <numeric value>{,<numeric value>}

Long and short form

The mnemonics feature a long form and a short form. The short form is marked by upper
case letters, the long form corresponds to the complete word. Either the short form or the
long form can be entered; other abbreviations are not permitted.

Example:
HCOPy:DEVice:COLor ON is equivalent to HCOP:DEV:COL ON.

Case-insensitivity

Upper case and lower case notation only serves to distinguish the two forms in the man-
ual, the instrument itself is case-insensitive.
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Numeric suffixes

If a command can be applied to multiple instances of an object, e.g. specific channels or
sources, the required instances can be specified by a suffix added to the command.
Numeric suffixes are indicated by angular brackets (<1...4>, <n>, <i>) and are replaced
by a single value in the command. Entries without a suffix are interpreted as having the
suffix 1.

Example:
Definition: HCOPy : PAGE : DIMensions : QUADrant [<N>]
Command: HCOP : PAGE : DIM: QUAD?2

This command refers to the quadrant 2.

Different numbering in remote control

For remote control, the suffix may differ from the number of the corresponding selection
used in manual operation. SCPI prescribes that suffix counting starts with 1. Suffix 1 is
the default state and used when no specific suffix is specified.

Some standards define a fixed numbering, starting with 0. If the numbering differs in
manual operation and remote control, it is indicated for the corresponding command.

Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or
omitted. These mnemonics are marked by square brackets in the description. The instru-
ment must recognize the long command to comply with the SCPI standard. Some com-
mands are considerably shortened by these optional mnemonics.

Example:
Definition: HCOPy [ : IMMediate]
Command: HCOP: IMM is equivalent to HCOP

Optional mnemonics with numeric suffixes

Do not omit an optional mnemonic if it includes a numeric suffix that is relevant for the
effect of the command.

Example:
Definition:DISPlay [ :WINDow<1...4>] :MAXimize <Boolean>
Command: DISP:MAX ON refers to window 1.

In order to refer to a window other than 1, you must include the optional WINDow param-
eter with the suffix for the required window.

DISP:WIND2 :MAX ON refers to window 2.

|
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Parameters

Parameters must be separated from the header by a "white space”. If several parameters
are specified in a command, they are separated by a comma (,). For a description of the
parameter types, refer to chapter 6.3.3, "SCP| Parameters", on page 225.

Example:
Definition:HCOPy : DEVice :CMAP:COLor :RGB <red>,<green>,<blue>

Command:HCOP: DEV:CMAP:COL:RGB 3,32, 44

Special characters

Parameters

A vertical stroke in parameter definitions indicates alternative possibilities in the sense of "or". The effect
of the command differs, depending on which parameter is used.

Example:

Definition:HCOPy : PAGE: ORIentation LANDscape | PORTrait
Command HCOP: PAGE : ORI LAND specifies landscape orientation
Command HCOP: PAGE: ORI PORT specifies portrait orientation
Mnemonics

A selection of mnemonics with an identical effect exists for several commands. These mnemonics are
indicated in the same line; they are separated by a vertical stroke. Only one of these mnemonics needs
to be included in the header of the command. The effect of the command is independent of which of the
mnemonics is used.

Example:

DefinitionSENSE : BANDwidth | BWIDth[:RESolution] <numeric value>
The two following commands with identical meaning can be created:
SENS:BAND:RES 1

SENS:BWID:RES 1

[l

Mnemonics in square brackets are optional and may be inserted into the header or omitted.
Example: HCOPy [ : IMMediate]

HCOP: IMM is equivalent to HCOP

{}

Parameters in curly brackets are optional and can be inserted once or several times, or omitted.
Example: SENSe:LIST:FREQuency <numeric value>{,<numeric_value>}

The following are valid commands:

SENS:LIST:FREQ 10

SENS:LIST:FREQ 10,20

SENS:LIST:FREQ 10,20,30,40

6.3.3 SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The param-
eters must be separated from the header by a "white space" (ASCIll code 0t0 9, 11 to 32
decimal, e.g. blank). Allowed parameters are:

Numeric values
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e Special numeric values
e Boolean parameters

o Text

e Character strings

e Block data

The parameters required for each command and the allowed range of values are speci-
fied in the command description.

Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent.
Values exceeding the resolution of the instrument are rounded up or down. The mantissa
may comprise up to 255 characters, the exponent must lie inside the value range -32000
to 32000. The exponent is introduced by an "E" or "e". Entry of the exponent alone is not
allowed. In the case of physical quantities, the unit can be entered. Allowed unit prefixes
are G (giga), MA (mega), MOHM and MHZ are also allowed), K (kilo), M (milli), U (micro)
and N (nano). If the unit is missing, the basic unit is used.

Example: SENS:FREQ: STOP 1.5GHz = SENS:FREQ:STOP 1.5E9

Units

For physical quantities, the unit can be entered. Allowed unit prefixes are:

* G (giga)

e MA (mega), MOHM, MHZ
o K (kilo)

e M (milli)

e U (micro)

e N (nano)

If the unit is missing, the basic unit is used.

Example:
SENSe:FREQ:STOP 1.5GHz = SENSe:FREQ:STOP 1.5E9

Some settings allow relative values to be stated in percent. According to SCPI, this unit
is represented by the PCT string.

Example:
HCOP:PAGE:SCAL 90PCT

Special numeric values

The texts listed below are interpreted as special numeric values. In the case of a query,
the numeric value is provided.

e MIN/MAX
MINimum and MAXimum denote the minimum and maximum value.

|
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e DEF
DEFault denotes a preset value which has been stored in the EPROM. This value
conforms to the default setting, as it is called by the *RST command.

e UP/DOWN
UP, DOWN increases or reduces the numeric value by one step. The step width can
be specified via an allocated step command for each parameter which can be set via
UP, DOWN.

e INF/NINF
INFinity, Negative INFinity (NINF) represent the numeric values 9.9E37 or -9.9E37,
respectively. INF and NINF are only sent as instrument responses.

e NAN
Not A Number (NAN) represents the value 9.91E37. NAN is only sent as a instrument
response. This value is not defined. Possible causes are the division of zero by zero,
the subtraction of infinite from infinite and the representation of missing values.

Example:
Setting command: SENSe:LIST:FREQ MAXimum
Query: SENS:LIST:FREQ?, Response: 3.5E9

Queries for special numeric values

The numeric values associated to MAXimum/MINimum/DEFault can be queried by
adding the corresponding mnemonics to the command. They must be entered following
the quotation mark.

Example: SENSe:LIST:FREQ? MAXimum

Returns the maximum numeric value as a result.

Boolean Parameters

Boolean parameters represent two states. The "ON" state (logically true) is represented
by "ON" or a numeric value 1. The "OFF" state (logically untrue) is represented by
"OFF" or the numeric value 0. The numeric values are provided as the response for a

query.

Example:
Setting command: HCOPy : DEV:COL ON
Query: HCOPy : DEV: COL?

Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered
using a short or long form. Like any parameter, they have to be separated from the header
by a white space. In the case of a query, the short form of the text is provided.

|
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Example:

Setting command: HCOPy : PAGE: ORIentation LANDscape
Query: HCOP : PAGE : ORI ?

Response: LAND

Character strings

Strings must always be entered in quotation marks (' or ").

Example:
HCOP:ITEM:LABel "Testl" or HCOP:ITEM:LABel 'Testl'

Block data

Block data is a format which is suitable for the transmission of large amounts of data. A
command using a block data parameter has the following structure:

Example:

FORMat :READings:DATA #45168XXXXXXXX

The ASCII character # introduces the data block. The next number indicates how many
of the following digits describe the length of the data block. In the example the 4 following

digits indicate the length to be 5168 bytes. The data bytes follow. During the transmission
of these data bytes all end or other control signs are ignored until all bytes are transmitted.

#0 specifies a data block of indefinite length. The use of the indefinite format requires a
NL”~END message to terminate the data block. This format is useful when the length of
the transmission is not known or if speed or other considerations prevent segmentation
of the data into blocks of definite length.

Overview of Syntax Elements

The following table provides an overview of the syntax elements:

The colon separates the mnemonics of a command. In a command line the separating semicolon
marks the uppermost command level.

The semicolon separates two commands of a command line. It does not alter the path.

The comma separates several parameters of a command.

? The question mark forms a query.

* The asterisk marks a common command.

Quotation marks introduce a string and terminate it (both single and double quotation marks are
" possible).

|
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# The hash symbol introduces binary, octal, hexadecimal and block data.
e  Binary: #810110

e  Octal: #07612

e Hexa: #HF3A7

e  Block: #21312

A "white space" (ASCII-Code 0 to 9, 11 to 32 decimal, e.g. blank) separates the header from the
parameters.

6.3.5 Structure of a command line

A command line may consist of one or several commands. It is terminated by one of the
following:

e a<New Line>

e a<New Line> with EOI

e an EOI together with the last data byte

Several commands in a command line must be separated by a semicolon ";". If the next
command belongs to a different command system, the semicolon is followed by a colon.

Example:
MMEM:COPY "Testl", "MeasurementXY"; :HCOP:ITEM ALL

This command line contains two commands. The first command belongs to the MMEM
system, the second command belongs to the HCOP system.

If the successive commands belong to the same system, having one or several levels in
common, the command line can be abbreviated. To this end, the second command after
the semicolon starts with the level that lies below the common levels. The colon following
the semicolon must be omitted in this case.

Example:

HCOP:ITEM ALL; :HCOP:IMM

This command line contains two commands. Both commands are part of the HCOP com-
mand system, i.e. they have one level in common.

When abbreviating the command line, the second command begins with the level below
HCOP. The colon after the semicolon is omitted. The abbreviated form of the command
line reads as follows:

HCOP:ITEM ALL;IMM
A new command line always begins with the complete path.

Example:
HCOP:ITEM ALL
HCOP:IMM

|
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6.3.6 Responses to Queries

A query is defined for each setting command unless explicitly specified otherwise. It is
formed by adding a question mark to the associated setting command. According to
SCPI, the responses to queries are partly subject to stricter rules than in standard IEEE
488.2.

e The requested parameter is transmitted without a header.
Example: HCOP: PAGE : ORI ?, Response: LAND

e Maximum values, minimum values and all other quantities that are requested via a
special text parameter are returned as numeric values.
Example: SENSe : FREQuency:STOP? MAX, Response: 3.5E9

e Numeric values are output without a unit. Physical quantities are referred to the basic
units or to the units set using the Unit command. The response 3.5E9 in the pre-
vious example stands for 3.5 GHz.

e Truth values (Boolean values) are returned as 0 (for OFF) and 1 (for ON).
Example:
Setting command: HCOPy : DEV: COL ON
Query: HCOPy : DEV : COL?
Response: 1

e Text (character data) is returned in a short form.
Example:
Setting command: HCOPy: PAGE: ORIentation LANDscape
Query: HCOP: PAGE: ORI ?
Response: LAND

6.4 Command Sequence and Synchronization

IEEE 488.2 defines a distinction between overlapped and sequential commands:

e A sequential command is one which finishes executing before the next command
starts executing. Commands that are processed quickly are usually implemented as
sequential commands. Sequential commands are not implemented in the instrument,
however the execution time of most commands is so short that they act as sequential
commands when sent in different command lines.

e Anoverlapping command is one which does not automatically finish executing before
the next command starts executing. Usually, overlapping commands take longer to
process and allow the program to do other tasks while being executed. If overlapping
commands do have to be executed in a defined order, e.g. in order to avoid wrong
measurement results, they must be serviced sequentially. This is called synchroni-
zation between the controller and the instrument.

Setting commands within one command line, even though they may be implemented as
sequential commands, are not necessarily serviced in the order in which they have been
received. In order to make sure that commands are actually carried out in a certain order,
each command must be sent in a separate command line.
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Example: Commands and queries in one message

The response to a query combined in a program message with commands that affect the
queried value is not predictable.

The following commands always return the specified result:

:FREQ:STAR 1GHZ;SPAN 100 :FREQ:STAR?

Result:

1000000000 (1 GHz)

Whereas the result for the following commands is not specified by SCPI:

:FREQ:STAR 1GHz;STAR?;SPAN 1000000

The result could be the value of STARt before the command was sent since the instru-
ment might defer executing the individual commands until a program message terminator

is received. The result could also be 1 GHz if the instrument executes commands as they
are received.

As a general rule, send commands and queries in different program messages.

Example: Overlapping command with *OPC

The instrument implements INITiate[:IMMediate] as an overlapped command.
Assuming that INITiate[:IMMediate] takes longer to execute than *OPC, sending
the following command sequence results in initiating a sweep and, after some time, set-
ting the opcC bit in the ESR:

INIT; *OPC.

Sending the following commands still initiates a sweep:
INIT; *OPC; *CLS

However, since the operation is still pending when the instrument executes *C1.S, forcing
it into the "Operation Complete Command Idle" State (OCIS), *opc is effectively skipped.
The OPC bit is not set until the instrument executes another *OPC command.

6.4.1 Preventing Overlapping Execution

To prevent an overlapping execution of commands, one of the commands *OPC, *OPC?
or *WAI can be used. All three commands cause a certain action only to be carried out
after the hardware has been set. By suitable programming, the controller can be forced
to wait for the corresponding action to occur.

|
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Table 6-2: Synchronization using *OPC, *OPC? and *WAI

Com- Action Programming the controller
mand
*OPC Sets the Operation Complete bit in the ESR e  Setting bit 0 in the ESE
after all previous commands have been execu- | ®  Setting bit 5 in the SRE
ted. e  Waiting for service request (SRQ)
*OPC? Stops command processing until 1 is returned. | Sending *OPC? directly after the command

This is only the case after the Operation Com- | whose processing should be terminated before
plete bit has been set in the ESR. This bit indi- | other commands can be executed.

cates that the previous setting has been com-
pleted.

*WAI Stops further command processing until all Sending *WAI directly after the command

commands sent before *WAI have been exe- | whose processing should be terminated before
cuted. other commands are executed.

Command synchronization using *WAI or *OPC? appended to an overlapped command
is a good choice if the overlapped command takes only little time to process. The two
synchronization techniques simply block overlapped execution of the command.

For time consuming overlapped commands it is usually desirable to allow the controller
or the instrument to do other useful work while waiting for command execution. Use one
of the following methods:

*OPC with a service request

1.

2
3.
4

Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

Set bit no. 5 in the SRE: *SRE 32 to enable ESB service request.
Send the overlapped command with *OPC

Wait for a service request

The service request indicates that the overlapped command has finished.

*OPC? with a service request

1.
2.
3.

Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.
Send the overlapped command with *OPC?
Wait for a service request

The service request indicates that the overlapped command has finished.

Event Status Register (ESE)

1.
2.
3.

Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1
Send the overlapped command without *OPC, *OPC? or *WAI

Poll the operation complete state periodically (by means of a timer) using the
sequence: *OPC; *ESR?

A return value (LSB) of 1 indicates that the overlapped command has finished.

|
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*OPC? with short timeout
1. Send the overlapped command without *OPC, *OPC? or *WAI

2. Poll the operation complete state periodically (by means of a timer) using the
sequence: <short timeout>; *OPC?

3. Areturn value (LSB) of 1 indicates that the overlapped command has finished. In
case of a timeout, the operation is ongoing.

4. Reset timeout to former value

5. Clear the error queue with SYStem: ERRor? to remove the "-410, Query interrupted"”
entries.

Using several threads in the controller application

As an alternative, provided the programming environment of the controller application
supports threads, separate threads can be used for the application GUI and for controlling
the instrument(s) via SCPI.

A thread waiting for a *OPC? thus will not block the GUI or the communication with other
instruments.

6.5 Status Reporting System

The status reporting system stores all information on the current operating state of the
instrument, and on errors which have occurred. This information is stored in the status
registers and in the error queue. You can query both with the commands of the STATus
Subsystem.

6.5.1 Hierarchy of the Status Registers

The figure 6-1 shows the hierarchical structure of information in the status registers
(ascending from left to right).
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Fig. 6-1: Graphical overview of the status registers hierarchy

OPER = Operation Status Summary Bit
RQS/MSS = Service Request Generation

ESB = Standard Event Status Summary Bit
MAV = Message Available in Output Queue
QUES = Querstionable Status Summary Bit
2 = Error- /Event-Queue

1,0 = not used

Note: This legend explains the abbreviations to the Status Byte Register.

The R&S signal generators use the following status registers:

e Status Byte (STB) and Service Request Enable (SRE), see chapter 6.5.3, "Status
Byte (STB) and Service Request Enable Register (SRE)", on page 237.
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Standard Event Status, i.e. the Event status Register (ESR) and the Event Status
Enable (ESE), see chapter 6.5.4, "Event Status Register (ESR) and Event Status
Enable Register (ESE)", on page 237.

Questionable Status and Operation Status, the (SCPI status registers, see chap-
ter 6.5.2, "Structure of a SCPI Status Register", on page 235, chapter 6.5.5, "Ques-
tionable Status Register (STATus:QUEStionable)", on page 238 and chapter 6.5.6,
"Operation Status Register (STATus:OPERation)", on page 239.

Output-Queue

The output queue contains the messages the instrument returns to the controller. It
is not part of the status reporting system but determines the value of the MAV bit in
the STB and thus is represented in the overview.

Error- /[Event-Queue

The error-/event-queue contains all errors and events that have occurred in the past.
When reading the queue the instrument starts with the first occurred error/event.

All status registers have the same internal structure.

SRE, ESE

The service request enable register SRE can be used as ENAB1e part of the STB if the
STB is structured according to SCPI. By analogy, the ESE can be used as the ENAB1e
part of the ESR.

6.5.2

Structure of a SCPI Status Register

Each standard SCPI register consists of 5 parts. Each part has a width of 16 bits and has
different functions. The individual bits are independent of each other, i.e. each hardware
status is assigned a bit number which is valid for all five parts. Bit 15 (the most significant
bit) is set to zero for all parts. Thus the contents of the register parts can be processed
by the controller as positive integers.

Fig. 6-2: The status-register model

|
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Description of the five status register parts

The five parts of a SCPI register have different properties and functions:

CONDition

The CONDi tion partis written into directly by the hardware or the sum bit of the next
lower register. Its contents reflect the current instrument status. This register part can
only be read, but not written into or cleared. Its contents are not affected by reading.
PTRansition / NTRansition

The two transition register parts define which state transition of the CONDition part
(none, 0 to 1, 1 to 0 or both) is stored in the EVENt part.

The Positive-TRansition part acts as a transition filter. When a bit of the
CONDition partis changed from O to 1, the associated PTR bit decides whether the
EVENt bit is set to 1.

— PTR bit =1: the EVENt bit is set.

— PTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

The Negative-TRansition part also acts as a transition filter. When a bit of the
CONDition partis changed from 1 to 0, the associated NTR bit decides whether the
EVENt bit is set to 1.

— NTR bit =1: the EVENt bit is set.

— NTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

EVENt

The EVENt part indicates whether an event has occurred since the last reading, it is
the "memory" of the condition part. It only indicates events passed on by the transition
filters. It is permanently updated by the instrument. This part can only be read by the
user. Reading the register clears it. This part is often equated with the entire register.
ENABIle

The ENABle part determines whether the associated EVENt bit contributes to the
sum bit (see below). Each bit of the EVENt part is "ANDed" with the associated
ENABle bit (symbol '&'). The results of all logical operations of this part are passed
on to the sum bit via an "OR" function (symbol '+').

ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABle bit = 1: if the associated EVENt bit is "1", the sum bit is set to "1" as well.
This part can be written into and read by the user as required. Its contents are not
affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENAB1e part for each register. The result is
then entered into a bit of the CONDition part of the higher-order register.

The instrument automatically generates the sum bit for each register. Thus an event can
lead to a service request throughout all levels of the hierarchy.

|
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6.5.3 Status Byte (STB) and Service Request Enable Register (SRE)

The sTatus Byte (STB)is already defined in IEEE 488.2. It provides a rough overview
of the instrument status by collecting the pieces of information of the lower registers. A
special feature is that bit 6 acts as the sum bit of the remaining bits of the status byte.

The STB is read using the command *STB? or a serial poll.

The sSTatus Byte (STB)is linked to the Service Request Enable (SRE) register.
Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is set
in the SRE and the associated bit in the STB changes from 0 to 1, a service request
(SRQ) is generated. The SRE can be set using the command *SRE and read using the
command *SRE?.

Table 6-3: Meaning of the bits used in the status byte

Bit No.

Meaning

0...

1

Not used

2

Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each
entry of the error queue generates a service request. Thus an error can be recognized and speci-
fied in greater detail by polling the error queue. The poll provides an informative error message.
This procedure is to be recommended since it considerably reduces the problems involved with
remote control.

QUEStionable status register summary bit

The bit is set if an EVENt bit is set in the QUEStionable status register and the associated
ENABle bitis set to 1. A set bit indicates a questionable instrument status, which can be specified
in greater detail by querying the STATus: QUEStionable status register.

MAV bit (message available)

The bit is set if a message is available in the output queue which can be read. This bit can be used
to enable data to be automatically read from the instrument to the controller.

ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status register is set and
enabled in the event status enable register. Setting of this bit indicates a serious error which can
be specified in greater detail by polling the event status register.

MSS bit (master status summary bit)

The bit is set if the instrument triggers a service request. This is the case if one of the other bits of
this registers is set together with its mask bit in the service request enable register SRE.

STATus:OPERation status register summary bit

The bit is set if an EVENt bit is set in the OPERation status register and the associated
ENABIle bitis set to 1. A set bit indicates that the instrument is just performing an action. The type
of action can be determined by querying the STATus : OPERation status register.

6.5.4 Event Status Register (ESR) and Event Status Enable Register (ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI
register. The event status register can be read out using command *ESR?.
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The ESE corresponds to the ENAB1e part of a SCPI register. If a bit is set in the ESE and
the associated bit in the ESR changes from 0 to 1, the ESB bit in the STB is set. The ESE
register can be set using the command *EsE and read using the command *ESE?.

Table 6-4: Meaning of the bits used in the event status register

Bit No. | Meaning

0 Operation Complete
This bit is set on receipt of the command *OPC exactly when all previous commands have been
executed.

1 Not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument instead.
The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device-dependent error occurs. An error message with a number between -300
and -399 or a positive error number, which denotes the error in greater detail, is entered into the
error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other
reasons. An error message with a number between -200 and -300, which denotes the error in
greater detail, is entered into the error queue.

5 Command Error

This bit is set if a command is received, which is undefined or syntactically incorrect. An error
message with a number between -100 and -200, which denotes the error in greater detail, is
entered into the error queue.

6 User Request

This bit is set when the instrument is switched over to manual control.

7 Power On (supply voltage on)

This bit is set on switching on the instrument.

6.5.5 Questionable Status Register (STATus:QUEStionable)

This register contains information on questionable instrument states. Such states may
occur when the instrument is not operated in compliance with its specifications. To read
the register, use the query commands STAT:QUEST:COND? or
STAT:QUEST[:EVEN]?.

Table 6-5: Meaning of the bits used in the questionable status register

Bit No. | Meaning

0-15 not used
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6.5.6 Operation Status Register (STATus:OPERation)

This condition part contains information on the actions currently being performed by the
instrument, while the event part contains information on the actions performed by the
instrument since the last readout of the register. To read the register, use the query com-
mands STAT:OPER:COND? or STAT:OPER[:EVEN]?.

Table 6-6: Meaning of the bits used in the operation status register

Bit No. | Meaning

0 Calibrating

The bit is set during the calibration phase.

1-2 not used

3 Sweeping

This bit is set during a sweep in automatic or single mode.

4-15 not used

6.5.7 Application of the Status Reporting System

The purpose of the status reporting system is to monitor the status of one or several
devices in a measuring system. To do this and react appropriately, the controller must
receive and evaluate the information of all devices. The following standard methods are
used:

e Service request (SRQ) initiated by the instrument

e Serial poll of all devices in the bus system, initiated by the controller in order to find
out who sent a SRQ and why

e Query of a specific instrument status by means of commands
e Query of the error queue

6.5.7.1 Service Request

Under certain circumstances, the instrument can send a service request (SRQ) to the
controller. Usually this service request initiates an interrupt at the controller, to which the
control program can react appropriately. An SRQ is always initiated if one or several of
bits 2, 4 or 5 of the status byte are set and enabled in the SRE. Each of these bits com-
bines the information of the error queue or the output buffer. In order to use the possi-
bilities of the service request effectively, all bits should be set to "1" in the enable registers
SRE and ESE.

Example:

Use command *0OPC to generate an SRQ .

*ESE 1 - set bit 0 of ESE (Operation Complete)

*SRE 32 - set bit 5 of SRE (ESB).

After its settings have been completed, the instrument generates an SRQ.
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The SRQ is the only possibility for the instrument to become active on its own. Each
controller program should set the instrument such that a service request is initiated in the
case of malfunction. The program should react appropriately to the service request.

Serial Poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried.
However, the query is realized via interface messages and is thus clearly faster.

The serial poll method is defined in IEEE 488.1 and used to be the only standard possi-
bility for different instruments to poll the status byte. The method also works for instru-
ments which do not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instruments
connected to the controller.

Query of an instrument status

Each part of any status register can be read using queries. There are two types of com-
mands:

e The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level reg-
isters.

e The commands of the STATus system query the SCPI registers
(STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the
queried register. This number is evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on
the cause of the SRQ.

Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of the
error queue are detailed plain text error messages that can be looked up in the Error Log
or queried via remote control using SYSTem:ERRor [ :NEXT]? or
SYSTem:ERRor:ALL?. Each call of SYSTem:ERRor [ : NEXT] ? provides one entry from
the error queue. If no error messages are stored there any more, the instrument responds
with 0, "No error".

The error queue should be queried after every SRQ in the controller program as the
entries describe the cause of an error more precisely than the status registers. Especially
in the test phase of a controller program the error queue should be queried regularly since
faulty commands from the controller to the instrument are recorded there as well.

Reset Values of the Status Reporting System

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except of *RST and

|
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SysTem: PRESet affect the functional instrument settings. In particular, DC1. does not
change the instrument settings.

Table 6-7: Resetting the status reporting system

Event Switching on supply | DCL, SDC | *RST or STA- *CLS
voltage (Device SYS- Tus:PRE-
Power-On-Status- Clear, ;em:PRE— Set
Clear Selected et
Device
Effect 0 1 Clear)
Clear STB, ESR - yes - - - yes
Clear SRE, ESE - yes - - - -
Clear PPE - yes - - - -
Clear error queue yes yes - - - yes
Clear output buffer yes yes yes 1) 1) 1)
Clear command processing and | yes yes yes - - -
input buffer
1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINATOR>
clears the output buffer.

6.6 General Programming Recommendations

Initial instrument status before changing settings

Manual operation is designed for maximum possible operating convenience. In contrast,
the priority of remote control is the "predictability” of the instrument status. Thus, when a
command attempts to define incompatible settings, the command is ignored and the
instrument status remains unchanged, i.e. other settings are not automatically adapted.
Therefore, control programs should always define an initial instrument status (e.g. using
the *RST command) and then implement the required settings.

Command sequence

As a general rule, send commands and queries in different program messages. Other-
wise, the result of the query may vary depending on which operation is performed first
(see also Preventing Overlapping Execution).

Reacting to malfunctions

The service request is the only possibility for the instrument to become active on its own.
Each controller program should instruct the instrument to initiate a service request in case
of malfunction. The program should react appropriately to the service request.

Error queues

The error queue should be queried after every service request in the controller program
as the entries describe the cause of an error more precisely than the status registers.

|
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7 Remote Control Commands

In the following, all remote-control commands will be presented in detail with their param-
eters and the ranges of numerical values.

For an introduction to remote control and the status registers, refer to chapter 6, "Remote
Control Basics", on page 202.

Conventions used in SCPI Command Descriptions

Note the following conventions used in the remote command descriptions:

e Command usage
If not specified otherwise, commands can be used both for setting and for querying
parameters.
If a command can be used for setting or querying only, or if it initiates an event, the
usage is stated explicitely.

e Parameter usage
If not specified otherwise, a parameter can be used to set a value and it is the result
of a query.
Parameters required only for setting are indicated as Setting parameters.
Parameters required only to refine a query are indicated as Query parameters.
Parameters that are only returned as the result of a query are indicated as Return
values.

e Conformity
Commands that are taken from the SCPI standard are indicated as SCPI con-
firmed. All commands used by the R&S SMB follow the SCPI syntax rules.

e Asynchronous commands
A command which does not automatically finish executing before the next command
starts executing (overlapping command) is indicated as an Asynchronous com-
mand.

e Reset values (*RST)
Default parameter values that are used directly after resetting the instrument (*RST
command) are indicated as *RST values, if available.

e Manual operation
If the result of a remote command can also be achieved in manual operation, a link
to the description is inserted.

7.1 Common Commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These com-
mands have the same effect and are employed in the same way on different devices.
The headers of these commands consist of "*" followed by three letters. Many common
commands are related to the Status Reporting System.

Available common commands:

|
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SO I S 244
=] = 244
B T 244
10N R 245
B 15 1 245
B0 T 245
SO ] = 1 245
B R 245
B 22 3 246
L3 246
B LS [ 246
ST\ 2 246
ST 2] TR 247
BT 1= 247
S 2 T T 247
B 5 T 2 247
B 247
*CLS

ClLear Status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of the
QUEStionable and the OPERation registers to zero. The command does not alter the
mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only

*ESE <Value>
Event Status Enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?
Event Status Read

Returns the contents of the event status register in decimal form and subsequently sets
the register to zero.

Return values:
<Contents> Range: 0 to 255

Usage: Query only
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*IDN?
IDeNtification: returns the instrument identification.

Return values:

<|D> "Rohde&Schwarz,<device type>,<serial number>,<firmware ver-
sion>"

Example: Rohde&Schwarz, ZVA8-4Port,12345,0.10.1.23

Usage: Query only

Manual operation: See "Hardware Options / Software Options" on page 85

*IST?
Individual STatus query

Returns the contents of the IST flag in decimal form. The IST flag is the status bit which
is sent during a parallel poll.

Return values:

<ISTflag> 01
Usage: Query only
*OPC

OPeration Complete

Sets bit 0 in the event status register when all preceding commands have been executed.
This bit can be used to initiate a service request. The query form writes a "1" into the
output buffer as soon as all preceding commands have been executed. This is used for
command synchronization.

*OPT?
OPTion identification query

Queries the options included in the instrument. For a list of all available options and their
description refer to the CD-ROM.

Return values:

<Options> The query returns a list of options. The options are returned at
fixed positions in a comma-separated string. A zero is returned for
options that are not installed.

Usage: Query only

Manual operation: See "Hardware Options / Software Options" on page 85

*PRE <Value>

Parallel poll Register Enable
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Sets parallel poll enable register to the indicated value. The query returns the contents
of the parallel poll enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*PSC <Action>
Power on Status Clear

Determines whether the contents of the ENAB1e registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:

<Action> 011
0
The contents of the status registers are preserved.
1

Resets the status registers.

*RCL <Number>

ReCall calls up the instrument settings from an intermediate memory identified by the
specified number. The instrument settings can be stored to this memory using the com-
mand *sAV with the associated number.

It also activates the instrument settings which are stored in a file and loaded using the
MMEMory:LOAD <number>, <file name.extension>command.

Manual operation: See "Recall" on page 110

*RST
ReSeT

Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

The command is equivalent to SYSTem: PRESet.
Usage: Setting only

Manual operation: See "Preset" on page 80

*SAV <Number>

SAVe stores the current instrument settings under the specified number in an intermedi-
ate memory. The settings can be recalled using the command *RCL with the associated
number.
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To transfer the stored instrument settings in a file, use the command : MMEMory :
STORe:STATe.

Manual operation: See "Save" on page 109

*SRE <Contents>
Service Request Enable

Sets the service request enable register to the indicated value. This command determines
under which conditions a service request is triggered.

Parameters:

<Contents> Contents of the service request enable register in decimal form.
Bit 6 (MSS mask bit) is always 0.
Range: 0 to 255

*STB?

STatus Byte query
Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG
TRiGger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal (Manual Trigger). This common command complements the commands of
the TRIGger subsystem.

Usage: Event

*TST?
self TeST query

Triggers selftests of the instrument and returns an error code in decimal form (see Service
Manual supplied with the instrument). "0" indicates no errors occured.

Usage: Query only

*WAI
WAILt to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and
*OPC).
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Usage: Event

7.2 Preset Commands

The preset commands are not bundled in one subsystem. Therefore, they are listed sep-
arately in this section. In addition, a specific preset command is provided for each digital
standard and for the fader. These specific commands are described in the associated
subsystems.

Four presetting actions are available:

e Activating the default state of 